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Prefazione

Prefazione

Grazie per avere acquistato questo prodotto Topcon. Il materiale ¢
stato preparato da Topcon Positioning Systems, Inc. ("TPS") per i
possessori di prodotti Topcon con l'intento di fornire assistenza
sull'uso del ricevitore. Il suo utilizzo ¢ soggetto ai presenti termini e
condizioni ("Termini e condizioni").

Leggere attentamente i presenti Termini e
condizioni.

Termini e condizioni

USO. Il presente prodotto € progettato per essere usato da un
professionista. L'utente deve essere a conoscenza delle disposizioni in
termini di sicurezza, sull'utilizzo del prodotto ed implementarle in base
alle disposizioni locali relative all'utilizzo privato o commerciale.

COPYRIGHT. Tutte le informazioni contenute nel presente Manuale
sono di proprieta intellettuale e di proprieta letteraria di TPS. Tutti i
diritti riservati. Non ¢ consentito usare, visualizzare, aprire,
memorizzare, visualizzare, copiare, vendere, modificare, pubblicare,
distribuire o divulgare a terzi grafici, contenuti, informazioni o dati
contenuti nel presente Manuale senza avere prima ricevuto esplicita
autorizzazione scritta da parte di TPS. Dette informazioni devono
essere usate solo per la cura e 1'utilizzo del ricevitore. Le informazioni
e 1 dati contenuti nel presente Manuale per TPS. I loro sviluppo ha
richiesto molto lavoro, tempo e denaro e sono il risultato di una
selezione, un coordinamento e una preparazione rigorosa da parte di
TPS.

MARCHI REGISTRATI. GR-3™, Topcon Tools™, Topcon Link™,
TopSURV™_ Modem-TPS™, Topcon® e Topcon Positioning



Prefazione

Systems™ sono marchi depositati o registrati di TPS. Windows® ¢ un
marchio registrato di Microsoft Corporation. Il marchio e i loghi
Bluetooth® sono di proprieta di Bluetooth SIG, Inc. Ogni utilizzo di
questi marchi da parte di Topcon Positioning Systems, Inc. ¢
autorizzato mediante un'apposita licenza. Altri nomi di prodotti o di
aziende menzionati all'interno del Manuale possono essere marchi di
fabbrica dei rispettivi proprietari.

GARANZIA AD ECCEZIONE DI UN ESTENZIONE DI
GARANZIA ALLEGATA AL PRODOTTO, IL PRESENTE
MANUALE E IL RICEVITORE VENGONO FORNITI "NELLO
STATO IN CUI SI TROVANO". NON SONO PREVISTE ALTRE
GARANZIE. TPS DISCONOSCE EVENTUALI GARANZIE
IMPLICITE DI COMMERCIALIZZAZIONE PER UN USO O UNO
SCOPO PARTICOLARE. TPS E I SUOI DISTRIBUTORI
DECLINANO OGNI RESPONSABILITA PER ERRORI TECNICI
O EDITORIALI OVVERO PER EVENTUALI OMISSIONI
CONTENUTE NEL PRESENTE MANUALE; PER DANNI
IMPREVISTI O EXTRACONTRATTUALI RISULTANTI DALLA
FORNITURA, RENDIMENTO O USO DEL PRESENTE
MATERIALE O DEL RICEVITORE. TALI DANNI
DISCONOSCIUTI INCLUDONO, MA NON SONO LIMITATI A,
PERDITA DI TEMPO O DISTRUZIONE DI DATI, PERDITA DI
PROFITTI, RISPARMI O PROFITTI OVVERO INCAPACITA DI
UTILIZZO DEL PRODOTTO. INOLTRE, TPS DECLINA OGNI
RESPONSABILITA PER DANNI O COSTI SOSTENUTI IN
RELAZIONE ALL'OTTENIMENTO DI PRODOTTI O
SOFTWARE SOSTITUTIVI, RIVENDICAZIONI DA TERZI,
INCONVENIENTI O SPESE DI ALTRO GENERE. IN NESSUN
CASO, TPS DEVE ESSERE RITENUTA RESPONSABILE PER
DANNI O ALTRO SUBITI DALL'UTENTE OVVERO DA TERZI
OVVERO DA ALTRA ENTITA OLTRE IL PREZZO DI
ACQUISTO DEL RICEVITORE.

Vi GR-3 Manuale Operativo



Termini e condizioni

CONTRATTO DI LICENZA. L'uso di qualsiasi programma o
software per computer fornito da TPS o scaricato da un sito Web di
TPS (il "Software") in relazione al ricevitore sottintende l'accettazione
dei Termini e condizioni specificati nel presente Manuale e
l'intenzione da parte dell'utente di rispettare detti Termini e condizioni.
All'utente viene concessa una licenza personale, non esclusiva e non
trasferibile all'uso del software in questione secondo le condizioni qui
specificate e in ogni caso solo per un singolo ricevitore o un singolo
computer.

L'utente non puo assegnare o trasferire il Software o la presente licenza
senza l'esplicito consenso scritto da parte di TPS. La licenza ¢ valida
fino alla rescissione. Il contratto di licenza puo essere rescisso in
qualsiasi momento previa distruzione del Software e del Manuale.
TPS puo rescindere il contratto di licenza nel caso in cui l'utente non
agisca in conformita con i termini o le condizioni specificati. L'utente
accetta di distruggere il Software e il Manuale quando smette di
utilizzare il ricevitore. Tutti i diritti di possesso, copyright e altra
proprieta intellettuale implicita o collegata al Software sono di
proprieta di TPS. Se questi termini di licenza non sono considerati
accettabili, restituire il Software e il Manuale non utilizzati.

CONFIDENZIALITA. 11 presente Manuale, il suo contenuto e il
Software (definiti collettivamente "Informazioni confidenziali") sono
informazioni confidenziali ed esclusive di TPS. L'utente accetta di
trattare le Informazioni confidenziali di TPS con una cura
corrispondente a quella che userebbe per salvaguardare i propri segreti
commerciali pitt importanti. Niente di quanto contenuto nel presente
paragrafo intende limitare 1'utente dal divulgare le Informazioni
confidenziali ai propri dipendenti nella misura necessaria o adeguata
per l'uso e la manutenzione del ricevitore. Tali dipendenti sono tenuti
a mantenere segrete le Informazioni confidenziali di cui vengono in
possesso. Nel caso in cui I'utente venga legalmente obbligato a
divulgare eventuali Informazioni confidenziali, dovra darne
immediata comunicazione a TPS in modo da consentire a quest'ultima
di cercare un ordine protettivo o un altro rimedio adeguato.

N° PART. 7010-0736 vii



Prefazione

SITO WEB; ALTRE DICHIARAZIONI. Nessuna dichiarazione
contenuta nel sito Web TPS (o in altri siti Web) ovvero nel materiale
pubblicitario o nella letteratura TPS ovvero redatta da un dipendente o
un contraente indipendente di TPS modifica questi Termini e
condizioni (compresa la licenza Software, la garanzia e la limitazione
di responsabilita).

SICUREZZA. Un utilizzo improprio del ricevitore potrebbe causare
lesioni a persone, danni alle cose e/o malfunzionamenti al prodotto. I1
ricevitore deve essere riparato solo da centri di assistenza TPS
autorizzati. Gli utenti devono osservare e rispettare gli avvisi di
sicurezza riportati nell' Appendice.

VARIE ED EVENTUALI . I suddetti Termini e condizioni possono
essere emendati, modificati, sostituiti o annullati in qualsiasi momento
da parte di TPS. I suddetti Termini e condizioni saranno governati da
e strutturati in conformita con le leggi dello Stato della California,
senza riferimento a conflitti legali.
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Convenzioni utilizzate all'interno del manuale

Convenzioni utilizzate
all'interno del manuale

Il presente manuale utilizza le seguenti convenzioni:

Esempio Descrizione
File » Exit Fare clic sul menu File, quindi su Exit.
. Indica il nome di una finestra di dialogo o di una
Connection
schermata.

Indica un campo in una finestra di controllo o in
Frequency una schermata oppure una scheda all'interno di
una finestra di controllo o di una schermata.

Premere o fare clic sul pulsante o il tasto

Enter .
etichettato con Enter

Maggiori informazioni da considerare per la
: configurazione, manutenzione o configurazione di
un sistema.

Informazioni supplementari che possono aiutare
['utente a configurare, mantenere in funzione o
configurare un sistema.

Informazioni supplementari che possono influire
sul funzionamento del sistema, sulle sue
prestazioni, sulle misurazioni o sulla sicurezza
personale.

Notifica che un'azione ha il potenziale di influire in
modo negativo il funzionamento del sistema, le sue
prestazioni, l'integrita dei dati o la salute degli
individui.

b || © || ¥
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danneggiamento del sistema, la perdita di dati, la

Notifica che un'azione avra come ripercussione il
& perdita della garanzia o lesioni personali.

PERICOLO Non eseguire mai questa operazione.
N/
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Capitolo 1

Introduzione

Il ricevitore GR-3 ¢ un ricevitore GPS+ multi-frequenza che
rappresenta la soluzione piu avanzata e compatta disponibile nel
settore della tracciatura. Il ricevitore € un ricevitore multifunzione e
multiuso pensato per i mercati di precisione. Per mercati di precisione
si intendono 1 mercati di apparecchiature, sottosistemi, componenti e
software per mappatura commerciale, rilievo e costruzione, ingegneria
civile, agricoltura di precisione e costruzione agricola, controllo delle
macchine agricole, mappatura fotogrammetrica, idrografica e tutti gli
altri impieghi a questo collegati.

I1 GR-3 ¢ in grado di ricevere ed elaborare diversi tipi di segnali
(compresi i piu recenti segnali GPS L2C, GPS L5, GLONASS C/A L2
e GALILEO), migliorando la precisione e 1'affidabilita dei punti e
delle posizioni di tracciatura, in particolare in condizioni di lavoro
difficili. Le funzioni GPS+ e multifrequenza del ricevitore si
combinano per fornire un sistema di posizionamento accurato per
qualsiasi tipo di rilievo. Una serie di altre funzioni, comprese la
mitigazione del multipath, assicura la ricezione anche in presenza di
ostacoli o di segnali di intensita ridotta. Il ricevitore assicura la
funzionalita, la precisione, la disponibilita e I'integrita necessarie per
una raccolta dati facile e veloce.

Figura 1-1. Ricevitore GR-3

1-1



Introduzione

Principi di funzionamento

Un rilievo effettuato con il ricevitore GPS giusto fornisce agli utenti
un posizionamento accurato e preciso, requisito fondamentale per tutti
1 progetti di rilevamento.

Questa sezione fornisce una panoramica dei sistemi GNSS (Global
Navigation Satellite Systems) presenti e futuri, nonché delle funzioni
del ricevitore in grado di aiutare gli utenti a comprendere e applicare i
principi operativi di base, consentendo loro di ottenere il massimo dal
ricevitore.

Sistema GNSS

Attualmente i seguenti tre sistemi GNSS (Global Navigation Satellite
System) offre servizi di posizionamento e navigazione su una scala
globale, in ogni condizione atmosferica, 24 ore su 24 per ogni utente
provvisto di ricevitore GNSSpresente sulla superfice terrestre o in
prossimita di essa

* GPS - (Global Positioning System) ¢ il sistema satellitare reso
operativo dal Dipartimento della Difesa degli Stati Uniti. Per
informazioni sullo stato di questo sistema, visitare il sito Web
dell'osservatorio navale USA. (http://tycho.usno.navy.mil/)
oppure il sito Web della guardia costiera statunitense (http://
Www.navcen.uscg.gov/).

* GLONASS - (Global Navigation Satellite System) utilizzato dal
Ministero della Difesa della Federazione Russa. Per
informazioni sullo stato di questo sistema, visitare il sito Web
del centro informativo per il coordinamento scientifico (http://
www.glonass- center.ru/frame_e.html).

* GALILEO - ¢ il futuro sistema di posizionamento globale, ¢ il
sistema satellitare reso operativo dal Galileo Industries, una
joint venture tra numerose aziende/agenzie spaziali europee che
operano a stretto contatto con 1'Agenzia Spaziale Europea. A
differenza di GPS e GLONASS, si tratta di un impegno civile e
si trova attualmente in una fase di sviluppo e convalida. Per
informazioni sullo stato di questo sistema, visitare il sito Web di
Galileo Industries (http://www.galileo-industries.net).

1-2 GR-3 Manuale Operativo



Principi di funzionamento

Nonostante numerose differenze tecniche nell'implementazione di
questi sistemi, 1 sistemi di posizionamento satellitare presentano tre
componenti essenziali:

» Segmento spaziale - I satelliti GPS, GLONASS e GALILEO
orbitano approssimativamente 12.000 miglia nautiche sopra la
Terra e sono dotati di orologio e radio. Questi satelliti
trasmettono segnali e diverse informazioni digitali (effemeridi,
almanacchi, correzioni di ora e frequenza, ecc.).

* Segmento di controllo - Le stazioni di terra monitorano i
satelliti effettuando opportune correzioni di orologio e di
effemeridi (posizioni dei satelliti in funzione del tempo), per
assicurare la corretta trasmissione dei dati da parte dei satelliti.

* Segmento utente - La comunita e l'esercito che utilizzano i
ricevitori GNSS per calcolare posizioni.

Calcolo delle posizioni assolute

Durante il calcolo di una posizione assoluta, un ricevitore fisso o
mobile rileva la posizione tridimensionale rispetto all'origine di un
sistema di coordinate ECEF. Per calcolare questa posizione, il
ricevitore misura la distanza (detta pseudo-range) tra sé¢ e almeno
quattro satelliti. I pseudo-range misurati vengono corretti per
eliminare le differenze di ora (ricevitore e satelliti) e i ritardi di
propagazione dei segnali dovuti ad effetti atmosferici. Le posizioni dei
satelliti vengono calcolate dai dati delle effemeridi trasmessi al
ricevitore nei messaggi di navigazione. Se si usa un sistema satellitare
semplice, il numero minimo di satelliti necessari per calcolare una
posizione ¢ quattro. In uno scenario di satelliti misto (GPS,
GLONASS, GALILEO), il ricevitore deve vedere almeno cinque o piu
satelliti per tenere conto delle diverse scale temporali utilizzate in
questi sistemi e calcolare una posizione assoluta.

Calcolo delle posizioni differenziali

DGPS, o GPS differenziale, ¢ una tecnica di posizionamento relativa
in cui le misurazioni da due o pit ricevitori remoti vengono combinate
ed elaborate usando algoritmi sofisticati per calcolare le coordinate dei
ricevitori con un alto grado di precisione.

DGPS comprende diverse tecniche di implementazione classificabili
in base ai seguenti criteri:

N° PART. 7010-0736 13
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* Il tipo di misurazioni GNSS usati, misurazioni differenziali
code-phase o misurazioni differenziali carrier-phase

* Se sono richiesti risultati in tempo reale o elaborazione

Le applicazioni in tempo reale possono essere ulteriormente
suddivise in base all'origine dei dati differenziali e al
differenziali e al sistema di comunicazione usato.

Con DGPS nel suo approccio piu tradizionale, un ricevitore viene
sistemato in una posizione conosciuta ¢ monitorata e viene definito
ricevitore di riferimento o stazione base. Un altro ricevitore viene
posizionato in un luogo sconosciuto e viene considerato come
ricevitore remoto o rover. La stazione di riferimento raccoglie le
misurazioni code-phase e carrier-phase da ciascun satellite GNSS in
vista.

* Per le applicazioni in tempo reale, queste misurazioni ¢ le
coordinate della stazione di riferimento vengono
successivamente strutturate secondo lo standard industriale
RTCM-o vari altri standard esclusivi previsti per la trasmissione
di dati differenziali-e trasmesse ai ricevitori remoti mediante un
collegamento per la comunicazione dei dati. Il ricevitore remoto
applica le informazioni di misura ricevute dalla base alle
misurazioni osservate degli stessi satelliti.

 Per le applicazioni post-processing, le misurazioni simultanee
dalle stazioni di riferimento e rover vengono di solito registrate
nella memoria interna del ricevitore (non inviate tramite sistema
di comunicazione). Dopo di che i dati vengono scaricati nel
computer, combinati ed elaborati.

Con questa tecnica, gli errori spazialmente correlati-quali errori
orbitali del satellite, errori ionosferici ed errori troposferici-pos-
sono ridursi in modo significativo, migliorando pertanto la pre-
cisione di soluzione della posizione.

Esiste una serie di implementazioni per il posizionamento
differenziale, compreso il rilievo in post-elaborazione, il rilievo
cinematico in tempo reale, radiofari marittimi, satelliti geostazionari
(come nel caso del servizio OmniSTAR) e sistemi SBAS (WAAS,
EGNOS, MSAS).

Il metodo cinematico in tempo reale (RTK) ¢ il metodo di rilievo in
tempo reale piu preciso. RTK ha bisogno di almeno due ricevitori per
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Principi di funzionamento

la raccolta di dati di navigazione e per il collegamento dei dati di
comunicazione tra i ricevitori. Di solito uno dei ricevitori si trova in
una posizione nota (base) mentre l'altro si trova in una posizione
sconosciuta (rover). Il ricevitore base raccoglie le misurazioni di fase,
genera correzioni RTK ed invia i dati al ricevitore rover. Il rover
elabora i dati trasmessi con le proprie osservazioni di fase per calcolare
la posizione relativa con una precisione RTK fino a 1 cm in orizzontale
e 1,5 cm in verticale.

Componenti essenziali per un rilievo di qualita

Per ottenere risultati di posizione di qualita, ¢ necessario disporre dei
seguenti elementi:

* Precisione - La precisione di una posizione dipende soprattutto
dalla geometria del satellite (Geometric Dilution of Precision o
GDOP) e dagli errori di misura (ranging).

- Il posizionamento differenziale (DGPS e RTK) mitiga
fortemente gli errori atmosferici e orbitali e risponde ai
segnali Selective Availability (SA) che il Dipartimento della
Difesa statunitense trasmette con i segnali GPS.

- Maggiore il numero di satelliti in vista, piu forte il segnale;
minore il numero DOP, maggiore la precisione di
posizionamento.

» Disponibilita - La disponibilita dei satelliti influenza il calcolo
delle posizioni. Piu visibili sono i satelliti disponibili, piu valida
ed accurata sara la posizione. Gli ostacoli naturali creati
dall'uomo possono interrompere o distorcere i segnali,
riducendo il numero di satelliti disponibili e compromettendo la
ricezione del segnale.

* Integrita - La tolleranza dei guasti consente ad una posizione di
disporre di una maggiore integrita, aumentando la precisione.
Numerosi fattori si combinano insieme per garantire la
tolleranza dei guasti, compresi:

- Receiver Autonomous Integrity Monitoring (RAIM) rileva i
guasti dei satelliti GNSS rimuovendoli dal calcolo della
posizione.

- Cinque o piu satelliti solo per GPS o0 GLONASS; sei o piu
satelliti per scenari misti.
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- Il sistema SBAS - Satellite Based Augmentation Systems -
(WAAS, EGNOS, etc.) crea e trasmette, insieme alle
correzioni DGPS, informazioni relative all'integrita dei dati
(ad esempio, avvisi sullo stato di salute dei satelliti).

- Effemeridi e almanacchi correnti.

Conclusione

Questa panoramica descrive le informazioni di base relative al
posizionamento dei satelliti. Per maggiori informazioni, visitare il sito
Web di TPS.

Panoramica sul ricevitore

Una volta acceso, il ricevitore completa il test automatico. Vengono
quindi inizializzati i 72 canali del ricevitore ed ha inizio la tracciatura
dei satelliti visibili. Ciascuno dei canali del ricevitore puo essere usato
per seguire uno dei segnali GPS, GLONASS o GALILEO. Il numero
di canali disponibile consente al ricevitore di tracciare tutti i satelliti
GPS visibili in qualsiasi momento e in qualsiasi luogo.

Un'antenna GPS+ interna dotata di amplificatore a bassa rumorosita
(LNA) e il dispositivo di frequenza radio del ricevitore (RF) sono
collegati mediante un cavo coassiale. Il segnale a banda larga ricevuto
viene convertito, filtrato, digitalizzato e assegnato a diversi canali. Il
processore del ricevitore controlla il processo di tracciatura dei
segnali.

Una volta bloccato il segnale nel canale, esso viene demodulato e
vengono misurati i parametri di segnale necessari (carrier-phase e
code-phase). Anche i dati di navigazione per la trasmissione vengono
ricavati dal riquadro di navigazione.

Dopo che il ricevitore ha agganciato quattro o piu satelliti, & possibile
calcolare la posizione assoluta in WGS-84, nonché il time offset tra
l'orologio del ricevitore e 1'ora del GPS. Queste informazioni e dati di
misura possono essere successivamente archiviati nella scheda MMC
oSD!inun computer, quindi elaborati mediante un pacchetto software
per la post-elaborazione. Se il ricevitore funziona nella modalita RTK,
le misurazioni di dati grezzi possono anche essere registrate nella

1. MMC = multi-media card; SD = secure digital
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memoria interna del ricevitore. Questo consente all'operatore di
verificare doppiamente i risultati in tempo reale ottenuti sul campo.

In base alle opzioni, le capacita del ricevitore comprendono:
* Riduzione multipath

» Sistema SBAS - Satellite based augmentation systems -
(WAAS, EGNOS, etc.)

* Parametri PLL (phase locked loop) e DLL (delay lock loop)
regolabili

* Modalita doppie o multifrequenza, comprese le modalita di
rilievo statica, cinematica, cinematica in tempo reale (RTK) e
GPS differenziale (DGPS) (le modalita DGPS comprendono
quella statica, cinematica e RTK)

* Registrazione automatica dei dati
» Impostazione di diversi angoli di cut off
» Impostazione di diversi parametri di rilievo

* Modalita statica o dinamica

Informazioni generali

I1 GR-3 ¢ un ricevitore GPS a 72 canali con batterie esterne amovibili,
due porte dati, un'interfaccia per il controllo e la visualizzazione delle
registrazioni dati, slot per scheda di memoria, un radio modem interno,
un modulo a tecnologia wireless Bluetooth® e un modulo GSM/GPRS
opzionale.
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Batterie

Il ricevitore GR-3 € alimentato da due batterie ricaricabili estraibili
(Figura 1-2).

Figura 1-2. Batterie del GR-3

Il ricevitore viene alimentato prima da una batteria, passando
successivamente alla seconda batteria. Ogni batteria amovibile ¢ in
grado di garantire tra 4h30m e 8h30m (circa) di funzionamento, a
seconda della modalita del ricevitore.

Il caricabatteria esterno (opzionale) (Figura 1-3) viene connesso a
una presa standard mediante un cavo adattatore e un cavo/unita di
alimentazione. Una volta collegato a una presa di corrente, le batterie
saranno caricate completamente in circa sei ore. Le batterie devono
funzionare a una capacita non inferiore all'80% dopo 500 cicli di
ricarica. Le batteria non devono essere scariche prima della ricarica.

Il caricabatteria ha due porte, un tasto e tre LED.

* Le due porte collegano il caricabatteria a un ricevitore o a
un'alimentazione esterna. Le porte caricano o scaricano le
batterie simultaneamente.

* Il pulsante STATUS consente di attivare i LED della batteria.
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Premere STATUS per visualizzare la quantita di carica della
batteria corrispondente.

* I due LED della batteria visualizzano la percentuale di carica
della batteria collegata.

- Verde: indica una carica superiore all'85%.
- Arancione: indica una carica intermedia.
- Rosso: indica una carica inferiore al 15%.

» I1 LED di alimentazione si accende quando il caricabatteria ¢
collegato a una sorgente di alimentazione esterna, quale una
presa elettrica o un'altra alimentazione (batteria da 12 volt).

Due porte di alimentazione ingresso/uscita

STATUS [ B
Batteria pulsante Batteria ( |

Alimentazione

Figura 1-3. Caricabatteria con batterie

Il caricabatteria puo anche essere collegato a un treppiede, a una
cinghia o a un palo RTK per garantire un'alimentazione esterna alla
stazione base o al rover.

L'involucro batteria AA (opzionale) (Figura 1-4) contiene quattro
batterie AA per garantire una sorgente di alimentazione per il
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ricevitore facilmente trasportabile . Viste le differenze di capacita delle
batterie AA a quelle originali I'autonomia potrebbe ridursi..

@
@

01

—Sm e )

¥
'

Ly
N B

Figura 1-4. Involucro batteria AA (aperto)

Non utilizzare batterie AA ricaricabili.
@ Non utilizzare l'involucro batteria AA se il radio

modem si trova nella modalita di trasmissione.

Ricevitore GR-3

Il design avanzato del ricevitore GR-3 riduce il numero di cavi
necessari per il funzionamento, consentendo di eseguire rilievi in
modo piu affidabile ed efficiente. L'alloggiamento dispone di spazio
per due batterie ricaricabili amovibili, slot per schede SD/MMC e
SIM, un modulo a tecnologia wireless Bluetooth, una scheda per
ricevitori multi-sistema e una scheda di comunicazione con il radio
modem.

Il GR-3 ¢ disponibile in una delle seguenti configurazioni:

+ con un radio modem FH915 Plus TX/RX/RP!

¢ con un radio médem FH915 Plus TX/RX/RP e un modulo
GSM/GPRS

* senza radio modem

Altre funzioni includono due porte dati, una porta di alimentazione e
un MINTER per visualizzare lo stato e controllare gli input/output di
dati.

MINTER

MINTER ¢ l'interfaccia minima del ricevitore usata per visualizzare e
controllare gli input e gli output di dati (Figura 1-5).

1. RP = ripetitore
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| LED della batteria visualizzano lo stato di alimentazione di ogni
batteria:

* Verde - indica una carica superiore all'85%.

» Arancione - indica una carica intermedia.

* Rosso - indica una carica inferiore al 15%.
Il LED STAT mostra lo stato dei satelliti tracciati.

* Rosso lampeggiante - il ricevitore ¢ acceso, ma non viene
tracciato alcun satellite.

* Verde lampeggiante - il ricevitore ¢ acceso e sta tracciando i
satelliti; un lampeggio per ogni satellite GPS tracciato.

+ Arancione lampeggiante - il ricevitore ¢ acceso e sta tracciando
i satelliti; un lampeggio per ogni satellite GLONASS tracciato.

(oo )

\o =

3

Batteria
Alimentazione _/ Pulsante
pulsante FUNCTION

Figura 1-5. MINTER del GR-3

Il LED REC visualizza lo stato di registrazione dei dati. Vedere Il
pulsante FUNCTION” a pag. 1-13 per maggiori informazioni sul
comportamento del LED REC quando si usa il pulsante FUNCTION.

* Verde lampeggiante - ogni lampeggio indica che i dati vengono
scritti nella scheda SD/MMC.

* Arancione fisso - indica che il ricevitore sta cambiando
modalita.
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* Arancione lampeggiante - indica che il ricevitore sta
controllando il proprio file system interno (dopo avere
cancellato la NVRAM o caricato un nuovo firmware). Durante
questa operazione, il file system non ¢ accessibile per le
applicazioni CDU (control display unit) oppure per la
registrazione di dati. Questa operazione puo richiedere da
frazioni di secondo a parecchi minuti, a seconda delle
circostanze e della quantita di memoria interna.

* Rosso fisso - indica una condizione di errore del ricevitore
(memoria insufficiente, nessuna scheda SD/MMC inserita, un
problema hardware o un OAF inadeguato).

Latabella 1-2 a pag. 1-14 descrive lo stato del LED REC quando si usa

il pulsante FUNCTION.

Il LED RX TX mostra lo stato del modem. La tabella 1-1 descrive i
colori e le caratteristiche dei LED dei diversi modem disponibili per il

ricevitore GR-3.
Tabella 1 - 1: Indicazioni relative al LED RX TX

Médem
FH915 Plus

Nessuna spia accesa - il modem ¢ spento.

Verde lampeggiante - il modem si trova nella
modalita di ricezione.

Verde fisso - ¢ stato stabilito un collegamento
radio; il modem ¢ pronto per ricevere i dati.
Verde fisso + rosso lampeggiante - il modem sta
ricevendo dei dati.

Rosso fisso - il modem si trova nella modalita di
trasmissione.

Rosso lampeggiante - ¢ stata rilevata una
condizione di errore. Controllare la condizione
dell'antenna del radio modem per verificare che
non presenti danneggiamenti e che sia collegata
correttamente e in modo sicuro. Assicurarsi
inoltre che nulla interrompa il segnale.

Rosso lampeggiante + verde lampeggiante - il
modem si trova nella modalita di comando.

1-12
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Tabella 1 - 1: Indicazioni relative al LED RX TX (Continuacién)

GSM/GPRS

Arancione fisso (rosso e verde) - fase di
inizializzazione del modem.

Verde lampeggiante - il modem ¢ acceso,
registrato nella rete e in attesa delle chiamate in
arrivo (modalita Slave).

Rosso fisso - € stato stabilito un collegamento.

Verde lampeggiante - il modem si trova nella
modalita di controllo diretto (catena a
margherita).

Arancione lampeggiante - si € verificato un
errore (errore di inizializzazione, codice PIN
errato, ecc.).

Il LED BT indica il livello di attivita all'altezza del collegamento di
comunicazione della tecnologia wireless Bluetooth:

* Blu lampeggiante - il modulo Bluetooth ¢ acceso ma non ¢ stato
stabilito alcun collegamento.

» Spia blu sempre accesa - il modulo Bluetooth ¢ acceso ed ¢ stato
stabilito un collegamento.

* Nessuna spia accesa - il modulo Bluetooth ¢ spento.

Il tasto di accensione consente di accendere e spegnere il ricevitore.

Il pulsante FUNCTION consente scegliere tra le information mode e
le modalita in post-elaborazione, di avviare/arrestare la registrazione
dei dati e di modificare la velocita di trasmissione della porta seriale a
9600. Vedere “Funzionamento del MINTER” a pag. 4-7 per maggiori
informazioni. La tabella 1-2 a pag. 1-14 descrive lo stato del LED REC
quando si usa il pulsante FUNCTION.
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Tabella 1 - 2: Operaciones del botén FUNCTION y estado del LED REC

Tasto FUNCTION

LED REC

Stato

Se la registrazione

dati ¢ disattivata

e il tasto FUNCTION...

Non premuto

Nessuna spia
accesa

Nessuna registrazione dati.

Arancione Test del file system interno in corso.
lampeggiante
Rosso Nessuna memoria libera; problema hardware

con la registrazione dati. Nessuna scheda SD/
MMC.

Premuto per < 1
secondo

Se la modalita d

el tasto FUNCTION ¢ "LED blink mode switch"

Arancione

‘Rilasciare per modificare I'information mode.

Se la modalita del tasto FUNCTION ¢ "Occupation mode switch"

Arancione

‘Nessuna funzione.

Premuto per 1-5
secondi

Se la modalita d

el tasto FUNCTION ¢ "LED blink mode switch"

Verde

Rilasciare per iniziare la registrazione dei dati
(modalita di occupazione post-elaborazione non
definito).

Se la modalita del tasto FUNCTION ¢ "Occupation mode switch"

Verde Rilasciare per iniziare la registrazione (modalita
di occupazione post-elaborazione cinematica o
statica)
Premuto per 5-8 |Rosso Rilasciare per impostare la velocita di

secondi

trasmissione della porta A su 9600 bps.

Premuto per > 8
secondi

Nessuna spia
accesa

Nessuna funzione.
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Tabella 1 - 2: Operaciones del botén FUNCTION y estado del LED REC

Tasto FUNCTION

LED REC

Stato

Se la registrazione

dati ¢ disattivata

e il tasto FUNCTION...

Non premuto

Rosso

Nessuna memoria libera; problema hardware
con la registrazione dati.

Se la modalita del tasto FUNCTION ¢ "LED blink mode switch"

Verde

Registrazione dei dati avviata (modalita di
occupazione post-elaborazione non definito).

Se la modalita del tasto FUNCTION ¢ "Occupation mode switch"

Verde Registrazione dei dati avviata (modalita di
occupazione post-elaborazione cinematica).
Arancione Registrazione dei dati avviata (modalita di

occupazione post-elaborazione statica).

Premuto per < 1
secondo

Se la modalita del tasto FUNCTION ¢ "LED blink mode switch"

Arancione

Rilasciare per modificare 1'information mode.

Se la modalita del tasto FUNCTION ¢ "Occupation mode switch"

Arancione

Rilasciare per scegliere tra le modalita di post-
claborazione statica e cinematica.

Premuto per 1-5
secondi

Nessuna spia
accesa

Rilasciare per interrompere la registrazione dei
dati.

Premuto per 5-8
secondi

Rosso

Rilasciare per impostare la velocita di
trasmissione della porta A su 9600 bps.

Premuto per > 8
secondi

Nessuna spia
accesa

Nessuna funzione (registrazione dei dati ancora
attiva).
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Porte dati e di alimentazione
Il GR-3 presenta le seguenti tre porte (Figura 1-6):

* USB - con bordo giallo; usata per la comunicazione e il
trasferimento di dati ad alta velocita tra il ricevitore e il
dispositivo esterno.

11 corpo del connettore sul cavo corrispondente ¢ giallo.

« Seriale - con bordo nero; usata per la comunicazione tra il
ricevitore e un dispositivo esterno.

11 corpo del connettore sul cavo corrispondente € nero.

» Alimentazione - con bordo rosso; usata per collegare il
ricevitore a una fonte di alimentazione esterna. Questa porta
puo anche essere usata per caricare le batterie.

I corpo del connettore sul cavo corrispondente € rosso.

uUsB Seriale Alimentazione
(giallo) (nero) (rosso)
)

Figura 1-6. Porte del GR-3
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Connettore per radio antenna esterna

L'antenna SS si collega al connettore dell'antenna esterna sul radomo
GR-3 (Figura 1-7). L'antenna SS/GSM utilizza un collegamento TNC
a polarita inversa.

Connettore
dell’antenna
esterna
S/

Figura 1-7. Radomo GR-3 e connettore dell'antenna esterna

Connettore

Il connettore inferiore (Figura 1-8) collega il ricevitore a un adattatore/
traliccio filettato da 5/8" oppure a disconnessione rapida (per maggiori
informazioni, vedere “L'adattatore a disconnessione rapida” a
pag. 1-21).

S Y \
I
Connettore inferiore RN x \
per setup standard ) O

F

|

Figura 1-8. Connettore rapido GR-3
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Slot per schede SIM e SD/MMC

Gli slot per le schede SD/MMC! e SIM si trovano sotto le batterie
accanto alla base della antenna.

Lo slot per schede SD/MMC si trova a sinistra del MINTER
all'interno della tasca portabatterie (Figura 1-9) e collega una scheda
SD/MMC opzionale alla scheda del ricevitore per fornire memoria.
Una volta installata, la scheda SD/MMC rimane di solito all'interno del
ricevitore. I dati presenti sulla scheda SD/MMC possono essere
visualizzati tramite la porta USB o seriale oppure con la tecnologia
wireless Bluetooth. La scheda SD (secure digital) puo essere
acquistata presso un rivenditore informatico di zona.

Lo slot per la scheda SIM si trova a destra di MINTER all'interno
della tasca portabatterie e consente l'installazione di una scheda SIM
standard nel ricevitore. Una volta installata, la scheda SIM fornisce
un'identificazione univoca per il modulo GSM del ricevitore e
consente la funzionalita GSM del ricevitore in base ai servizi
sottoscritti (la scheda del ricevitore accede al modulo GSM che a sua
volta ha accesso alla scheda SIM). La scheda SIM rimane di solito
all'interno del ricevitore. E possibile accedere al modulo GSM con la
scheda SIM installata tramite Modem-TPS per scopi di
configurazione. La scheda SIM puo essere acquistata da un rivenditore
di cellulari.

Slot per scheda
(per scheda SD/MMC)

Figura 1-9. Esempio di slot per scheda del GR-3

1. MMC = multi-media card; SD = secure digital
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Informazioni generali

Il pacchetto GR-3 comprende cavi di alimentazione e comunicazione
standard per la configurazione del ricevitore e per garantire una fonte
di alimentazione al ricevitore. La tabella 1-3 elenca i cavi in dotazione

con il pacchetto GR-3.

Tabella 1 - 3: Cavi del pacchetto GR-3

Descrizione del cavo

Illustrazione del cavo

Il cavo di alimentazione (opzionale)
collega l'unita di alimentazione a una presa
provvista di messa a terra.

U.S.A. matricola 14-008052-01

Europa matricola 14-008054-01

Australia matricola 14-008053-01

11 cavo di alimentazione/ricarica del
ricevitore

collega il ricevitore e l'unita di
alimentazione mediante connettori SAE
per la ricarica della batteria. Il corpo del
connettore € rosso.

Matricola 14-008016-03

Il cavo di ricarica dalla basetta cradle al
ricevitore (opzionale)

collega il ricevitore alla basetta cradle di
ricarica per l'alimentazione esterna.
matricola 14-008072-01 (lunghezza 1,5m)
matricola 14-008072-02 (lunghezza 0,5 m)

—=377))
N DR

Cavo USB

Collega il ricevitore a un dispositivo
esterno (controller o computer) per il
trasferimento di dati ad alta velocita e per
la configurazione del ricevitore. Il corpo
del connettore ¢ giallo.

matricola 14-008070-01

Cavo seriale

Collega il ricevitore a un dispositivo
esterno (controller o computer) per il
trasferimento di dati e per la
configurazione del ricevitore. Il corpo del
connettore ¢ nero.

matricola 14-008005-02
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Altri accessori

Insieme ai seguenti accessori, il pacchetto GR-3 comprende una
scheda di memoria SD da 128 MB, nastro di misurazione da 3 metri,
una palina regolabile e una borsa portacavi.

L'unita di alimentazione (matricola 22-034101-01) carica le batterie
interne se viene collegata a una presa provvista di messa a terra (Figura
1-10). Questa unita converte la corrente alternata (AC) normalmente
fornita da una presa elettrica in corrente diretta (DC) usata per caricare
le batterie e/o alimentare il ricevitore.

caricare le batterie. Non utilizzarla come fonte di

L'unita di alimentazione deve essere usata solo per
@ alimentazione durante il rilievo.

L'unita di alimentazione puo essere collegata alla basetta cradle oppure
direttamente al ricevitore. Per maggiori informazioni, vedere le
sezioni relative all'alimentazione del capitolo 2.

Figura 1-10. Unita di alimentazione

L'antenna modem Spread Spectrum include il supporto per un
modem GSM (Figura 1-11 a pag. 1-20). L'antenna Spread Spectrum &
un collegamento TNC RF a polarita inversa (matricola 30-030012-01).

Antenna SS/GSM

Figura 1-11. Antenna del modem
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Il tricuspide universale e il relativo adattatore (matricola 22-
006008-01 e matricola 22-006009-011) vengono usati per livellare il
treppiede e fissare il ricevitore o l'antenna allo stesso (Figura 1-12).

Figura 1-12. Tricuspide universale e relativo adattatore
L'adattatore a disconnessione rapida (matricola 02-850905-01)
collega la palina in modo che il ricevitore possa scorrere all'estremita.
Grazie alle clip laterali, il ricevitore puo essere collegato/scollegato
rapidamente dalla palina (Figura 1-13).

i

Figura 1-13. Disconnessione rapida

Per maggiori informazioni sugli accessori e sulle opzioni del pacchetto
disponibili per il GR-3, contattare il rivenditore Topcon di zona.

Accessori opzionali

Topcon offre un'ampia scelta di accessori, progettati in particolare per
migliorare l'affidabilita e l'efficienza di lavoro. Per maggiori
informazioni sugli accessori opzionali disponibili per il GR-3,
contattare il rivenditore Topcon di zona.

L'adattatore di precisione per tricuspide (Figura 1-14) serve per
centrare, allineare e livellare il treppiede a un punto. Il distanziale
orizzontale (matricola 60419) si inserisce nel tricuspide di precisione
e consente al ricevitore di fissarsi in modo sicuro sul tricuspide di
precisione.
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Figura 1-14. Adattatore del tricuspide di precisione
e distanziale orizzontale

Un controller portatile (Figura 1-15) consente ai sistemi base e rover
GR-3 di essere configurati e monitorati direttamente sul campo.
TopSURYV (software per la raccolta di dati sul campo) e CE-CDU
(software per la configurazione e il monitoraggio del ricevitore)
possono essere usati sui controller Topcon per configurare e gestire il
ricevitore.

FC-2000

Figura 1-15. Esempi di controller portatili
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Option Authorization File (OAF)

Il cavo ODU morsetti a coccodrillo (opzionale) (matricola 14-
008097-01LF) collega la basetta cradle o il ricevitore a una batteria
ausiliaria per l'alimentazione del ricevitore durante le operazioni di
acquisizione (Figura 1-13).

Figura 1-16. Cavo di alimentazione ausiliario -
ODU a morsetti a coccodrillo .

Option Authorization File (OAF)

Topcon Positioning Systems genera un Option Authorization File
(OAF) per abilitare opzioni specifiche che il cliente ha la possibilita di
acquistare. L'Option Authorization File consente ai clienti di
personalizzare e configurare il ricevitore in base a specifiche esigenze,
acquistando quindi solo le opzioni desiderate.

Normalmente, tutti i ricevitori hanno in dotazione un OAF temporaneo
che ne consente l'utilizzo per un periodo di tempo predefinito. Dopo
avere acquistato il ricevitore, un nuovo OAF attiva in modo
permanente le opzioni desiderate e acquistate. Le opzioni del
ricevitore rimangono intatte anche se si cancella la NVRAM o si
ripristina il ricevitore.

11 file OAF abilita i seguenti tipi di funzioni. Per un elenco completo
delle opzioni disponibili e maggiori informazioni al riguardo, visitare
il sito Web di TPS oppure rivolgersi al rivenditore TPS di zona.

» Tipo di segnale (L1 standard; L2, L5 GPS, GLONASS,
GALILEO opzionale)

* Scheda di memoria SD esterna

* Velocita di aggiornamento standard 1Hz (opzionale 5, 10 o
20Hz)

e RTK a 1Hz, 5SHz, 10Hz ¢ 20Hz

* Input/Output RTCM/CMR

* Riduzione multipath avanzata

* Wide Area Augmentation System (WAAS)

» Receiver Autonomous Integrity Monitoring (RAIM)
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Note:
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Capitolo 2

Preparazione al
rilievo

Prima di iniziare le operazioni di acquisizione con il ricevitore GR-3,
¢ necessario installare il seguente software ed adottare le seguenti
configurazioni:

O Installare il software per la configurazione del ricevitore.
Vedere “Installazione del software Topcon ” a pag. 2-2.

O Opzionale: installare la scheda SD e/o SIM.
Vedere “Installazione delle schede SD e SIM opzionali ” a
pag. 2-7.

O Caricare le batterie.
Vedere “Ricarica della batteria ” a pag. 2-8.

O TImpostare al fonte di alimentazione (interna o esterna)

Vedere “Configurazione dell'alimentazione ” a pag. 2-10 y “Ali-
mentazione del ricevitore” a pag. 2-14.

O Configurare il modulo con tecnologia wireless Bluetooth.
Vedere “Modulo Bluetooth Configurazione” a pag. 2-21.

O Attendere l'aggiornamento di almanacchi ed effemeridi (dopo le
attivita di configurazione preliminari descritti nel capitolo 3).

Vedere “Acquisizione di almanacchi ed effemeridi” a pag. 2-26.

Questo capitolo spiega inoltre come collegare le batterie al ricevitore,
come collegare il ricevitore a un computer e come alimentare il
ricevitore con sorgenti diverse.



Preparazione al rilievo

Installazione del software Topcon

I1 CD Topcon GPS+ include i seguenti programmi software necessari
per configurare e mantenere in funzione il ricevitore. Questa software
¢ disponibile anche sul sito Web di TPS per gli utenti registrati.

« PC-CDU Lite + BTCONF
ver. 2.1.1.15 o superiore ver. 1.2 o superiore
* Modem-TPS * BTCONF
ver. 2.0 o superiore ver. 1.0.07 o superiore

Se si installano i programmi dal CD GPS+, inserire il CD nell'unita
CD-ROM del computer. Se si scaricano i programmi dal sito Web,
estrarre i file del programma in una cartella sul disco rigido.

Le seguenti sezioni descrivono come installare il software. Altre
sezioni del manuale descrivono invece l'uso di questo software con il
ricevitore

Installazione di PC-CDU

PC-CDU™ syviluppato da TPS ¢ un prodotto software Windows®
completo pensato per configurare i ricevitori GPS+. PC-CDU utilizza
GPS Receiver Interface Language (GRIL) per configurare diverse
impostazioni del ricevitore e diagnosticare lo stato del ricevitore.

11 software PC-CDU ¢ disponibile in due versioni: una versione con
funzionalita complete definita PC-CDU MS e una versione con
funzionalita ridotte detta PC-CDU Lite. PC-CDU Lite ¢ disponibile
gratuitamente sul sito Web di Topcon oppure sul CD GPS+.

I requisiti informatici per PC-CDU sono i seguenti: Windows® 98 o
superiore e una porta RS-232C o USB, oppure compatibile con
Bluetooth. Utilizzare PC-CDU versione 2.1.15 o superiore per
configurare correttamente il ricevitore.

Fare riferimento al Manuale di riferimento del PC-

@ CDU per maggiori informazioni sull'installazione e
l'uso del PC-CDU.
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Installazione di Modem-TPS

1. Creare una cartella PC-CDU sul disco rigido e posizionare il file
compresso di PC-CDU (ricavato dal sito Web o dal CD GPS+) in
questa cartella.

2. Sfogliare fino a raggiungere la cartella PC-CDU e fare doppio clic
sul file compresso PC-CDU.

3. Estrarre il file PCCDU.EXE e il file *.dll associato nella cartella
PC-CDU (Figura 2-1).

4. Creare un collegamento di scelta rapida sul desktop del computer
per un accesso rapido al PC-CDU (Figura 2-1).

B pecdu EEIX
File Edt View Favorites Tools Help .
Qe - © ¥ SO searnh |2 Fodens | [F-

Address |23 ci\ropoonipecdy M ﬂ G

Folders x Marre: Size Type Date Modified

(B Desktop | pccou vs.ze 854 KB WinZip Fils 152004 4:56 P #
@ [} My Documents ] LPTACCES. WKD 6KB Virtusl dsvic...  6i1j2000 6:39 PH

= ' My Computer & prenu ExE 2,224 kB Application 122312005 5: 16 P @tn“
# L 3% Floppy (A1)
=) % New ¥olme (C:)
@ 12 Documer:s and Settings
I Program Files
15 quarantine
& TEMR
= 1) topeon
3 peedu

15 unzpped
® 12 WINDOWS
# % CD Drive (D1}
# UL <D Drive (B b
p > < >

Figura 2-1. Estrazione del programma e creazione
del collegamento di scelta rapida
Per disinstallare il PC-CDU, navigare fino alla posizione del file *.exe.
Selezionare il file e premere Delete.

Installazione di Modem-TPS

Modem-TPS ¢ un programma di configurazione per la scheda del
radio modem interna al ricevitore. Modem-TPS ¢ disponibile dal sito
Web TPS o sul CD GPS+.

I requisiti informatici per Modem-TPS sono i seguenti: Windows® 98
o superiore e una porta RS-232C oppure tecnologia wireless
Bluetooth. Utilizzare Modem-TPS versione 2.0 o superiore per
configurare correttamente il ricevitore.

1. Navigare fino alla posizione del programma Modem-TPS e fare
doppio clic sull'icona Setup.exe.
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Preparazione al rilievo

2. Mantenere la posizione di installazione predefinita oppure

selezionare una nuova destinazione. Fare clic su Finish (Figura 2-
2).

Modem-TPS Installation

Please enter the directory in which to install
Modem-TPS.

Installing Files...

Extracting fils to C:A\Program Files\ odemn-TPS et dil

Modem-TPS Directory:

C:\Program Files\Modem-TPS

Change

Fish |  Cancel |

Figura 2-2, Selezione della posizione di installazione
di Modem-TPS e installazione
3. Fare clic su OK per completare l'installazione (Figura 2-3).
4. Se lo si desidera, creare un collegamento di scelta rapida sul
desktop del computer per un accesso rapido a Modem-TPS
(Figura 2-3).

Modem-TPS Installation

Modem-TPS installation successful

AIOEM

eelem-TS

Figura 2-3. Installazione completa e tasto di scelta rapida

Per disinstallare Modem-TPS, usare il menu Start sul computer. Fare
clic su Start » Programs » Modem-TPS » Uninstall Modem TPS,
quindi su Yes Yes nel messaggio di avviso che viene visualizzato.

Dopo di che, fare clic su OK una volta completata la disinstallazione.

Installazione di BTCONF

BTCONF ¢ un programma di configurazione per il modulo con
tecnologia wireless Bluetooth all'interno del ricevitore. BTCONF ¢
disponibile dal sito Web TPS o sul CD GPS+.
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Installazione di BTCONF

I requisiti del computer per BTCONF sono i seguenti: Windows® 98
o superiore e una porta RS-232C oppure tecnologia wireless
Bluetooth. Utilizzare BTCONF versione 1.2 o superiore per
configurare correttamente il ricevitore.

1. Creare una cartella BTCONF sul disco rigido e posizionare il file
compresso di BTCONF (ricavato dal sito Web o dal CD GPS+) in
questa cartella.

2. Navigare fino alla cartella BTCONF e fare doppio clic sul file

compresso BTCONF.

Estrarre il file btconf.exe nella cartella BTCONF.

4. Creare un collegamento di scelta rapida sul desktop del computer
per un accesso rapido a BTCONF (Figura 2-4).

98]

& biconf ;@El
Fle Edit View Favorites Tools Help i
Qo - © - F O seach [ rocers | [T~
Address |3 Ciytopeoniptearf ~ B
Falders X Name Size  Time Date Moriifed u
(B nestten ) “Dbtorfdp 273KB WinZip File 817/2005 2:18 P
() My Decuments Arbicont s ¢ S54 KB Application 6/20/2003 10:23 AM Iﬂ
= 4 My Computer
&) Bl
= % New Volme iC:)
® ) Docamerts and Scttings
# (2 Program Files
() qusrantins
=) TEMP
= |3 topeon
9 bconf
(9 pecd
|23 unzipped
B (3 WINDOWs
@ UL o Drive (D3] b/
< > { >

Figura 2-4. Estrazione del programma e creazione
del collegamento di scelta rapida
Per disinstallare BTCONF, navigare fino alla posizione del file *.exe.
Selezionare il file e premere Delete.

Ogni volta che si esegue BTCONF e si configura il modulo Bluetooth,
BTCONEF salva le impostazioni in un file (btconf.ini). BTCONF
aggiorna automaticamente il file ogni volta che si modificano le
impostazioni del modulo Bluetooth.

univoche per diverse finalita, conservare le copie di

Per mantenere impostazioni del modulo Bluetooth
5 BTCONEF in cartelle separate.
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Installazione di FLoader

FLoader ¢ un programma di caricamento firmware per scheda GPS,
radio modem, dispositivo bluetooth. FLoader ¢ disponibile dal sito
Web TPS o sul CD GPS+.

I requisiti del computer per FLoader sono i seguenti: Windows® 98 o
superiore e una porta RS-232C oppure tecnologia wireless Bluetooth.
Utilizzare FLoader versione 1.0.07 o superiore per configurare
correttamente il ricevitore.

1. Creare una cartella FLoader sul disco rigido e posizionare il file
compresso di FLoader (ricavato dal sito Web o dal CD GPS+) in
questa cartella.

2. Navigare fino alla cartella FLoader e fare doppio clic sul file

compresso FLoader.

Estrarre il file FLoader.exe nella cartella FLoader (Figura 2-5).

4. Creare un collegamento di scelta rapida sul desktop del computer
per un accesso rapido a FLoader (Figura 2-5).

W

& floader gﬁ‘ﬁ‘

Fle Edit View Favorites Tools  Help o

Qo - © - T O searh |2 roiders | [T~

Address |23 Ciitopconifloadsr M ﬂ @

Folders X Name Size | Tyne: Date Modfied
(B Deskiop | “Dficader_app.zip | 234 KB WinZip File 8/17/2005 2117 PH g

@ (L) My Documents ¥ Floader exe 524 KB Applicaton 2i12/2002 5:49 P F

= 4 My Computer
® & 3% Floppy (A1) ﬁLﬁEﬁ?
= e New Vobme (C:)
# [ Documerts and Scttings
# [ Program Fles
(2 quarantine
=) TEMP
= |3 topecon
(3 beonf
2 floader
3 peedu
(2 unzpped
® 5 WINDOWS hd
< > < >

&)

Figura 2-5. Estrazione del programma e creazione
del collegamento di scelta rapida

Per disinstallare FLoader, navigare fino alla posizione del file *.exe.
Selezionare il file e premere Delete.
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Installazione delle schede SD e SIM opzionali

Installazione delle schede SD e SIM
opzionali

Dietro ad ogni batteria amovibile & presente uno slot per la scheda SD
o la scheda SIM opzionale. La scheda SD garantisce uno spazio di
memoria in cui salvare i dati registrati; la scheda SIM consente la
comunicazione telefonica per il trasferimento dei dati tra due ricevitori
compatibili con GSM. La scheda SD puo essere acquistata presso un
rivenditore di computer di zona; la scheda SIM puo essere acquistata
presso un rivenditore di cellulari di zona. Il ricevitore supporta
correntemente una scheda SD con una capacita fino a 1 GB.

E' possibile leggere i dati memorizzati sulla SD collegando il
ricevitore ad un dispositivo tramite cavo seriale o via bluetooth.

Per installare la scheda SD (Figura 2-6):

1. Verificare che il ricevitore sia spento.

2. Togliere la batteria a sinistra di MINTER.

3. Inserire con cura la scheda SD con l'etichetta rivolta verso il basso
nell'apposito slot sopra la tasca portabatterie.

=l
(S |
R

Figura 2-6. Installazione della scheda SD

Non rimuovere la scheda se il ricevitore € acceso.
@ Una rimozione inappropriata della scheda potrebbe

danneggiarla.
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Preparazione al rilievo

Dopo avere acceso il ricevitore, la scheda rilevera la scheda SD e sara
pronto all'uso.

Per installare la scheda SIM (Figura 2-7):

La scheda SIM deve supportare lo standard CSD (Circuit Switched
Data) per la comunicazione diretta tra ricevitori. La scheda SIM deve
avere il supporto di GPRS per poter comunicare con un indirizzo [P
della rete GPS.

Per una corretta comunicazione, sia i ricevitori base
che i rover devono avere una scheda SIM installata

@ (in grado di supportare lo standard CSD) e disporre
di registrazioni per lo stesso provider di servizi.

Verificare che il ricevitore sia spento.

Togliere la batteria a destra di MINTER.

Se necessario, innestare la scheda SIM nel relativo supporto.
Inserire con cura il supporto con I'etichetta rivolta verso il basso
nell'apposito slot sopra la tasca portabatterie.

L=

Figura 2-7. Installazione della scheda SIM

v il ricevitore, leverd .
Dopo avere acceso il ricevitore, la scheda rilevera la scheda SD e sara
pronto all'uso.

Ricarica della batteria

Prima di iniziare a lavorare, caricare le batterie completamente al
massimo della potenza (Figura 2-8 a pag. 2-10).
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Ricarica della batteria

» Se le batterie sono collegate al caricabatterie esterno, per
caricarle completamente ¢ necessario un ciclo di circa 6 ore; le
batterie si ricaricano contemporaneamente.

* Se le batterie sono collegate al GR-3, per caricarle
completamente & necessario un ciclo di circa 6 ore; le batterie si
ricaricano contemporaneamente.

Non sovraccaricare le batterie.

% Le batterie vengono fornite dal produttore scariche.
T Caricare completamente le batterie prima di pro-
cedere al rilievo.

Ogni batteria amovibile ¢ in grado di garantire un'autonomia di
funzionamento compresa tra 4,5 e 8,5 ore (circa, a temperatura
ambiente), a seconda della modalita del ricevitore.

Se le batterie sono collegate al ricevitore, collegare
il cavo dell'adattatore di alimentazione alla porta di
alimentazione del ricevitore. Le batterie si ricarich-
eranno contemporaneamente.

1. Togliere le batterie dal ricevitore e inserirle nella basetta cradle.

2. Collegare il cavo di alimentazione all'unita di alimentazione.

3. Collegare i connettori SAE al cavo di alimentazione dell'adattatore
e all'unita di alimentazione.

4. Collegare il cavo di alimentazione dell'adattatore a una delle porte
della basetta cradle (ogni porta ¢ in grado di caricare una o due
batterie).

5. Collegare l'alimentazione a una presa disponibile. Lasciare le
batterie in carica per circa 6 ore.
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Preparazione al rilievo

Figura 2-8. Inserimento delle batterie nel caricabatteria
e collegamento a una presa

Le batterie agli ioni di litio usate nei gruppi batterie funzionano con
una capacita non inferiore all'80% dopo 500 cicli di carica. Queste
batterie non devono essere scariche prima della ricarica.

Configurazione dell'alimentazione

11 software PC-CDU di Topcon rappresenta un'interfaccia per diverse
funzioni di configurazione, monitoraggio e gestione relativamente al
ricevitore.

Per la gestione dell'alimentazione del ricevitore, PC-CDU abilita
I'alimentazione elettrica, la modalita di carica e visualizza la tensione
delle batterie.

1. Collegare ricevitore e computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19. per informazioni su questa
procedura.

2. Dopo il collegamento, fare clic su Configuration » Receiver.

3. Selezionare 1'elenco a discesa Power Mode per impostare la fonte
di alimentazione desiderata (Figura 2-9). Current Mode visualizza
la fonte di alimentazione corrente; se si utilizza la basetta cradle,
verra visualizzato il testo "extbat."
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Configurazione dell'alimentazione

* Auto - receiver consente di selezionare automaticamente la
fonte di alimentazione

* Mix - le batterie si scaricheranno quasi simultaneamente

» Battery A - le due batterie si scaricheranno in sequenza: prima
A, poi B, A, B e cosi via. In questo caso, la batteria B durera 1 -
2 ore piu a lungo.

» Battery B - le due batterie si scaricheranno in sequenza: prima
B, poi A, B, A e cosi via. In questo caso, la batteria A durera 1 -
2 ore piu a lungo.

L4 Receiver Configuration

Genoral | MINTER | Postionng | Base | Rowes | Poits | Events | Advanced |
Ehrvation madk, (degren] ek =T
Trmerrwanl § barvadions Mask. 5 Mode
Artonne Acteren Status resd onb) Ll o
# Cureetiopu: [7 oyl I
) o e ]| | G Power
¢ Fut DT Stahus 7 | eoerdl | bioe:
Temoeratue (Cobsus dagnes] = e et Chaiges
Doard temperanre .
ity Current Mode :
Prow oulgnd maocdes Tuan an
2[:
¥ Enatie Low Powsr Mode I —
Rehesh
Gt | Save | Setollpwametens o defasks

Figura 2-9. Selezione di Charger Mode

4. Selezionare l'elenco a discesa Charger Mode per impostare la
modalita del caricabatteria desiderata (Figura 2-10 a pag. 2-12).
Current Mode visualizza la batteria sotto carica: a, b, ab o nessuna

(off).
* Off - il ricevitore non carica le batterie

e Auto - 1l ricevitore rileva e carica automaticamente le due
batterie
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L Receiver Configuration
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Figura 2-10. Selezione di Charger Mode

5. Selezionare 1'elenco a discesa Turn on/off Slots per impostare
l'uscita degli slot interni (Figura 2-11).

* On - lo slot C viene alimentato solo con ricevitore acceso

* Off - lo slot interno non viene alimentato, nemmeno con
ricevitore acceso

* Always - lo slot interno viene alimentato anche con ricevitore

04 Receiver Configuration %)
Genesdl | MINTER | Posioning | Base | Rower | Ports | Evenis | Adverced |
Elevatior mask (degrees) e Vokages [vols)
Trerrwsnd £ lvaliors M ask 5 Mexte - Evtemal
brienna Arperr Status resd onk) b achlor) OnDosd
= P — Chaper
Cumaet Inout provg Baliesy & Tumn on/off Slots
Ext BE Statm BotieyB: [ 21c): [on
Tempotatue (Calmus dogess) Cunent Mass Chasges
Dowd tempeatas
Custer fsig) |
Poss oukgnd modes .k
r 20:fon

[+ Enable Low Power Mode

Fchosh |

Dt

Save

Set ol parameters 1o defodi

Figura 2-11. Selezione di Power Output Modes - Ports and Slots

6. Visualizzare le informazioni relative alle tensioni (Figura 2-12 a

pag. 2-13).

» External - visualizza la tensione dell'alimentazione esterna

* On Board - visualizza la tensione ricavata dalla scheda del

ricevitore
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Configurazione dell'alimentazione

» Battery A - visualizza la tensione della batteria A

» Battery B - visualizza la tensione della batteria B

» Charger - visualizza la tensione di uscita del caricabatteria

durante la carica

[Genessl | MINTER | Positining | Bane | Rowes | Pods | Evends | Advarced |

Ebevation mack (degees) * Power

¥ Enabie Low Poser Mode

Rehoth

okages [vells)
Tosrwrsdl Ebervsdion Mask 5 Mods desngl
Arasnna Bevsres Status fresd ordl Cunrt Modé n Bowd
y Curmert Iogut Chages
Ext DC S L2 | ‘ et
. DC Staus P
I |
Termperatue (Crlmus dogenes| G T =y
Bowd iomperthars M
Cunat fAng): |

Waltages [volts]

Extemnal : I_
OnBoard: Ii
Battery & : I—
BatteryB: [ 15
Charger : I_

I—

Uit | Save | 5ot o poameters bo defouks

Figura 2-12. Visualizzazione delle informazioni sulle tensioni

7. Selezionare e spuntare la casella di controllo Enable Low Power

Mode per portare il processore del ricevitore nella modalita di

consumo ridotto (Figura 2-13).

[ Receiver Configuration
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Figura 2-13. Abilitazione e applicazione delle impostazioni
di alimentazione

8. Fare clic su Apply.
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Preparazione al rilievo

Alimentazione del ricevitore

Se il ricevitore viene alimentato da batterie interne, passera
continuamente da una batteria all'altra, mantenendo una differenza di
0,4 V tra di esse.

Per controllare lo stato delle batterie interne, osservare il LED
BATT oppure controllare lo stato con 1'ausilio del software Topcon
disponibile.

* Controllare i LED BATT per verificare lo stato delle batterie.
- La spia verde indica una carica superiore all'85%.
- La spia arancione indica una carica intermedia.
- La spia rossa indica una carica inferiore al 15%.

* Con PC-CDU, eseguire una delle seguenti operazioni:

- Fare clic su Configuration » Receiver per vedere le
tensioni della batteria sulla schermata Receiver
Configuration.

- Fare clic su Help » About per vedere le tensioni della
batteria sulla schermata About PC-CDU.

Utilizzo di batterie amovibili

Il ricevitore GR-3 ¢ provvisto di due batterie ricaricabili amovibili e un
involucro batteria AA. Ogni batteria ¢ in grado di garantire
un'autonomia di funzionamento compresa tra 4,5 e 8,5 ore (circa), a
seconda della modalita del ricevitore e della capacita della batteria.

Tabella 2 - 1: Ore di funzionamento stimate con due batterie completamente
cariche

Utilizzo di batterie amovibili
Condizioni del ricevitore: Bluetooth = ON; 10-12 SV tracked; temperatura ambiente

Modem spento 17 ore
915+ modem nella modalita di sola ricezione 13 ore
915+ modem nella modalita di trasmissione da 11 ore
250mW

915+ modem nella modalita di trasmissione da IW |9 ore

Con involucri e batterie AA
Condizioni del ricevitore: Bluetooth = ON; 10-12 SV tracked

Modem spento 2,5 ore
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Utilizzo di batterie amovibili

Per collegare le batterie (Figura 2-14):

1. Con la batteria leggermente inclinata, posizionare il fondo della
batteria nel fondo della tasca portabatterie.

2. Spingere delicatamente la parte superiore della batteria nella tasca
portabatterie fino all'innesto. Assicurarsi che la clip sopra la
batteria si innesti perfettamente.

Figura 2-14. Inserimento delle batterie del GR-3
Per togliere le batterie:

abbassare il clip sulla batteria,ed estrarla delicatamente dal ricevitore
(Figura 2-15).

Figura 2-15. Rimozione delle batterie del GR-3
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Per assemblare l'involucro batteria AA (Figura 2-16):

Non utilizzare batterie AA ricaricabili.
@ Non utilizzare l'involucro batteria AA se il radio

modem si trova nella modalita di trasmissione.

1. Far scorrere il coperchio posteriore dell'involucro batteria AA
verso il basso e rimuoverlo.

2. Inserire quattro batterie AA all'interno dell'involucro come
illustrato (e nella Figura 2-16 sotto).

* Le batterie a sinistra hanno il polo positivo rivolto verso il
fondo dell'involucro.

* Le batterie a destra hanno il polo positivo rivolto verso la parte
superiore dell'involucro.
3. Riposizionare il coperchio posteriore dell'involucro.

Figura 2-16. Rimozione del coperchio
e inserimento delle batterie AA

4. Inserire l'involucro batteria AA nella tasca portabatterie come
descritto in “Per collegare le batterie” a pag. 2-15.

Utilizzo di un'alimentazione ausiliaria

Oltre alle batterie in dotazione, il ricevitore si collega a batterie
esterne. Le batterie esterne consentono di continuare a usare il
ricevitore nel caso in cui le batterie interne siano scariche.

Le batterie nella basetta cradle non caricano le bat-

%
@ terie interne/amovibili.
La basetta cradle serve per alimentare il ricevitore.
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Utilizzo di un'alimentazione ausiliaria

Per collegare il ricevitore al caricabatteria esterno (Figura 2-17):

Il caricabatterie esterno si aggancia al treppiede. La matricola del cavo

ricevitore-basetta cradle ¢ 14-008072-01 o 14-008072-02.

1. Collegare un'estremita del cavo al caricabatterie esterno.

2. Collegare l'altra estremita alla porta di alimentazione del
ricevitore.

Alla basetta
cradle del
ricevitore e di
carica con il cavo
ricevitore-
caricabatteria

Figura 2-17. Collegamento della basetta cradle
di carica e del ricevitore

Per collegare il ricevitore a una batteria ausiliaria (Figura 2-18):

Utilizzare il cavo ODU a morsetti a coccodrillo (matricola 14-008097-
01LF) per collegare direttamente la batteria ausiliaria e la porta di
alimentazione del ricevitore (senza SAE).
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Se il ricevitore viene alimentato con batterie
esterne, impostare la modalita caricabatteria su
OFF. In caso contrario, si caricheranno anche le
batterie amovibili, causando una riduzione del

@ tempo di funzionamento. Vedere “Configurazione
dell'alimentazione ” a pag. 2-10 per maggiori infor-
mazioni sull'impostazione della modalita del cari-
cabatteria

1. Collegare il cavo ODU ai morsetti a coccodrillo a una batteria da
12 Volt.

2. Collegare il cavo ODU ai morsetti a coccodrillo alla porta di
alimentazione del ricevitore.

3. Accendere il ricevitore.

Dal ricevitore
alla batteria
ausiliaria con il
cavo ODU ai
morsetti a
coccodrillo.

Figura 2-18. Collegamento di una batteria
ausiliaria al ricevitore

Un'unica batteria esterna da 12 V, 2.3 A*h dovrebbe azionare il
ricevitore e il modem per circa 4,5 ore e il ricevitore per 6 ore.
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Accensione/spegnimento del ricevitore

Accensione/spegnimento del
ricevitore

Per accendere il ricevitore, premere e tenere premuto il tasto di
alimentazione fino al breve lampeggio dei LED.

Per spegnere il ricevitore, premere e tenere premuto il tasto di
alimentazione per piu di un secondo e meno di quattro secondi (fino
allo spegnimento dei LED STAT e REC). Questo ritardo (circa 1
secondo) impedisce lo spegnimento per errore del ricevitore.

Collegamento del ricevitore al
computer

11 software PC-CDU di Topcon rappresenta un'interfaccia per diverse
funzioni di configurazione, monitoraggio e gestione relativamente al
ricevitore.

Per configurare e gestire file oppure per mantenere in funzione il
ricevitore, collegare il ricevitore e un computer adottando uno dei
seguenti metodi e avviando il PC-CDU:

* un dispositivo esterno abilitato Bluetooth (computer/controller)
* un cavo RS232 e un computer/controller

* un cavo USB e un computer/controller con il driver USB TPS
installato

Una volta stabilito il collegamento tra il ricevitore e il computer/
controller, sara possibile configurare il ricevitore e i relativi
componenti, inviare comandi al ricevitore, scaricare file dalla
memoria del ricevitore e caricare nuovo firmware con l'aiuto di
FLoader™, caricare un OAF e caricare file di configurazione in un
ricevitore.

Creazione di un collegamento
wireless

Il ricevitore GR-3 contiene tecnologia wireless Bluetooth che consente
il trasferimento e la sincronizzazione di file tra il ricevitore e altri
dispositivi esterni in grado di supportare la tecnologia wireless
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Bluetooth; ad esempio un FC-100 o un computer con installato un
adattatore USB-Bluetooth o un adattatore PCMCA-Bluetooth.

La modifica delle impostazioni predefinite della
porta D del ricevitore si ripercuote sul collega-
@ mento Bluetooth. Le impostazioni predefinite per la
porta D sono: 115200 bps, 8 bit di dati, 1 bit di
arresto, nessuna parita e nessun handshaking.

La procedura di collegamento del ricevitore e del dispositivo esterno
varia leggermente in funzione del tipo di dispositivo esterno usato. In
generale, la procedura di collegamento ¢ la seguente.

tivi esterni abilitati Bluetooth per maggiori infor-
mazioni sul collegamento.

% Fare riferimento alla documentazione sui disposi-

1. Accendere un dispositivo esterno abilitato Bluetooth e il
ricevitore. La modalita predefinita del dispositivo esterno ¢
Master; la modalita del modulo Bluetooth del ricevitore ¢ Slave.

2. Avviare la scansione del dispositivo esterno (master) affinché
ricerchi il ricevitore (Slave).

3. Una volta che il Master ha rilevato il ricevitore, attenersi alla
procedura descritta nella documentazione del dispositivo esterno
per collegarlo al ricevitore.

4. Collegare al software di configurazione desiderato (PC-CDU,
Modem-TPS, ecc.) come descritto nelle sezioni relative alla
configurazione.

Se non fosse possibile stabilire un collegamento, verificare che sia
abilitato lo slot tre del ricevitore.

1. Collegare il ricevitore e un computer con un cavo RS232 USB e
PC-CDU come mostrato di seguito.

2. Fare clic su Configuration » Receiver » General.

3. Nel campo Turn on/off, assicurarsi che la casella di controllo
Slot 2 (C) sia abilitata.
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Creazione di un collegamento via cavo RS232

Creazione di un collegamento via
cavo RS232

1. Con il cavo RS232, collegare la porta seriale del computer (di
solito COM1) alla porta seriale del ricevitore.

2. Accendere ricevitore e computer.

3. Awvviare il software di configurazione desiderato (PC-CDU,
Modem-TPS, ecc.) come descritto nelle sezioni relative alla
configurazione.

Creazione di un collegamento USB

Assicurarsi che il computer disponga del driver USB TPS e che
I'opzione USB sia abilitata.

1. Con il cavo USB, collegare la porta USB del computer alla porta
USB del ricevitore.

2. Accendere ricevitore e computer.

3. Collegare al software di configurazione desiderato (PC-CDU)
come descritto nelle sezioni relative alla configurazione.

Modulo Bluetooth Configurazione
Usare BTCONTF, il programma di configurazione del modulo
Bluetooth di Topcon, per:

» accedere al modulo con tecnologia wireless Bluetooth

* configurare il modulo Bluetooth

* controllare o modificare la configurazione del modulo

Per accedere al modulo con tecnologia wireless Bluetooth, scaricare e
installare BTCONF, quindi collegare il computer e il ricevitore ed
eseguire il programma di configurazione. Per maggiori informazioni,
vedere “Installazione di BTCONF ” a pag. 2-4.

Una volta che si dispone di BTCONF, attenersi alla seguente
procedura per configurare il modulo Bluetooth.

1. Con il cavo RS232, collegare la porta seriale del computer (di
solito COM1) alla porta seriale del ricevitore. Se necessario,
accendere il ricevitore e il computer.
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2. Lanciare il programma di configurazione del modulo Bluetooth
(Figura 2-19). Per la versione BTCONF e informazioni sul
copyright, fare clic sul tasto About.

~ | |dentification I Parameteis | Sernial Inlerface}

Bluetooth Information:
About
Connect

Lo |
=

Exit

Disconnected

Figura 2-19. Schermata principale di configurazione
del modulo Bluetooth

3. Dall'elenco a discesa nell'angolo in alto a sinistra, selezionare la
porta seriale del computer usata per la comunicazione (Figura 2-
20).

4. Fare clic su Connect per collegare il computer e il modulo
Bluetooth.

BTCONF =]
I COME = I Identification |F‘aramelers} Serial Interface |

Bluetooth Information:
COME - About

[l

Exit |

Disconnected

Figura 2-20. Selezione della porta di comunicazione
e selezione di Connect

Una volta collegato il ricevitore e il computer mediante BTCONF,
la scheda Identification (Figura 2-21) visualizza le seguenti infor-
mazioni:
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¢ Bluetooth name - il nome del modulo Bluetooth.

Modulo Bluetooth Configurazione

* Bluetooth address - 'indirizzo elettronico univoco del

modulo.

* Firmware version - la versione corrente del firmware del
modulo Bluetooth.

About

EE
N
Disconnect

Exxit

Identification I Parameters | Serial Interface |

Bluetooth Information:

Bluetooth name: GR3 Rover

Bluetooth address: 0028 866D 0074 0003
Firmware base: RECOMM1.1v16.4.4
Firmware version: V1.3 pl

COME, 115200

Figura 2-21. Scheda Identification di BTCONF

La porta COM e la velocita di trasmissione vengono visualizzate
nell'angolo in basso a sinistra.

5. Fare clic sulla scheda Parameters (Figura 2-22). La scheda

Parameters consente di impostare informazioni di identificazione e

protezione per il modulo Bluetooth. La sezione relativa alla

protezione consente di impostare i parametri di protezione dei dati

e di accesso non autorizzato per il modulo Bluetooth.

6. Immettere un numero massimo di 14 caratteri per impostare un
nome univoco per il modulo Bluetooth (Figura 2-22), quindi fare

clic su Apply.
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BTCONF FEX

I Sernial Interface I

About Bluetooth Name: |BRS Rover

Security

Bluetooth PIN: I

Disconnect

4]

Exit

COMB. 115200

Figura 2-22. Scheda Parameters di BTCONF

7. Per impostare i parametri di protezione (Figura 2-23 a pag. 2-25),
abilitare le seguenti opzioni, quindi fare clic su Apply:

* Bluetooth PIN - immettere max. 16 caratteri per specificare
un numero di identificazione personale per il modulo
Bluetooth.

* Encryption - da abilitare per consentire al modulo Bluetooth
di crittografare i dati inviati. Per leggere i dati crittografati,
l'utente deve utilizzare lo stesso PIN nel dispositivo che ha
inviato i dati.

* Authentication - da abilitare per richiedere un PIN prima
che due dispositivi abilitati Bluetooth (quali il ricevitore e
un computer) possano stabilire una comunicazione. I due
dispositivi devono usare lo stesso PIN.

Se le impostazioni di protezione non servono, evi-
tare di abilitare queste opzioni.
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BTCONF

Identification Parameters I Serial \nlerface]

Modulo Bluetooth Configurazione

o0&

About Bluetooth Name: \GFB Rover

Securty

Disconnect

Exit ‘

Blustooth PIN: [1234567

Authertication: [V

Encryption: v

COME, 115200

Figura 2-23. Parametri di protezione di BTCONF
8. Fare clic sulla Serial Interface (Figura 2-24). Abilitare Echo per
visualizzare le risposte del modulo Bluetooth e i relativi comandi
sul terminale. Se necessario, fare clic su Apply.
9. Fare clic su Disconnect, quindi su Exit per uscire da BTCONF.

BTCONF S]]

Identiﬁcatim] Parameters

about

Apply

Disconnect

e b

Exit

Echo: [~

COME, 115200

Figura 2-24. Scheda Serial Interface di BTCONF
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Acquisizione di almanacchi ed
effemeridi

Ogni satellite trasmette un messaggio di navigazione che include le
effemeridi del satellite, I'almanacco e altre informazioni. Le effemeridi
descrivono il movimento orbitale del satellite e vengono utilizzate per
prevedere la loro posizione/traiettoria. L'almanacco fornisce l'orbita
approssimativa (corso) di tutti i satelliti relativamente allo stesso
sistema.

« [ satellitt GPS e GLONASS trasmettono ciclicamente 1 dati
delle effemeridi a distanza di 30 secondi.

I satelliti GPS trasmettono ciclicamente i dati degli almanacchi
a distanza di 12,5 minuti; 1 satelliti GLONASS trasmettono
ciclicamente i dati degli almanacchi a distanza di 2,5 minuti.

Se il ricevitore presenta un almanacco, € possibile ridurre
considerevolmente il tempo necessario per ricercare e fissare i segnali
satellitari.

Il ricevitore aggiorna regolarmente gli almanacchi e le effemeridi e
conserva le versioni piu recenti nella NVRAM (RAM non volatile).

1. Impostare il ricevitore in modo che la sua posizione sia priva di
ostacoli.

2. Accendere il ricevitore.

3. Attendere circa 15 minuti mentre il ricevitore acquisisce
almanacchi ed effemeridi dai satelliti.

Se sono trascorsi 15 minuti e il ricevitore non riesce

a fissare alcun satellite, cancellare la NVRAM.
Vedere “Cancellazione della NVRAM” a pag. 5-13
per maggiori informazioni.

Sara necessario raccogliere o aggiornare 1'almanacco e le effemeridi
nelle seguenti situazioni:

» Se il ricevitore € rimasto spento a lungo.

* o Se l'ultima posizione nota del ricevitore conservata nella
NVRAM ¢ diversa dalla posizione attuale di diverse centinaia di
chilometri.

* Dopo avere caricato un nuovo OAF.
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Acquisizione di almanacchi ed effemeridi

* Dopo avere caricato nuovo firmware.
* Dopo avere cancellato la NVRAM.

* Prima del rilievo.
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Note:

2-28 GR-3 Manuale Operativo



Capitolo 3

Configurazione del
GR-3

I ricevitori base e rover devono essere entrambi configurati a seconda
del metodo di rilievo scelto.

* In applicazioni che richiedono risultati di posizionamento in
tempo reale, il ricevitore base fornisce le informazioni di
correzione necessarie per calcolare con precisione la posizione
del ricevitore rover.

Una stazione base viene di solito configurata su un punto cono-
sciuto e consente di raccogliere dati GPS/GLONASS dai satel-
liti. Man mano che il ricevitore cattura i dati dei satelliti, esso
misura la fase della portante e la code-phase in modo da calco-
larne e verificarne accuratamente la posizione. Dopo di che il
ricevitore trasmette tali informazioni via radio (SS o GSM) al
ricevitore rover.

* Il ricevitore rover applica le informazioni di correzione della
stazione base alla sua posizione in modo da calcolare con
accuratezza uno o piu punti.

I rover sono ricevitori GPS mobili su asta o bipiede che con-
frontano le informazioni della stazione base con i dati registrati
dai satelliti e applicano gli algoritmi di correzione per calcolare
in modo accurato un nuovo punto.

* In applicazioni destinate alla post-elaborazione. I ricevitori base
e rover registrano separatamente i dati dagli stessi satelliti
visibili nello stesso intervallo di tempo.Questi dati vengono
quindi elaborati con un software di post-elaborazione (ad es.
Topcon Tools).
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Configurazione del GR-3

Quando si configurano i ricevitori per il rilievo RTK, utilizzare la
seguente checklist per garantire la corretta impostazione dei ricevitori.

O

O

Eseguire le funzioni preliminari al rilievo come descritto nel
Capitolo 2.

Configurare un ricevitore come stazione base RTK e 1'altro
ricevitore come rover RTK. Vedere “Configurazione del
ricevitore” a pag. 3-9.

Configurare il dispositivo per la trasmissione e la ricezione delle
correzioni.

* Per un modem Spread Spectrum, vedere “Configurazione di
un dispositivo radio modem ad ampio spettro” a pag. 3-3.

* Per un modem GSM/GPRS, vedere “Configurazione del
radio modem GSM” a pag. 3-6.

Posizionare il ricevitore base su un punto conosciuto per iniziare
la raccolta di dati di osservazione statici e la trasmissione delle
correzioni. Impostare il ricevitore rover per iniziare la raccolta di
dati RTK. Vedere “Setup del ricevitore” a pag. 4-1 per maggiori
informazioni.

Quando si configurano i ricevitori per I'acquisizione in post-
elaborazione utilizzare la seguente checklist per garantire la corretta
impostazione dei ricevitori.

O

O

Eseguire le funzioni preliminari al rilievo come descritto nel
Capitolo 2.

Configurare un ricevitore come stazione base e l'altro ricevitore
come rover. Vedere “Configurazione del ricevitore” a pag. 3-9.

Impostare il ricevitore base su un punto conosciuto per iniziare la
raccolta di dati di osservazione statici. Impostare il ricevitore
rover per iniziare la raccolta di dati di osservazione statici o
dinamici. Vedere “Setup del ricevitore” a pag. 4-1per maggiori
informazioni.
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Configurazione del dispositivo integrato radio mo-

uGIn

Configurazione del dispositivo
integrato radio modem

Modem-TPS ¢ un'utilita di configurazione per i dispositivi radio
modem integrati nei ricevitori Topcon. Modem-TPS presenta le
seguenti funzioni:

* Collegamento di un dispositivo radio modem integrato ad un
computer mediante porta seriale o tecnologia wireless
Bluetooth.

* Visualizzazione di informazioni su un dispositivo radio modem
integrato nel ricevitore.

* Programmazione delle impostazioni del radio modem.

Fare riferimento alle seguenti sezioni per informazioni sulla
configurazione del ricevitore con un radio modem GSM o Spread
Spectrum mediante Moden-TPS.

Ricordare che la radio SS e GSM non funzionano

Una volta configurato il radio modem, scollegarlo
sempre da Modem-TPS prima di uscire per evitare
conflitti con la gestione delle porte seriali.

@ contemporaneamente. E possibile utilizzare un solo
dispositivo alla volta.

I software di configurazione e acquisizione Topcon, TopSURYV o
Pocket-3D, consentono anche di configurare i ricevitori Topcon. Per
maggiori informazioni, fare riferimento ai manuali di TopSURYV o di
Pocket-3D.

Configurazione di un dispositivo
radio modem ad ampio spettro

Per i ricevitori Topcon, il radio modem TPS FH915+ integrato
consente comunicazioni TX/RX Spread Spectrum tra una base e un
rover. Per configurare un radio modem SS, preparare quanto segue:

» Computer con sistema operativo Windows® 98 o superiore
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* Modem-TPS ver 2.0 o successiva installato sul computer
» Un cavo seriale (o tecnologia wireless Bluetooth)

Vedere “Configuracion de un radio médem GSM”per configurare la
porzione GSM di un setup radio Spread Spectrum.

1. Collegare il ricevitore al PC e accenderlo. Accendere il ricevitore.
2. Aprire Modem-TPS e selezionare la porta COM a cui ¢ collegato
il ricevitore (Figura 3-1). Fare clic su Connect.

& - [Bx]|

File Tods Help

QConnectiun |g\

Port's setting

Com1 =
Cancel

Disconnected

Figura 3-1. Collegamento a Modem-TPS
3. Nella scheda Radio Link, impostare i seguenti parametri (Tabella
3-1) e fare clic su Apply (Figura 3-2 a pag. 3-6).

Tabella 3 - 1: Parametri del ricevitore per la scheda Radio Link

Parametro Ricevitore base ‘ Ricevitore rover

Protocol Selezionare il tipo di protocollo scelto.

+ SIMPLEX

+ TRIMB

« PDLW/EOT
Mode Selezionare Transmitter. Selezionare Receiver.
Output power Selezionare la potenza di n/d

trasmissione per il radio

modem.
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Configurazione di un dispositivo radio modem ad

Tabella 3 - 1: Parametri del ricevitore per la scheda Radio Link (continua)

Parametro

Ricevitore base Ricevitore rover

Link rate

Selezionare la velocita di trasmissione dati per il collegamento

radio.

A differenza della velocita di trasmissione (baud rate) (la velocita

di trasferimento dati attraverso un'interfaccia con cavo seriale), la

velocita di collegamento rappresenta la quantita di dati (misurata

in bit) che il radio modem ¢ in grado di trasmettere/ricevere
lungo la linea in un determinato periodo di tempo (misurato in
secondi).

* 9600 - ripetere i data packet per tre volte; i packet sono
codificati cosi da ridurre le probabilita di interferenza. In
questo modo si ottiene la massima protezione dei dati, a
scapito pero della quantita.

+ 12000 - ripete i data packet cinque volte; non viene applicata
la codifica.

+ 17000 - ripete i data packet tre volte; non viene applicata la
codifica.

* 24000 - utilizza solo la codifica.

* 51000 - non utilizza ripetizione né codifica. In questo modo si
ha la massima produzione di dati, a scapito pero
dell'affidabilita della comunicazione.

Per la massima efficienza, le dimensioni dei data packet al radio

modem in un determinato periodo devono essere uguali o
inferiori alla velocita di collegamento. Utilizzare la Tabella 3-2 a
pag. 3-5 per stabilire la velocita di collegamento.

Channel

Consente di assegnare un canale in cui trasmettere/ricevere i dati.

Ogni canale utilizza una frequenza di comunicazione unica,

consentendo la trasmissione contemporanea di max. 5 radio

modem, senza interferenze, sul luogo di lavoro.

+ Utilizzare lo stesso canale per entrambi i ricevitori della stessa
rete.

» Assegnare canali diversi ad altre reti.

Tabella 3 - 2: Confronto tra velocita di collegamento e velocita di trasmissione

Dimensioni dei
data packet

Velocita di

L Velocita di trasmissione RX
trasmissione

Link rate(bps) seriale (bps)

(in bit) TX seriale (bps)
0-9600 9600; 19200 9600a;12000 9600; 19200; 38400; 57600
9600-12000 19200; 38400 19200; 38400; 57600

12000%; 24000

12000-17000

19200; 38400 19200; 38400; 57600

17000%; 24000

17000-24000

38400; 57600 24000 38400; 57600

24000-51000

57600 51000 57600

a. Velocita di collegamento consigliata per data packet di queste dimensioni.
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4. Nella scheda Serial Interface, selezionare i seguenti parametri per
la velocita di trasmissione, quindi fare clic su Apply (Figura 3-2).

Baud Rate - selezionare una velocita di trasmissione per la
porta seriale del modem. La stessa velocita deve essere
usata per il ricevitore e per il modem.

e RTS/CTS - consente di controllare il flusso di dati tra il

ricevitore € il modem. "On" abilita il controllo di flusso
hardware/handshaking.

Se la velocita di trasmissione seriale supera la

velocita di collegamento, abilitare I'handshaking
@ hardware per evitare il sovraccarico del collega-

mento radio con la conseguente perdita di dati.

4 Spread Spectrum Radio Modem 915 MHz (Plus)

Flle Torls _Help ﬁ Spread Spectrum Radio Modem 915 MHz (Plus)

File Tods Help
Radio Link ‘ GEM | Senal Interface | Identific

g e Radio Link | GEM  Serial Interface | Identification |
rotocol us ¥
Apply
Location: | Morth America =
Operation mode: | Transmitter x| Baud Rate 7600 -

Output powar 1w -
Link Rate: 9600 =
Channel: 4 |

RTS/CTS an >

COM2, 115200

COm2, 115200

0:05:55

Figura 3-2. Applicazione dei parametri relativi
alla velocita di collegamento e di trasmissione

5. Al termine, fare clic su File » Disconnect.

Configurazione del radio modem GSM

nere almeno una distanza di 25cm tra 'utente e il

Per soddisfare i requisiti di esposizione RF, mante-
@ radio modem.
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Configurazione del radio modem GSM

Per i ricevitori GR-3, il radio modem TPS SS integrato configurato
con un modulo GSM consente le comunicazioni GSM TX/RX tra una
base e un rover oppure comunicazione con una rete di stazioni
permanenti. Per configurare un radio modem GSM, preparare quanto
segue:

» Computer con sistema operativo Windows® 98 o superiore
* Modem-TPS ver 2.0 o superiore

» Un cavo seriale (o tecnologia wireless Bluetooth)

* [l numero di telefono della stazione base

1. Collegare il ricevitore al PC e accenderlo.

2. Aprire Modem-TPS e selezionare la porta COM a cui ¢ collegato
il ricevitore (Figura 3-3). Fare clic su Connect.

# - [EIX]

File Tods belp

[ connection ... \XI

Port's setting

CON1 E
Cancel

Disconnected

Figura 3-3. Collegamento a Modem-TPS

3. Nella scheda GSM, impostare i seguenti parametri (Table 3 - 3 on
page 7) e fare clic su Apply (Figura 3-4 a pag. 3-8).
In alcuni campi ¢ presente il testo "N/A", fare clic su Refresh.
Tabella 3 - 3: Parametri del ricevitore per la scheda FCS

Parametro Ricevitore base Ricevitore rover
Mode Selezionare ON. Selezionare ON.
PIN Se necessario, immettere un codice di identificazione
personale (PIN)
Dial Lasciare vuoto. Immettere il numero di
telefono del modem GSM
della base.
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Tabella 3 - 3: Parametri del ricevitore per la scheda FCS (continua)

Parametro Ricevitore base Ricevitore rover
Send time Immettere un periodo di tempo in secondi in cui il modem
GSM base/rover inviera una parola di servizio al modem GSM
rover/base.

* Questo parametro garantisce l'affidabilita della
comunicazione tra due modem ed evita un'inutile re-
inizializzazione degli stessi.

+ Per garantire una comunicazione via modem affidabile e
sicura, questo parametro deve essere superiore al tempo
impostato per la trasmissione di correzioni differenziali.

Se la base e il rover sono entrambi ricevitori GR-3 con modem
GSM interni, impostare /'ora di invio sullo zero (0).

ﬂ Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer
File Tods Help

[EEE|

Radio Link ~ GEM |Ser|a\ Interface ‘ Identification |

Mode: Slave = Send time: |0

Dial | Pin; [008

Model
[ "GSMI00" "GSM1800" "MODEL=G20"

ﬁ Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer
File Tods Help

Status: [Registered, home network

Radio Link  GZM ‘Sena\ Interface ‘ Identification |

Signal quality : 85 dB Refrzsh Anply"
Mode: Master h Send time: |0
COME, 115200
: Dial: [B3163870338 Pin; [008

hndel
[ "GSMa00","GSM1600" "MODEL=G20"

Status: [Registered, home network

Signal quality - [85 4B _ Refiesh | _&SMinfo

COMB, 115200 0:02:54

Figura 3-4. Selezione dei parametri GSM per base e rover

4. Per visualizzare le informazioni sul modem GSM, fare clic su
"Cell Modem Info" (Figura 3-5). Fare clic su Quit per ritornare
alla scheda GSM.

La qualita del segnale indica la forza del segnale GSM. Minore
il numero (ossia quanto pit il numero ¢ prossimo allo zero),
migliore sara la qualita del segnale. Il segnale minimo (cutoff)
¢ -111db.
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I Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer ok
Model:
["GEMe00" 'GSIME00" "MODEL=G20"
Stalus:
Registered, home netwark
GPRS status Operator.
[GFRS coverage [uTs-RUS
S/ GSM modem Signal guality
[752219001 334863 [#3 am
Cluit
COME, 115200 0:04:15

Figura 3-5. Visualizzazione delle informazioni GSM
5. Nella scheda Serial Interface, selezionare una velocita di
trasmissione per la porta seriale del modem. La stessa velocita
deve essere usata per il ricevitore e per il modem.
6. Fare clic su Apply, quindi su File » Disconnect.
7. Se necessario, avviare PC-CDU e configurare il ricevitore in modo
che funzioni come stazione base RTK.

Configurazione del ricevitore
I1 GR-3 puo essere configurato per la raccolta di dati in RTK o in post-

elaborazione.

» Una stazione base statica acquisisce i dati di misura e li salva
nella propria memoria interna.

* Una stazione base RTK acquisisce i dati di misura, determina le
correzioni differenziali da trasmettere al rover RTK.

» Un rover statico acquisisce e memorizza i dati di osservazione
dagli stessi satelliti e nello stesso intervallo di tempo della
stazione base statica.

* Unrover RTK acquisisce i dati di misura e accetta le correzioni
della stazione base RTK per calcolare la sua posizione relativa.

Per configurare il ricevitore e gestire file collegare il ricevitore ad un
computer adottando uno dei seguenti metodi e avviare il PC-CDU:

* dispositivo esterno Bluetooth (computer)
» cavo RS232
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* cavo USB e utilizzando il driver USB TPS installato
(disponibile sul sito Web di TPS)

11 software PC-CDU sta per Personal Computer-Control Display Unit
ed ¢ usato per gestire le diverse funzioni del ricevitore. La gamma di
funzioni di configurazione di PC-CDU non ¢ oggetto del presente
manuale. Per maggiori informazioni sulle procedure descritte nella
presente sezione o su PC-CDU, fare riferimento al Manuale dell'utente
di PC-CDU disponibile sul sito Web di TPS.

PC-CDU consente di configurare diverse parti del ricevitore. Tali
impostazioni verranno applicate al momento dell'uso di MINTER. La
gamma di funzioni di configurazione di PC-CDU non viene trattata
all'interno del presente manuale.

Una volta stabilito un collegamento tra il ricevitore e il computer, sara
possibile:

 configurare il ricevitore e i relativi componenti
* inviare comandi al ricevitore
 scaricare file dalla memoria del ricevitore

* caricare un nuovo OAF e altri file di configurazione in un
ricevitore

Si consiglia di applicare le seguenti configurazioni per base e rover per
le applicazioni pit comuni. Tuttavia, ¢ inoltre possibile selezionare
parametri di configurazione specifici per le diverse postazioni di
lavoro.

Non apportare altre modifiche senza consultare il
manuale di riferimento di PC-CDU.

1. Collegare il ricevitore e il computer come descritto in
“Collegamento del ricevitore al computer” a pag. 2-19.
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Configurazione del ricevitore

2. Avviare PC-CDU sul computer. Verra visualizzata la schermata
principale del software PC-CDU (Figura 3-6).

File Configuration Tools Plots Help
GPS Satellites Geo |svz | Taget|

=101 x|

GLONASS Satellites

# [ EL] az[calPi]pre] 1c] ss] LL:t Sn|Fn| EL[ AZ[ca]Pi|P2[ TC] S5

i
Al
Vel
RMS Pos:
AMS Vet
PDOP:

Receiver time:
Receiver date:
Clock offset:
Dsc. offset
Tracking time:

|Disconnected

Figura 3-6. Schermata principale di PC-CDU
L'angolo in basso a sinistra mostra lo stato del ricevitore "Discon-

nected".
Fare clic su File » Connect.

98]

4. Nella finestra di dialogo Connection Parameters, selezionare i
seguenti parametri (Tabella 3-4) e fare clic su Connect

(Figura 3-7).

Tabella 3 - 4: Parametri di connessione

Parametro RS232 o Bluetooth

usB

Connection Mode || Selezionare Direct.

Selezionare USB

Port Selezionare la porta che
collega computer e ricevitore
(di solito COM1, COM2 per
RS232 ¢ COM3, COM4, ecc.
per Bluetooth)

Baud Rate Selezionare la velocita di
comunicazione tra il ricevitore
e il computer (di solito
115200).

n/d

Rec ID n/d

Selezionare il numero
identificativo del ricevitore.
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RS232 o Bluetooth

X
Ci ion mode
(=" Direck " Intemet Client € Intemet Server
Port settings | UsBe
Pot: [COM1 =] Baudrate: [115200 7| [ Infisted po [ Tommmpersey s x|
I~ RTS/CTS handshaking | Connection mode
e & Direct © Intemel Client € Intemet Server |
[~ Passiverode [~ Manual mode only ~Port settings
I™ Restore the receiver's original baud rate on Disconnect Port, [usB | Rec|D: [ePazkEBATKW w| [T Infiared port
[ Intemet settings
Host e [locaiost TR port [0
~Program setting:
Passyord | I~ Passivemode [ Marual modeorly  Timeout (ms] |S00 -
[T Display data onserver | Log server events I~ DNe| || Restore the receiver's original baud rate on Disconnect
Internet ( Client - Server ) settings
Connect I Cancel |
Hst name: floc ahost TR port: {2000
Password: |
I” | Display data on server [ | Lo server everits I DNS lookup:
Connect I Cancel |

Figura 3-7. Parametri di connessione
Una volta stabilito il collegamento con il ricevitore, le impostazi-
oni di comunicazioni correnti-quali nome porta, velocita di tras-
missione (se applicabile) e controllo di flusso (se applicabile)-
vengono visualizzate nell'angolo in basso a sinistra della finestra

principale di PC-CDU. Nell'angolo in basso a destra si mette inol-

tre in funzione un timer (Figura 3-8).

1ol
File Configuration Jools Plots Help

GLONASS Satellites (0)

GPS Satellites (0) Geo |wvz | Tagel|
Snlfn] EL] Az[cA[ P P2 1c] s8]

# [ EL] sz{cafpifpa] Tef ss] tar
on:

Al

Vel

RMS Pos:

RAMS Vel
FDOF:

Receiver time: 08:06:07
Receiver date: 24.09,2002
Clock offset:

Osc. offset :

Tracking time: 00.00:00

00:00:12

COMZ, 115200

Figura 3-8. Collegamento PC-CDU creato
5. Fare clic su Configuration » Receiver.
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Configurazione del ricevitore

Fare clic su Apply dopo ogni modifica della
configurazione; in caso contrario, il ricevitore non
memorizzera la modifica

6. Fare clic su Set all parameters to defaults (Figura 3-9).

6 R rcriver Contigaration

Gonosod | MINTER | Postonng | Base | Rover | Ports | Events | Advanced|

Elervalron ik [degrmnc]

Touad € lovadion Mask: 5

Antonny Aberns Stahus fread only)
:: ‘:;'"; Cumert Input
i -
& s Ext. DC Status
Tempetann (Caksus dogans

Set all parameterrfo defaults |

Pawers manaopmernt
Power

‘Voltages fvolti|
Modn Ao . Extemal
ComertMode: [= || OnBosd: [0
Changes Batey A

Mode b hd B 2 '_
’ ||
CuereMode: [ | Cheowe Ires

Foawer cuIpLE mOBRT Tum onvolt Sints
oty 0n =] | | Sa2

P Skl
Skt on 2] || st

7 Enstie Low Possr Mode

Helesh Holy

0K l Dt lel '.'Hlluﬂpﬁddull

Figura 3-9. Impostazione di tutti i parametri sui valori predefiniti

7. Fare clic sulla scheda MINTER e configurare le seguenti
impostazioni (Tabella 3-5), quindi fare clic su Apply

(Figura 3-10).

Tabella 3 - 5: Parametri del ricevitore per la scheda MINTER

Parametro

Ricevitore base

Ricevitore rover

Recording interval

Immettere 15 secondi.

Elevation mask
angle

Immettere 15 gradi.

File name prefix

Immettere un ID univoco,

quali gli ultimi 3 numeri del

numero di serie del ricevitore.

FN key mode

FUNCTION)

(inizia/interrompe la registrazione dei dati con il tasto

Per la registrazione statica
dei dati, selezionare il
selettore LED blink.

Per la registrazione cinematica
dei dati, selezionare il selettore
Occupation.

Initial data
collection dynamic

mode

n/d

Selezionare Kinematic.
(Questa impostazione serve per
irilievi delle traiettorie.)
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FM key mode
% LED blink mode switch

el Receiver Conliguration

Genedl MINTER | Pastonng | Bave | Rover | Pots | Events | Advarced|
Precerding innerval 100 (secondi] PN key mode Statico
Ebsention mack fos Log e 5 {degrees] 1% LED birk mode swich Dccupalion mode swich|
i e o sl dats coection dynamc e
(3 r-

o Rover RTK
Fies Constion ke D recondrg aufo-stst
& Loghis  a5AM & on € 0On g

Aunate e Holaln Mods VFHM] passstes

& Dccupation mode switch
Recording interval : 1.00 [seconds) s mode
Elevation mask for Log file: |15 [degrees) @ Kinematic

File name prefix : log
Hehesh !g&
0K |G | Seve | Getshpoamerssto datas

Figura 3-10. Configurazione del MINTER del ricevitore
per la registrazione dei dati

8. Fare clic sulla scheda Positioning e impostare Elevation mask su
15 (Figura 3-11), quindi fare clic su Apply.

-
Goneal | MINTER [PE#0000 | Bavn | Rove | Pots | Events | Advarsed |
Posmonng Mo Frable Sotins | |~ Sabelitn mragoment
 Standabne I Standaona Sapelies naeked Saleins e n pos
 DGPS [Code Dibeerii) | | 17 (5 R 6 [ G0 I aesf
© RTK Fsa P TS -
* RIK Femd " GFS | GLONASS | wikaS |
. ponflock|use ok s pun bk e ok e
r"_”’:"{:‘””“‘" WK 3K UKW BFF
A IFF WFF WRFF ZFF
= IFF NFF WFF TFF
TR T IFF 2FF aF F 2BF F
e ]| | & A1 SFF NP R AR P AFF
i s ¢ FAl EF F UF F RFF DFF
Elevation mask r P2 ¥ v 2F F BDF R
(dearee) : 15 L i aiee IFF B5FF AFF NF R
VK WK K AFF TP

CunertDonm: [wee =] [ lonpCosechon

Dstun Paranaters I oneCesect

Altolock | Menetoloct] Altouse | Moo towse]

| Retesh | |

[k | i | Seve | Serslparametes o datauks

Figura 3-11. Configurazione del posizionamento
del ricevitore - Elevation Mask

9. Per il ricevitore base, fare clic sulla scheda Base e impostare i
seguenti parametri (Figura 3-12 a pag. 3-15), quindi fare clic su
Apply.

¢ GPS/GLO at one time - da abilitare

* Antenna position - immettere i valori Lat, Lon e Alt facendo
ricorso a uno dei seguenti metodi:

- Se conosciuti, digitare i valori.
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- Abilitare Averaged e immettere Averaged Span in
secondi, quindi fare clic su Apply. Fare clic su Tools »
Reset receiver ¢ attendere fino al termine dell'intervallo
specificato (span). Controllare le coordinate della base
nella scheda Base; esse dovrebbero corrispondere alle
coordinate ottenute dalla media. Fare clic su Refresh se
le coordinate sono zero

- Fare clic su Get from receiver.

in questa scheda si riferiscono al centro di fase L1

Le coordinate geodetiche di riferimento specificate
@ dell'antenna.

Continuare con il punto 11 a page 17 per le acquisizioni RTK o con il
punto 12 a page 18.

& GPS/GLO ol one time 2

B are Stabor Cowdnates | Andenna Phave Cende ) RTCM Settnge
& GPS/GLO o ome ime | Avereced Sation i [0
T BPS/BLD sopoiotely

Messurements Sent
FourpePupEpL2

M rusrbe .,
G Syatem Used
of Satees . |0

GPS/GLO | Gt lrom e F 6Pt F GLONASS
Tefesance Geodetis Cocndnares Hoom:[Goct =] = Prodorars ooty
a0 o0 Joanced [ =] [wer =] [f [CHA Seting: e —.D

tenfo00 o0 “foaoooco *fc =] Simoni0: [0 | @ CALL © PAIF PA2
gl B Do Pasometons | | | Motin: [Urkrowr =] GLONASS mestace: [5~ 5]

Junimnia Phisis Center ollials. malés Shot D 0060
Cat > Jo0002 kagne 0.0052 g —

} Cerbigaration of Mecerrs: Parts |
GPSJ’ELDI Get from receiver - (] |

1 Reference Geodetic Coordinate

La:fo0 “fo0 'fonnonon [+ [wes <]
Lonf000 “[00” *foc.00000 (€ ]
Al |+00000  m Datum Parameters

Figura 3-12. Configurazione della base

s paramaters 1o dtfaikt

10.Per il ricevitore rover, fare clic sulla scheda Rover e impostare i
seguenti parametri, quindi fare clic su Apply (Figura 3-13 a
pag. 3-16).

» Positioning Mode - Per i rilievi in post-elaborazione,
selezionare Standalone; per i rilievi RTK, selezionare RTK
float o RTK fixed.
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Genmal | MINTER | Postonrg | Base  Fover | Ports

RTK Parameters, RTK mode - selezionare Extrapolation for
RTK float (cinematica) oppure Delay for RTK fixed
(statica).

L'estrapolazione serve per applicazioni RTK con output
a bassa latenza ed alta frequenza (>= 5 Hz). Il rover
estrapolera le correzioni delle misure carrier-phase della
stazione base durante il calcolo della posizione RTK
corrente del rover.

Questa impostazione (estrapolazione) ¢ quella
consigliata.

Delay serve per applicazioni RTK ad alta precisione (1
Hz). Il motore RTK del rover calcolera una posizione
RTK ritardata (all'epoca corrispondente al messaggio
RTCM/CMR appena ricevuto) oppure la posizione
stand-alone corrente (in attesa dell'arrivo di nuovi
messaggi RTCM/CMR dalla base).

RTK Parameters, Dynamics - selezionare Static o
Kinematic.

RTK Parameters, Ambiguity fixing level - (non applicabile
per RTK Float) selezionare Low, Medium o High per lo
stato dell'indicatore 95%, 99.5% 0 99.9%. Il motore RTK
utilizza I'indicatore per il fissaggio di ambiguita quando si
decide se fissare o meno delle ambiguita. Maggiore il livello
di confidenza specificato, piu lunga sara la durata per la
ricerca dell'ambiguita intera.

Positioning Mode

o tevarnd | Standalone

" RTK Float

Puosiioring Mode Enablo Scksons | (™~ DGPS (Code Differential] = RTK Fixed
 Standakne  ATE PR 7 Slandsons
 DGPS (Code Dillsertial) & ATE. Fiusd "
TV, Paten:
= 1 AT mode Dyrarmics Aambipaty o evel
[ € Edugobtion | € Stakie T Low
W 7 | ¢ oem & Kismatic ,r: x;" =
=
E r - Dase
= 7 ALl P P 7 PA2 v
r - I Us nles Souce. [fuy |
i I
RTK mode Dynamic: Ambiguity fixing level|
Cerirgastron of Aed] {~ Ewxtrapolation | |  Static C L°W_
i ' Medium
{* Delay  Kinematic | | High
Ok |Gt | Save | Sotslipmmetsss to defoks

3-16

Figura 3-13. Configurazione del rover
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Configurazione del ricevitore

Continuare con il passo 11 per i rilievi RTK oppure con il passo 12
a page 18.

11.Peririlievi RTK, fare clic sulla scheda Ports e impostare i seguenti
parametri per la porta seriale (Tabella 3-6), quindi fare clic su
Apply (Figura 3-14 a pag. 3-18).

Per irilievi in post-elaborazione, conservare i valori
predefiniti per questi parametri.

Tabella 3 - 6: Parametri del ricevitore per la scheda Ports

Parametro Ricevitore base Ricevitore rover

Input n/d (lasciare il valore Selezionare lo stesso formato

predefinito.) per la correzione differenziale
selezionato per la base.

Output Selezionare il tipo e il formato | Selezionare “None”
delle correzioni differenziali.

Period (sec) Immettere l'intervallo con cui il |n/d (lasciare il valore
ricevitore trasmettera le predefinito.)
correzioni differenziali.

Baud rate Selezionare una velocita di trasmissione da usare per trasmettere i
messaggi differenziali dalla scheda del ricevitore al modulo
modem

La velocita di trasmissione deve corrispondere alla velocita della
porta seriale del modem.

RTS/CTS Selezionare questa voce per abilitare 1'handshaking.
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General | MINTER | Posionng | Bate | Rover Poss | Events | Advanced|
Sesol | Parabel| Mot | USE | Ethermt| TP |
L H| B isls E
i Duipd |1 - Porod ] r
song  eut [Comand *] Baudiste: [15200 7]
Ouput: [ticee =] Peisdisl I ATS/CTS
e outs [Command -] Badrole: [ 0400 =)
i Dups; [oMN =]  Peidi: o [ RISATS
SeidlD  Irgua [Command - Bansdiote [115200 =)
I tohowod  puppt: [Hore <] Penady ™ RTSATS
Base Rebed) I’:MTEI
Input : IEnmmand 'l Baud rate: | 38400 'I
Serial C
Output : IEMF! 'I Period (s): [1.00 ¥ RTS/CTS
Fd
Movil
S Input: |CMA = Baud rate : |334UU bl
erial
Output: [Nore ] Period zec): | I~ RTS/CTS

Figura 3-14. Configurazione della base e del rover
per i rilievi RTK - Porte

12.Fare clic sulla scheda Advanced, quindi sulla scheda Multipath.
Impostare 1 seguenti parametri e fare clic su Apply (Figura 3-15).

*  Code multipath reduction - da abilitare

» Carrier multipath reduction - da abilitare

[A Recetver Conliguration E
Gionesal | MINTER | Postunrg | s | oves | Pots | Evenis Advercod |

Bt rdrteere e Muhﬁmmlw M 1 | R Dot M | Oytnss |

¥ Code multipath reduction

teee |_tge |

m‘l ] Save | Set sl paanatecs to dafacks

Figura 3-15. Configurazione dei parametri multipath
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13.Fare clic su OK per salvare le impostazioni e chiudere la finestra
di dialogo.
Una volta configurato il ricevitore, la configurazione verra mante-
nuta fino alla successiva modifica mediante PC-CDU/TopSURV/
Pocket-3D o alla cancellazione della NVRAM.
Per maggiori informazioni sulle impostazioni disponibili per la
configurazione dei ricevitori base e rover, fare riferimento al Man-
uale di riferimento di PC-CDU.

14.Continuare con le altre configurazione oppure fare clic su File »
Disconnect, quindi su File » Exit per uscire da PC-CDU. Per una
gestione corretta delle porte, ¢ bene scollegarsi prima di uscire.

per evitare possibili conflitti con la gestione delle

Scollegare il ricevitore da PC-CDU prima di uscire
@ porte seriali del computer.
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Configurazione del MINTER

L'interfaccia MINTER (Minimum INTERface) si compone di due tasti
(di accensione e FUNCTION) che controllano il funzionamento del
ricevitore, quattro LED (STAT, REC, RX/TX e BT) che visualizzano
lo stato di funzionamento del ricevitore e due LED che mostrano lo
stato della batteria (Figura 3-16).

=N
Batteria II D T @D T |,
\ P /
[ FUNCTION |
g
Pulsante Pulsante
Allmentazmne FUNCTION

-1 [

Figura 3-16. MINTER

I1 MINTER esegue le seguenti funzioni. Per maggiori informazioni
sull'uso di MINTER, vedere “Funzionamento del MINTER” a pag. 4-

7.

Consente di accendere o spegnere il ricevitore e di portarlo nella
modalita sospensione.

Consente di attivare o disattivare la registrazione dei dati
(pulsante FUNCTION).

Consente di modificare I'information mode del ricevitore.

Consente di visualizzare il numero dei satelliti GPS (verde) e
GLONASS (arancione) da tracciare (LED STAT).

Consente di visualizzare lo stato di registrazione dei dati (LED
REC).

Consente di registrare in ogni momento i dati nella memoria
interna (LED REC).
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» Consente di visualizzare lo stato della modalita di post-
elaborazione (statica o dinamica) mentre si esegue il rilievo
cinematico in post-elaborazione con 1'aiuto del tasto FN (LED
REC).

» Consente di visualizzare lo stato (condizione di carica completa,
carica intermedia o scarica) della batteria (LED BATT).

* Consente di visualizzare lo stato di alimentazione del ricevitore
(LED BATT).

» Consente di visualizzare lo stato del modem e se ricevono
segnali (LED TX RX).

* Consente di visualizzare l'attivita Bluetooth (LED BT).

Utilizzare PC-CDU per configurare le impostazioni MINTER. La
seguente procedura descrive le impostazioni piu comuni; fare
riferimento al Manuale di riferimento di PC-CDU per altre possibili
configurazioni di MINTER.

1. Collegare ricevitore al computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19.

2. Nella finestra principale di PC-CDU, fare clic su File » Connect.

3. Nella finestra di dialogo Connection Parameters, abilitare RTS/
CTS handshaking (Figura 3-17).
Vedere “Collegamento del ricevitore al computer” a pag. 2-19 per
informazioni sull'impostazioni di altri parametri.

4. Fare clic su Connect.

[Ed Connection Patameteis
Connection mode
& Direcl € Intamat Cliant € Interrat Sarvar

Foit selting:

Fort: | COM1 | Eaud rate: | 116200 v | [ Infrared pot

¥ RT5/TS handshaking

Pregram seiting: f/
I Pasivemode [ {malmudzurw Timeout fimsl: | 500 -

nanal baue rate on Disconrect

v RTS/CTS handshaking fe—

|

I Display ataon corver [# Loc srverovents | BHS aclap

TER pit] 000

Figura 3-17. Parametri di connessione - Impostazioni di MINTER

5. Fare clic su Configuration » Receiver quindi sulla scheda
MINTER, impostare i seguenti parametri e fare clic su Apply
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(Figura 3-18 a pag. 3-22). Fare riferimento alle pagine seguenti
per le descrizioni di questi parametri.

Recording interval, page 22.

Elevation mask for log file, page 23.

File name prefix, page 23.

Always append to the file, page 23.

Files Creation mode, page 23.

Automatic File Rotation Mode (AFRM), page 23.
FN key mode, page 25.

Initial data collection dynamic mode, page 25.
Data recording auto-start, page 25.

[ Receiver Configuration x|

General MINTER | Postioring| Base | Fover | Farte | Events | Advanced|

Recording interva) : 100 [seconds) FN key mad
Elsvatin nack fr Log e [5 (degross] ’76‘ LED blink meda switch  * ooupation mada switch

File name prefix : log "\nin'al data callection d mode

ezl e % 5ttic € Kinevate

Files Creation medh Dita rscerding atostat——————————————
’Vrr Leg fie © HFRM ’Vr-‘ of  in © Hvas

[#utomatic File Rotaton Mode (3FRM) pammeters

Parad(sec]: [ 300 Fis featal] - [0
Phase(secl: [0 Fies remair o]0

I~ Automatically remove ofd files,

Feresh | pple |

Exit Save | Gat ol paramsters bo difaults |
—

Figura 3-18. Configurazione del ricevitore - scheda MINTER
Parametro Recording Interval L'intervallo di registrazione dei dati
che il ricevitore memorizza una volta premuto il tasto function
(premuto per 1 - 5 secondi). Questa impostazione serve per registrare
un singolo file di registro e i dati del ricevitore nella modalita AFRM.
I valori sono 1-86400 secondi. Il valore predefinito € un secondo.

3-22
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Parametro Elevation Mask for Log File Questo parametro specifica
l'angolo di elevazione minimo per i satelliti i cui dati verranno inseriti
nei file del ricevitore registrati premendo FUNCTION. Il valore
predefinito ¢ 5 gradi.

Parametro File Name Prefix Questo parametro specifica il prefisso
aggiunto ai nomi dei file del ricevitore creati premendo FUNCTION.
Il prefisso puo essere lungo max. 20 caratteri. Il valore predefinito per
il prefisso ¢ "log".

I nomi dei file di registro hanno la seguente struttura:
<prefisso><mese><giorno><lettera dell'alfabeto progrssiva>

Il nome del file dipende dall'ora di creazione del file (mese e giorno) e
1 suffissi con lettere aggiuntive servono per evitare confusione tra i file
creati nello stesso giorno.

Parametro Always Append to the File Se si intende allegare nuovi
dati del ricevitore a un file di registro esistente, immettere il nome del
file desiderato in questo parametro. L'impostazione puo avere una
lunghezza massima di 20 caratteri.

Parametro Files Creation Mode Questo parametro dispone delle
seguenti modalita:

* Log file - Se ¢ stato selezionato il pulsante di opzione del
file di registro, premendo il pulsante FUNCTION ¢
possibile chiudere il file di registro corrente. Se la
registrazione dei dati ¢ disattiva, premendo FUNCTION ¢
possibile aprire un nuovo file di registro.

* AFRM - Se ¢ stato selezionato il pulsante di opzione
AFRM, premendo FUNCTION ¢ possibile abilitare questa
modalita. Se ¢ stata abilitata I'opzione AFRM, premendo
FUNCTION ¢ possibile disabilitare questa modalita.

Parametri Automatic File Rotation Mode (AFRM) I ricevitori TPS
sono in grado di mettere in successione automaticamente i file di
registro. Durante I'evento "file rotation", il ricevitore chiude il file
corrente e ne apre uno di nuovo in base definito dall'utente. I parametri
Period e Phase specificano questo criterio.

Quando si apre un nuovo file di registro il ricevitore imposta i
parametri della modalita AFMR con valori predefiniti. Tutti i
parametri sono programmabili.
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Period - specifica la durata di ogni file di registro creato in
modalita AFRM. I valori sono compresi tra 60 e 86400
secondi; il valore predefinito ¢ 3600 secondi.

Phase - specifica la "fase" (time shift costante) di creazione
di piu file di registro nella modalita AFRM. I valori sono
compresi tra 0 e 86400 secondi; il valore predefinito ¢ zero
secondi.

Files (total) - un contatore che specifica quanti file di
registro multipli devono essere creati in AFRM fino alla
disattivazione automatica di questa modalita. Questo
contatore si riduce ad ogni sequenza del file fino a
raggiungere il valore zero, dopo di che la sequenza del file
si interrompe automaticamente.

Si ricordi che un file di registro si apre immediatamente
dopo avere attivato AFRM. Questo file di avvio non ¢ con-
siderato un evento di rotazione del file; il contatore AFRM
non diminuira.

I valori sono compresi tra 0 e [231-1]; il valore predefinito ¢
0 (zero). Zero significa che verra creato un numero illimi-
tato di file di registro

@ La memoria del ricevitore puo contenere fino a 512

file.

3-24

Files (remain) - specifica il numero di file che il ricevitore
deve ancora creare in AFRM. I valori sono compresi tra 0 e

[231-1]; il valore predefinito ¢ zero.

Automatically remove old files - se non ¢'¢ memoria libera
per registrare i dati, consente di rimuovere automaticamente
il file di registro piu obsoleto. Se questo parametro ¢
abilitato, il ricevitore cancellera il file con 1'ora/data di
creazione piu vecchia. Per usare questa funzione FIFO
(First-In, First-Out), ¢ necessario abilitare AFRM. Il valore
predefinito ¢ OFF (disabilitato).
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Parametro FN Key Mode Utilizzare questi due pulsanti di opzione
per programmare il tipo di reazione del ricevitore quando si preme il
tasto FUNCTION.

* LED blink mode switch - premendo FUNCTION ¢
possibile scegliere tra le information mode normale/estesa
di MINTER e avviare/interrompere la registrazione dei dati
del rilievo statico.

- FUNCTION premuto per meno di un secondo: modifica
l'information mode (normale o estesa).

- FUNCTION premuto per 1-5 secondi: consente di
avviare o interrompere la registrazione dei dati (modalita
di post-elaborazione statica).

*  Occupation mode switch - premendo FUNCTION (per
meno di un secondo) ¢ possibile inserire nel file di registro
corrispondente un messaggio indicante il tipo di rilievo
modificato da statico a cinematico o viceversa. Se il LED
REC LED lampeggia di verde, la modalita corrente ¢
dinamica; se lampeggia di arancione, la modalita corrente ¢
statica. Per maggiori informazioni, vedere la Table 1 - 2 on
page 14 e fare riferimento al Manuale di riferimento di PC-
CDU.

Parametri Initial Data Collection Dynamic Mode Questi pulsanti di
opzione specificano il descrittore del tipo di occupazione iniziale
inserito all'inizio dei file di registro del ricevitore. Selezionare Static o
Kinematic per impostare l'avvio del file di registro corrispondente con
un'occupazione statica (STOP) o cinematica (GO, traiettoria).

Parametro Data Recording Auto-start Questi pulsanti di opzione
consentono di programmare il comportamento del ricevitore in caso di
assenza di corrente.

La tabella 3-7 descrive i diversi scenari disponibili e i risultati una
volta ripristinata l'alimentazione al ricevitore. "Specified file" si
riferisce al nome del file immesso nel campo Always append to file.
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Tabella 3 - 7: Comportamento dei parametri di registrazioni dati

Prima del guasto
alla corrente

Risultati con pulsante di opzione abilitato

Off

On

Sempre

Dati del ricevitore
registrati nel file
specificato.

La registrazione
dei dati non
riprende una volta
ripristinata
l'alimentazione.

Il ricevitore
riprendera la
registrazione dei
dati nello stesso
file una volta
ripristinata
I'alimentazione.

Il ricevitore
riprendera la
registrazione dei
dati nello stesso
file una volta
ripristinata
I'alimentazione.

Dati del ricevitore
registrati nel file
predefinito.

La registrazione
dei dati non
riprende una volta
ripristinata
l'alimentazione.

Si aprira un nuovo
file di registro una
volta ripristinata
I'alimentazione; i
dati verranno
registrati in questo
file.

Si aprira un nuovo
file di registro una
volta ripristinata
I'alimentazione; 1
dati verranno
registrati in questo
file.

File specificato;
registrazione dei
dati del ricevitore
non iniziata.

Non si aprira
nessun file con
questo nome. La
registrazione dei
dati non si aprira
una volta
ripristinata
l'alimentazione.

Non si aprira
nessun file con
questo nome. La
registrazione dei
dati non si aprira
una volta
ripristinata
l'alimentazione.

Si aprira un file di
registro con questo
nome e la
registrazione dei
dati avra inizio
dopo il ripristino
dell'alimentazione.

Nessun file
specificato;
registrazione dei
dati del ricevitore
off.

La registrazione
dei dati non si
aprira una volta
ripristinata
l'alimentazione.

La registrazione
dei dati non si
aprira una volta
ripristinata
I'alimentazione.

Si aprira un file di
registro con un
nome predefinito e
la registrazione dei
dati avra inizio
dopo il ripristino
dell'alimentazione.
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Inoltre, se Always ¢ abilitato, il ricevitore iniziera automaticamente la
registrazione dei dati (in un file esistente o appena creato) nei seguenti

tre casi:
» Dopo avere acceso il ricevitore con il pulsante di alimentazione.

* Dopo avere ripristinato il ricevitore (con PC-CDU).
* Dopo avere disattivato la modalita sospensione.

[ Receiver Configuration x|

General  MINTER | Positoning | Base | Fiover | Ports | Events | Advanced |

Fiecording interva - 100 [seconds) FM ey mode
Eevationmesk for Logfle:  [5 dsgiess) [r-‘ LED blink mads switch ¢ Oscupation node switch

Fle name prefi : [ Initial data colection dynamic mods
IRl | Irri‘ Stats 0 Kinematic
Deka recording aute-star
AFRM |Vf;' off © n 1 Aluays

Files Creaticn maods

& Logfile “

—Autamatic Flls Retation Mods [AFAM) paramsters———

Frind fsec)l [3600 Files (tatall [0
[aasc fsez); [0 Frile: (remain] 0

I | Avtormatically ey old files

Retesh | dopy |

Exit Save | Set allpaiameters to defauits |

Figura 3-19. Scheda MINTER
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Note:
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Capitolo 4

Inizializzazione del
ricevitore GR-3 e
rilievo

Il rilievo puo avere inizio solo dopo aver inizializzato il ricevitore e
misurato 'altezza dell'antenna

Setup del ricevitore

Un sistema di acquisizione GPS standard ¢ costituito da una stazione
base posizionata in un punto conosciuto e un ricevitore rover
configurato eseguire un rilievo e memorizzare i dati. Dopo la
configurazione dei ricevitori base e rover, ¢ necessario misurare
l'altezza dell'antenna.

Prima di raccogliere i dati, assicurarsi che i ricevitori base e rover
contengano dati correnti di almanacco ed effemeridi (vedere
“Acquisizione di almanacchi ed effemeridi” a pag. 2-26).

Passo 1. Configurazione dei ricevitori

La stazione base deve essere configurata per registrare e trasmettere i
dati prima di configurare il ricevitore rover. Il setup del ricevitore per
i rilievi in post-elaborazione o RTK ¢ lo stesso.

O Configurazione della stazione base e dei suoi componenti.

Per maggiori informazioni, vedere “Per configurare il ricevi-
tore base” a pag. 4-2.

O Configurare il ricevitore rover.

Per maggiori informazioni, vedere “Per configurare il ricevitore
rover” a pag. 4-3.

41



Inizializzazione del ricevitore GR-3 e rilievo

Per configurare il ricevitore base (Figura 4-1):

1.
2.

Posizionare un treppiede su un punto di controllo conosciuto.
Fissare il tribraco universale al treppiede. Posizionare l'adattatore
(universale o di precisione) sul tricuspide e serrare le viti.

. Inserire la spina a L (distanziale orizzontale) nell'adattatore del

tribraco di precisione.

Collegare il ricevitore GR-3 all'adattatore del tribraco. Collegare
I'antenna desiderata al connettore dell'antenna del modem.
Livellare con cautela il treppiede e serrare le viti.

Se necessario, collegare eventuali altri accessori (ad esempio, una
fonte di alimentazione esterna).

Ricevitore GR-3

Distanziale

Adattatore

Tricuspide universale

Figura 4-1. Installazione del treppiede e
del ricevitore su un punto di controlio
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Per configurare il ricevitore rover (Figura 4-2):

1. Se necessario, collegare l'attacco rapido al bipod/palina.

% Usare un bipod durante i rilievi in post-elaborazi-

one per assicurare che I'antenna/ricevitore rimanga
fermo durante la registrazione dei dati.

2. Collegare il ricevitore GR-3 all'attacco rapido. Assicurarsi che il
ricevitore sia bloccato in posizione.

3. Collegare I'antenna radio al connettore.

T

T Ricevitore GR-3

)

3 T Attacco rapido

[~ Vite da 5/8”

Blocco

Figura 4-2. Collegamento del ricevitore GR-3 al bipod
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Passo 2: Misurazione dell'altezza dell'antenna

La posizione dell'antenna relativamente al punto da misurare ¢ molto
importante sia per i rilievi in 3D che per quelli in 2D. I rilievi
orizzontali hanno spesso una superficie piu grande che non permette
'adattamento su un piano piatto; la regolazione dell'antenna deve
pertanto essere tridimensionale e quindi proiettata in un piano
bidimensionale.

Il ricevitore calcola le coordinate del centro di fase dell'antenna. Per
determinare le coordinate del punto a terra, l'utente deve specificare
quanto segue:

» Altezza misurata dell'antenna sopra il punto
* Metodo di misurazione dell'altezza dell'antenna
* Modello di antenna usato

Le antenne hanno due tipi di misurazione:

* Vertical - misurata dal chiodo al punto di riferimento
dell'antenna (ARP) che si trova sotto il ricevitore alla base dei
filetti di montaggio.

¢ Slant - misurato dal chiodo al bordo inferiore del SHMM
dell'antenna che si trova ai pannelli alle due estremita del
ricevitore.

11 punto di acquisizione delle misure GPS/GLONASS sull'antenna ¢
definito centro di fase dell'antenna. Si tratta di qualcosa di analogo al
punto in cui un distanziometro collima un prisma. Un utente deve
immettere I'offset del prisma per compensare questo punto che non si
trova su una superficie fisica del prisma. Per un'antenna GPS/
GLONASS, l'offset viene immesso in funzione del tipo di misurazione
effettuata.

» Per Vertical, 'offset viene semplicemente aggiunto all'altezza
verticale misurata per produrre un'altezza verticale "effettiva".

* Per l'altezza inclinata, I'altezza verticale deve essere dapprima
calcolata con il raggio dell'antenna, dopo di che ¢ possibile
aggiungere 1'offset.

Gli offset sono diversi in virtu della differenza di posizione tra il punto
di misurazione inclinato e il punto di misurazione verticale.
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1. Misurare l'altezza dell'antenna sopra il punto di controllo o sul
chiodo, indipendentemente dal fatto che si tratti di altezza
inclinata o verticale (Figura 4-3).

2. Registrare 'altezza dell'antenna, il nome del punto e I'ora di inizio
nelle note.

66,5mm
| men) |
T 2 2345
= ,5mm
==l
168mm
A= ARP al bordo = 78,3
B = ARP all'angolo = 96,7
I
e
[y
Altezza inclinata
alla base Altezza verticale
dell'angolo su ad ARP

parabordo grigio

Durante la misurazione dell'altezza
dell’'antenna rover, includere l'altezza
dell'attacco rapido.

Chiodo di stazione

Figura 4-3. Misurazioni dell'offset dell'antenna

* SHMM a offset verticale ARP = 168mm
* SHMM a raggio ARP = 78,3mm al lato; 95.8mm all'angolo
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La tabella 4-1 indica 1 valori di offset dei ricevitori.

Tabla 4 - 1: Valori di offset del ricevitore GR-3

ARP al centro di fase L1 ARP al centro di fase L2

In alto 228,8 mm 216,3 mm

Passo 3: Raccolta di dati

Vedere le altre sezioni di questo capitolo per maggiori informazioni
sulla raccolta di dati.

1. Accendere il ricevitore. Il led STAT lampeggera di colore rosso.

2. Una volta che il ricevitore si sia fissato su uno o piu satelliti, la
spia STAT lampeggera di verde per satelliti GPS e di arancione per
i satelliti GLONASS. Un lampeggio rosso rapido indica che il
ricevitore non ha acquisito una posizione. Quattro o piu satelliti
assicurano un posizionamento ottimale.

3. Una volta che il lampeggio rosso rapido smette, il ricevitore ha
acquisito una posizione e puo iniziare il rilievo; attendere le spie
verde e arancione prima di iniziare la raccolta dai dati. Questo
assicura che il ricevitore abbia la data e I'ora corrette e sia fissato
su un numero di satelliti sufficiente per garantire una buona qualita
dei dati.

Il processo di fissaggio sui satelliti richiede di solito meno di un
minuto. In presenza di ostacoli, oppure dopo il ripristino del
ricevitore, potrebbe richiedere parecchi minuti.

4. Per iniziare la raccolta di dati, tenere premuto il tasto FUNCTION
(per oltre di un secondo e per meno di cinque secondi).

5. Rilasciare il tasto FUNCTION quando il LED REC
(registrazione) diventa verde. Questo indica che ¢ stato aperto un
file e che la raccolta dei dati ha avuto inizio. Il LED REC
lampeggia ogni volta che i dati vengono salvati nella memoria
interna.

Utilizzare PC-CDU per configurare la registrazione
dei dati. Vedere “Configurazione del MINTER” a
pag. 3-20 oppure fare riferimento al Manuale di
riferimento di PC-CDU

4-6 GR-3 Manuale Operativo



Funzionamento del MINTER

6. Al termine, tenere premuto il tasto FUNCTION fino allo
spegnimento della spia del LED REC.

7. Per spegnere il ricevitore, premere e tenere premuto il tasto di
alimentazione fino allo spegnimento di tutte le spie, quindi
rilasciarlo.

Funzionamento del MINTER

MINTER ¢ l'interfaccia minima del ricevitore usata per visualizzare e
controllare gli input e gli output di dati (Figura 4-4).

[ —

\o =)

| l' ."
Batteria ‘| s,m D @& CFD .f“‘:. -
o
\ { FUNCTIO[\I/\ /
Pulsante Pulsante
Allmentazmne FUNCTION

Figura 4-4. MINTER del GR-3

MINTER esegue numerose funzioni:

Accensione o spegnimento del ricevitore.

Attivazione o disattivazione della registrazione dei dati (tasto

FUNCTION).

Consente di modificare l'information mode del ricevitore.

Consente di visualizzare il numero dei satelliti GPS (verde) e
GLONASS (arancione) da tracciare (LED STAT).

Visualizzazione dello stato di registrazione dei dati e delle
singole registrazioni dei dati nella memoria interna (LED REC).
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Inizializzazione del ricevitore GR-3 e rilievo

* Visualizzazione dello stato della modalita post-elaborazione

(statica o dinamica) durante un rilievo cinematico in post-
elaborazione (LED REC).

» Consente di visualizzare lo stato (condizione di carica completa,
carica intermedia o scarica) della batteria (LED BATT).

* Consente di visualizzare lo stato di alimentazione del ricevitore
(LED BATT).

* Consente di visualizzare lo stato del modem e 'eventuale
ricezione di segnali (LED RX TX).

* Consente di visualizzare l'attivita Bluetooth (LED BT).

Vedere “MINTER” a pag. 1-10 per una descrizione completa
dell'applicazione MINTER.

Per accendere/spegnere il ricevitore, premere il tasto di
alimentazione (Figura 4-5).

* All'accensione, premere il tasto di alimentazione fino a quando
i LED di MINTER lampeggiano brevemente.

* Allo spegnimento, premere il tasto di alimentazione fino allo
spegnimento dei LED, quindi rilasciarlo.

Premere il tasto di alimentazione
per circa un secondo per
accendere/spegnere il ricevitore.

- Y

=Y
| (ST RECD (AXTX BT /
W o & an e (I

N o merion)
\ -\@ (FUNCTION ) /

Pulsante
Alimentazione

Figura 4-5. Funzioni del tasto di alimentazione

Per avviare/interrompere i dati di registrazione, premere il tasto
FUNCTION per 1-5 secondi (Figura 4-6).
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* Durante la registrazione dei dati, il LED REC diventa verde.
Usare PC-CDU per impostare l'intervallo di registrazione. Per
maggiori informazioni, vedere “Parametro Recording
Interval” a pag. 3-22.

» II LED REC lampeggia di verde ogni volta che i dati vengono
scritti nella memoria SD/MMC.

* Se il LED REC ¢ rosso, il ricevitore ¢ privo di memoria,
presenta un problema hardware, non dispone di scheda SD/
MMC oppure contiene un OAF inadeguato (vedere “Option
Authorization File (OAF)” a pag. 1-23 per maggiori
informazioni).

Utilizzare PC-CDU per abilitare la modalita del tasto FUNCTION nel
ricevitore, "LED blink mode switch" per i rilievi statici oppure
"Occupation mode switch" per i rilievi cinematici. Vedere
“Parametro FN Key Mode” a pag. 3-25 per maggiori informazioni.

Ogni volta che si avvia o si interrompe la registrazione dei dati, si apre
un nuovo file oppure vengono allegati dati aun file particolare. Vedere
“Parametro Always Append to the File” a pag. 3-23 e “Parametro
Files Creation Mode” a pag. 3-23 per informazioni sull'impostazione
di queste funzioni.

Premere il tasto FUNCTION
per 1-5 secondi per
avviareflinterrompere la
registrazione dei dati.

= —_
' ~ \I
w

) o @ e e |
TN e
NP4

\_ Pulsante 8 I
FUNCTION

Figura 4-6. Funzioni del tasto FUNCTION
Per passare da una modalita di post-elaborazione all'altra,

premere il pulsante FUNCTION per meno di un secondo una volta
abilitato "Occupation mode switch" con PC-CDU.
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Per modificare I'information mode del ricevitore, premere il
pulsante FUNCTION per meno di un secondo una volta abilitato
"LED blink mode switch" con PC-CDU.

Per cambiare la velocita di trasmissione della porta seriale del
ricevitore, premere il pulsante FUNCTION per 5-8 secondi. Questo

risulta utile se il controller non supporta la velocita impostata per la
porta del ricevitore.

Dopo circa cinque secondi, il LED REC diventa rosso. Rilasciare il
pulsante FUNCTION nei successivi tre secondi.

Rilievo statico

Il rilievo statico ¢ il metodo di acquisizione classico. Almeno due
antenne del ricevitore, posizionate sui punti predefiniti, raccolgono
simultaneamente i dati grezzi per un certo periodo di tempo. Questi
due ricevitori devono tracciare quattro o piu satelliti comuni, devono
avere un intervallo di registrazione (5-30 secondi) e gli stessi angoli di
elevation mask. La lunghezza delle sessioni di osservazione puo
variare da alcuni minuti a diverse ore. Il tempo di registrazione
ottimale dipende dall'esperienza dell'utente e dai seguenti fattori:

* La lunghezza della base line

* Il numero di satelliti in vista

» La geometria dei satelliti (DOP)
» La posizione dell'antenna

+ Il livello di attivita ionosferica

* [ tipi di ricevitori usati

* [ requisiti di precisione

» Lanecessita di risolvere le ambiguita carrier-phase

4-10 GR-3 Manuale Operativo



Rilievo in Stop & Go

Generalmente, i ricevitori monofrequenza vengono usati per basi
topografiche con lunghezze non superiori a 15 km (9,32 miglia). Per
le basi topografiche di 15 km o superiori, ¢ preferibile usare ricevitori
a doppia frequenza.

I ricevitori a doppia frequenza presentano due vantaggi principali.
Innanzitutto sono in grado si stimare e rimuovere quasi tutti gli effetti
ionosferici dalle misurazioni code-phase e carrier-phase, garantendo
un'accuratezza molto superiore a quella dei ricevitori monofrequenza
su basi topografiche lunghe o durante tempeste ionosferiche. In
secondo luogo, i ricevitori a doppia frequenza richiedono tempi di
osservazione molto inferiori per raggiungere il grado di precisione
desiderato.

Una volta completato il rilievo, i dati raccolti dai ricevitori possono
essere scaricati su un computer ed elaborati con un software per la
post-elaborazione (ad es. Topcon Tools).

Rilievo in Stop & Go

Nei rilievi in Stop & Go il ricevitore base viene posizionato su un
punto noto o su un punto qualsiasi e viene avviato alla registrazione di
dati grezzi.Il ricevitore rover viene configurato in un punto qualsiasi e
raccoglie i dati nella modalita statica per 2-10 minuti. Al termine, si fa
passare il ricevitore in modalita cinematica e ci si muove verso un
punto successivo. In questo modo, durante lo spostamento, il rover si
trova nella modalita cinematica, mentre durante la raccolta di dati si
trovera nella modalita statica.

1. Posizionare il rover in un da rilevare, quindi premere Power.
Consentire al rover di raccogliere i dati statici per 2-10 minuti. Il
LED REC sara di colore arancione.

2. Controllare la spia STAT per i satelliti tracciati.

3. Al termine, premere il pulsante FUNCTION per meno di un
secondo per assegnare il rover alla cinematica.

modalita corrente ¢ dinamica; se lampeggia di aran-

é : i Nota bene: se il LED REC lampeggia di verde, la
cione, la modalita corrente ¢ statica.
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4. Spostare il rover nella posizione successiva e premere il pulsante
FUNCTION per meno di un secondo per raccogliere i dati nella
modalita statica per 2-10 minuti.

5. Ripetere3 e 4 fino all'acquisizione di tutti i punti. Il tempo di
occupazione dei punti dipende dagli stessi fattori menzionati per il
rilievo statico.

6. Al termine, premere il pulsante FUNCTION per 1-5 secondi per
interrompere la registrazione dei dati. Se necessario, spegnere il
rover.

Questo metodo di acquisizione GPS consente all'operatore di ridurre il
tempo di occupazione, acquisendo molti piu punti rispetto agli altri
metodi disponibili.

Rilievo in tempo reale

Nei rilievi in RTK, un ricevitore ¢ posizionato su un treppiede o funge
da BASF, mentre l'altro ¢ posizionato su un'asta e si sposta verso i
punti da rilevare fungendo da ROVER. A differenza dei rilievi in post-
elaborazione, nei rilievi in RTK c'¢ una comunicazione tra la base e il
rover. Attraverso un collegamento via radio modem, il ricevitore base
trasmesse i dati di misura e di posizione al ricevitore rover. Il rover, in
base ai dati ricevuti e ai relativi dati di osservazione, effettua
immediatamente un'analisi della base topografica creando dei risultati.
Per le impostazioni specifiche usate nei rilievi RTK, vedere
“Configurazione del dispositivo integrato radio modem” a pag. 3-3 ¢
“Configurazione del ricevitore” a pag. 3-9.

Se si utilizza PC-CDU per monitorare un ricevitore rover RTK,
controllare il campo LQ sulla schermata principale (Figura 4-7 a
pag. 4-13) per assicurarsi che il ricevitore ottenga la correzione
differenziale. Di solito, il ricevitore iniziera a ricavare le coordinate
del centro di fase dell'antenna insieme al tipo di soluzione nel giro di
10-30 secondi. Tuttavia, la radio integrata e i telefoni GSM possono
richiedere fino a 60 secondi per la sincronizzazione.

Le coordinate geodetiche visualizzate nella scheda Geo vengono
sempre calcolate in WGS84 e dispongono di quattro tipi di soluzione.

» Standalone - in culi il ricevitore calcola le coordinate 3D in
modo autonomo senza usare correzioni differenziali.
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* Code differential - in cui il ricevitore rover calcola la coordinata
relativa corrente in modo differenziale usando pseudo range.

* RTK float - in cui il ricevitore rover calcola le coordinate
relative correnti in modo differenziale usando pseudo range e
pseudo-fase; tuttavia, con una soluzione float, I'ambiguita di
fase non ¢ un numero intero fisso e al suo posto viene usata la
stima "float".

e RTK fixed - in cui il ricevitore rover calcola le coordinate
relative correnti, con fissaggio dell'ambiguita, in modo
differenziale.

Il campo LQ riflette lo stato dei messaggi differenziali ricevuti e
contiene le seguenti informazioni:

» Percentuale di qualita del collegamento dati
» Tempo (in secondi) trascorso dall'ultimo messaggio ricevuto

* Numero totale di messaggi ricevuti correttamente (in base al
tipo di messaggio ricevuto)

* Numero totale di messaggi non ricevuti correttamente (in base
al tipo di messaggio ricevuto)

Se il ricevitore (per qualsivoglia ragione) non riceve le correzioni
differenziali oppure se nessuna delle porte ¢ stata configurata per la
ricezione delle correzioni differenziali, il campo LQ sara vuoto oppure
apparira come descritto di seguito: 100%(999,0000,0000).

[APC-CDU to GR3 ID:RBPTIIQGOGW (rover) =10i x|

File Configuration Tooks FPlots Help

GPS Satellites (9) Geo |xvz | Taget| GLONASS Satellites (6)
u [ B] az[calm[pe] 1c] ss] Lat 85:43187161"N  [sn[Fn] EL] ez[cal Pr]pe] 1c] ss]
03 20+ 62 42 27 27 k:.ﬂl%&g?nﬂs.rl‘m E M 07 54+ 286 40 41 47 4 55+
(17 7- 16 41 18 18 Vel 00142 m/s 02 01 18+ 334 38 39 41
08 53 242 51 42 42 %5+ AMS Pox 0.0158m 08 05 38- 206 41 43 45
10 45+ 288 50 39 39 55+ RMSVel 02114mse |18 10 24~ 28 34 3% 3
13037~ 12 46 34 W PDOP: 17296 19 03 23+ B0 41 43 43
19 13 94 44 24 2 RIK 20 11 12+ 112 36|38 37
27 87" 142 51 44 M

554
B e oo onm ?ﬂf Receiver time; 14:17.05 \

2 8 200 221120 Receiver date; 08.06.2006

Gk it g65530m [ Lo: 1002 (000,0363,0000) |
Tracking time: 00:06:17

|COM1, 115200, HS 00:0259 |

55+
55+
55+
55+
55+

PPN

ENTLIE N I RN
7

Figura 4-7. Schermata principale di PC-CDU
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Note:
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Capitolo 5

Gestione file e
manutenzione del
ricevitore

I dati di post-elaborazione registrati nella memoria del ricevitore
devono essere scaricati su un PC per essere elaborati da un software
adeguato. La memoria del ricevitore deve essere cancellata per essere
operativa nei rilievi successivi. Occasionalmente, la NVRAM del
ricevitore puo essere cancellata per eliminare eventuali problemi di
comunicazione o tracciamento.

E' possibile aumentare le funzionalita del ricevitore con ulteriori
opzioni mediante un file OAF. Le diverse schede all'interno del
ricevitore (GPS, alimentazione, modem e Bluetooth) richiedono un
firmware per funzionare in modo corretto e garantire una funzionalita
corretta. Caricando gli aggiornamenti firmware messi a disposizione
da TPS ¢ possibile sfruttarne a pieno la portenza del ricevitore.

Trasferimento di un file ad un
computer

Dopo avere completato un rilievo € possibile scaricare i file del rilievo
stesso su un PC per l'archiviazione, la post-elaborazione e il backup.
Inoltre poiché la memoria del ricevitore pud contenere una quantita
limitata di file, il trasferimento evita che ssi possano andare persi. PC-
CDU e Topcon Link dispongono di un file manager che consente di
scaricare i file dal ricevitore al computer e di cancellare i file dal
ricevitore. PC-CDU Lite e Topcon Link sono utilita gratuite
disponibili presso il rivenditore Topcon o il sito Web di Topcon
(www.topconpositioning.com).
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Utilizzare Topcon Tools per scaricare i file dalla
scheda SD. Fare riferimento al manuale di riferi-
mento di Topcon Tools per maggiori informazioni.

Scarico dati tramite Topcon Link

Topcon Link fornisce due opzioni per lo scarico dei dati da un
ricevitore: tramite Risorse del computer o 1'interfaccia Topcon Link.
Prima di scaricare i file, € necessario collegare il ricevitore al computer
(vedere “Collegamento del ricevitore al computer” a pag. 2-19 per
informazioni su questa procedura).

...Utilizzo di Risorse del Computer

1. Collegare ricevitore e computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19 per informazioni su questa
procedura.

2. Aprire Risorse del Computer e fare clic sulla cartella Topcon
Receiver. 1l pannello destro della finestra visualizza I'avvio
automatico della ricerca dei ricevitori Topcon collegati a una porta
qualsiasi del computer (COM e USB) (Figura 5-1).

3. Al termine, verranno visualizzati tutti i ricevitori collegati alle
porte del computer (Figura 5-1).

B Topcon Receivers

Fle Edit View Favorites Tools  Help i

Qo - © - [ SO searh ([ rolders
Address &) Topean Reeivers ~ 8=
Folders x Q

® &) Tepeon Recsivers ~
# & Tepeon TotalStations

® &ty Meswork Places
& Recyck Bin

# EJ My Bluetooth Places

Noigceivers found

Stop oy
v

= =
#ddress | &) Topeon Receivers ~ Be

Folders x N .
T . ' @ @

<7 HE_GD Search for HE_GD HIPER
- connett...

= HIPER
¥ & Topcon TotalStations

& % My Mekwark Places
LD, -

v

Figura 5-1. Ricerca dei ricevitori Topcon in Windows Explorer
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4. Per arrestare la ricerca dei ricevitori una volta trovato il ricevitore

desiderato, fare clic su Stop. Verranno visualizzati solo i ricevitori
trovati.

B Topcon Receivers

Fle Edt View Favorites Tools Heb

Qe - © T Oz

fiddress [ @) Topeen Recsivers v He 5 /W‘Search
I
Folders -

4® Topcon Digital Levels ~ &9 Bsivers V| £d &
&) Topeon Receivers x & Q
& Topcon Total Stations There are 1 new receiver(s] found T

& My Network Places ~ | searchfor HIPER.
#l Recyck Bin ftop lk‘ connext. .

My Blustooth Flaces

EBIX
ﬁr

[ Felders

Favorives  Tooks  Hela *

[ Faders

<

al Stations
| % 3 My Network Places =

2 Recyck Bin v

Figura 5-2. Interruzione della ricerca dei ricevitori
5. Per aggiornare le informazioni sui ricevitori collegati alla porta del
computer, fare clic su Search for connected receivers.
6. Per visualizzare le informazioni sul ricevitore (Figura 5-3), fare

clic con il tasto destro del mouse sul ricevitore desiderato e
selezionare l'opzione Properties.

7. Per visualizzare il file raw, fare clic sul ricevitore desiderato

Properties X

8 Topcon Receivers =3 Rz i |
File Edt View Favories Tooks Help "
Q- Q- ¥ s ) Search [ Folders oo [THER
niicrass | 1 Topeon Resetvers v B Model: HE_ED
Folders X & @ o: 22253366650
# &) Topeon Receivers ~ o T T—
~r— Seachfor [ :
[# & Tcpeon Total Statons conreck. . Transfer options file...
2
8 Wty Metwork Places —
# Recyce Bin ¥

oF Cancel ‘ |

Figura 5-3. Proprieta del ricevitore

8. Per importare i file dal ricevitore in una cartella, selezionare i file

desiderati e copiarli nella cartella usando il metodo copia-incolla
(Figura 5-4).
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[=]Fse

File Edit ‘iew Favorites Tools Help

Qo ~ @ - (T ) 50ann

Downloading file gl 01e tps
Downloaded 4036 bytes of 5227

[ Folders

fdross [ HIPER, -
Transfer rate is 4096 byes/sec
Folders £ I B B B
5 TLData ~ NNEREENENENENERENENEEEER

ol 0T s

hm101b.tps  (pgo101c.tps  logo101e,t)
# I TepconLink Data 05 log! o5 logl #
1) Tepeon Took Data m;F
3

<

Figura 5-4. Inizio dell'importazione di file dal
ricevitore TPS/Importazione in corso

...Utilizzo del collegamento Topcon

1. Collegare ricevitore e computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19 per informazioni su questa
procedura.

2. Per avviare Topcon Link, fare clic sul pulsante Import from
Device nella barra degli strumenti.

3. Nel riquadro a sinistra della finestra di dialogo Import from
Device, fare doppio clic su Topcon Receivers (Figura 5-5).

=~ Import from Device 7”2J
Lookin My Comouter -] +| 5| s Lookin:  [Z3Raw data -] «|@| e
Mabil Device: ICFrom _Met
4 Topcan Dig & logiinib.tps
4 & Iogoinic.tps
£ lon0101e.tos
&, logi14a.tps

Figura 5-5. Finestra Import From Device
4. 1l programma ricerca automaticamente i ricevitori Topcon
collegati alle porte del computer (COM e USB). Al termine,
verranno visualizzati tutti i ricevitori collegati alle porte del
computer (Figura 5-6).
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kA Import from Device kA Import from Device:
Lookin  [&:TopconReceires =] 0| 1] 1| Lookin €\ Topcon Recsives | | 1] |
[@ksearch for connected recaners
HE_D
< HIPER
Searching. .

Stap

Figura 5-6. Ricerca dei ricevitori Topcon

5. Per visualizzare le informazioni sul ricevitore (Figura 5-7 a pag. 5-

5), fare clic con il tasto destro del mouse sul ricevitore desiderato e
selezionare l'opzione Properties.

=~ Import from Device Properties ﬁ?\
Lookin [ Topeon Receive +| 4| 1] Racevan propertes |
k¢Search for connected receivers
< HE_GD
OI i! s
Select Recsver: | INED
Transfer opions F\b‘%‘ il o e —
o 27233386656
Fort; CamM1
oe Cancel ‘ |

Figura 5-7. Proprieta del ricevitore

6. Nel riquadro a destra della finestra Import From Device, sfogliare
e selezionare, oppure creare una cartella in cui salvare i file
(Figura 5-8).

7. Per visualizzare il file raw, fare doppio clic (oppure fare clic sul
menu di pop-up Select) sul ricevitore desiderato. Per importare i
file dal ricevitore al computer e per salvarli nella cartella
selezionata, evidenziare i file desiderati e fare clic sulle doppie
frecce (Figura 5-8).

8. Viene visualizzata l'importazione in corso (Figura 5-8).
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ﬁ Import from Device @@
Lookin: [« HIPER -| | =] Lookin: [JRawdata  ~| 4| | £¥|
] 1.tps ] logz004113 Cfrom _Net

B logD101a.tps ﬂ logz004113 £ logD101b.tps

#] log0225a.tps & |o50101c.tps

2] l0g0225b tps ] L log0101e tps

#] log0228a.tps #log0314a tps

#] log0304a.tps
[#] l0g0304b.tps
#]l0g20041117_51538.tps

Progress... @
[#] 10020041117 51710.tps
#] log20041130_2942.tps Downioading fle Iogli304b tps
< » Downiloaded 137216 bytes of 12003568

Transter rate is 8071 bytes/sec

Close

Cancel

Figura 5-8. Selezione del file di dati grezzi da
importare e visualizzazione dello stato
di avanzamento dell'importazione

Scarico dati tramite PC-CDU

1. Collegare ricevitore e computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19 per informazioni su questa
procedura.

2. Aprire PC-CDU. Nella finestra di dialogo Connection

Parameters, abilitare RTS/CTS handshaking e fare clic Connect
(Figura 5-9).

[ Connection Parameters x|

Cenneciion mode
& Direct " Intesnet Clisnt " Iniernet Server |

Part setfing
Pt [COM1 =] Baudrate: [115200 =] I Infrered port
¥ RTS/CTS handshaking

F i
Prograr setting
[~ Pasivemade [~ lama\ mode caly  Timeout [ms]: | 500 b2

vighal baud rate on Disconned:

[¥ RTS/CTS handshaking s

TIOF ot [aro0

Pesswoid: |

I Disglap dataoserver | | Log server events = ONS ook
Cancel

Figura 5-9. Parametri di collegamento - RTS/CTS Handshaking

3. Fare clic su File » File Manager, quindi fare clic sulla scheda

Download path nella finestra di dialogo File Manager (Figura 5-
10).
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ﬂ
Download files I Current log file | Dowrla[}é path |

Total memory: 47348784 bytes Free memony: 47164824 bytes
Name | Size | Date | Time
log03235 75196 23.09.2002 8:43:52
log0323b 76795 23.09.2002 851:53
log0324a 5661 24.03.2002 452:51
log0324b 4701 24.03.2002 9:52:59
log0924c 4333 24.09.2002 9:53:44
log0924d 5190 24.09.2002 9:53:55
log0924e 4676 24.09.2002 9:54:06
log0324f 4162 24.03.2002 95416

Save to: EATESTING\DATA

I~ Exclusive mode
Using: IEu'c-'.::'t U]‘.':\LJ Blncksize:|512 bytes j
Download| Delete | Refresh | Ext |
[ [

Figura 5-10. Ricerca dei file da scaricare

4. Sfogliare o creare (con il pulsante Create) la cartella in cui
scaricare e archiviare 1 file.

5. Fare clic sulla scheda Download files e selezionare i file da
scaricare (Figura 5-11).

Per selezionare piu file, premere il tasto MAIUSC facendo clic su file
non-sequenziali; in alternativa € possibile premere il tasto Ctrl e fare
clic su singoli file.

x

Download files | Current log ﬁlel Dowrload pathl

Total memary: 47348784 bytes Free memary: 47164824 bytes
Size | Date | Time.

13

Iog0324b 4701 24.09.2002 352:59
log0324c 4933 24.09.2002 35344

log0924f 4162 24.09.2002

Save to: EATESTINGADATA

| I Exclusive mode
Using: |, srent port ([COM2| ;I Bbﬁksiza:|512hyles ﬂ
ann\nad| Delete | Refresh | Exit I

|

Figura 5-11. Scaricamento di file

6. Fare clic sul tasto Download. Durante lo scaricamento, accanto ad
ogni file verranno visualizzati degli indicatori di stato (Figura 5-
12).
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* Indicatore blu - file in coda per lo scaricamento.

* Indicatore rosso - file in fase di scaricamento.

» Indicatore verde - il file € stato scaricato correttamente.

x
Download files | Current log ﬁ\gl Dowrload palh]
Total memony: 47348784 bytes Free memory: 47164824 bytes
Size I Date | Time
® |og323a 75196 23.03.2002 84952
® |og0323b 76795 23.03.2002 851:53
® |ogl324a 5661 24.09.2002 95251
® Iog0924b 4701 24.08.2002 3:52:59
log0924c 4933 24.05.2002 35244
log0924d 5190 24.05.2002 35255
log0924e 4676 24.03.2002 9:54:06
log0924f 4162 24.09.2002 95416
Save to: EATESTINGADATA
‘ Blocks: 28 I™ | Exclusive mode
Using: | ment port [COM2) j Block size: I"-' bytes j
Stap | Befrest | Exit |
15% | Downloading log0923a...

Figura 5-12. Scaricamento di file - Indicatori di stato
7. Al termine, fare clic sulla finestra di dialogo Exit su File

Manager.

8. Continuare con altre operazioni. Oppure fare clic su File »
Disconnect, quindi su File » Exit per uscire da PC-CDU.

Eliminazione di file dalla scheda SD

del ricevitore

Attenersi alla seguente procedura per cancellare i file dal ricevitore.

1. Collegare ricevitore e computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19 per informazioni su questa

procedura.

2. Nella finestra di dialogo Connection Parameters, abilitare RTS/
CTS handshaking (Figura 5-13 a pag. 5-9).
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[ Connection Parameters x|
Connecion mode
& Direct " Intesnet Clisnt " Iniernet Server |

Part setfing
Pt [COM1 =] Baudrate: [115200 =] I Infrered port
¥ RTS/CTS handshaking

F i
Prograr setting
[~ Pasivemade [~ lama\ mode caly  Timeout [ms]: | 500 b2

vighal baud rate on Disconned:

[¥ RTS/CTS handshaking s
TER pot W

Pesswoid: |

I- | Disslaydataorserner [ Log severeverts I DS lookus

Cancel
Figura 5-13. Parametros de conexion. RTS/CTS Handshaking

3. Fare clic su File » File Manager Manager e selezionare i file da
cancellare nella scheda Download files (Figura 5-14).
Per selezionare piu file, tenere premuto il tasto MAIUSC e fare
clic su file non-sequenziali per selezionare contemporaneamente
piu file. In alternativa ¢ possibile tenere premuto il tasto Ctrl e
fare clic su singoli file.

4. Fare clic su Delete (Figura 5-14 a pag. 5-9).

5. Fare clic su Yes nella finestra di conferma relativa alla
cancellazione dei file. PC-CDU cancella i file selezionati.

6. Fare clic su Exit nella schermata File Manager.

7. Continuare con altre operazioni. Oppure fare clic su File »
Disconnect, quindi su File » Exit per uscire da PC-CDU.

x|

Download files | Current log fils | Download palhl

Total memory: 47348784 bytes Free memory: 47164824 bytes
Date Time:

1
24.03.2002 52:59
:53:44

24.08.2002

Save to: EATESTINGADATA
‘ [~ Esclusive mode
Using: |_ inent port [COM2] j Block size: |512 bytes ﬂ

Qawnload' DelegeR Eehesh| Exit |
[ |

Figura 5-14. Cancellazione di file
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Gestione della memoria del
ricevitore

Se si utilizza il ricevitore in applicazioni statiche o dinamiche,
potrebbe essere necessario conoscere la quantita di memoria occupata
dal file di registro del ricevitore. Le dimensioni specifiche della
memoria dipendono dal tipo di dati in essa registrati. Usare le formule
specificate di seguito per calcolare le dimensioni approssimative dei
file di registro del ricevitore. Queste equazioni si basano sul set di
messaggi predefinito.

* SS - le dimensioni stimate di un'epoca di dati grezzi nel file di
registro del ricevitore (in byte).

* N - il numero di satelliti osservati per epoca.
Nel caso in cui vengano registrati solo i dati L1:
SS =183 +22*N
Se si registrano i dati L1 e L2:
SS =230 + 44*N

Gestione delle opzioni del ricevitore
L'Option Authorization File abilita determinate funzioni, proprieta ed
opzioni del ricevitore, come ad esempio quelle elencate di seguito:

* il tipo di segnale (L1, L1/L2, ecc.) che il ricevitore dovra
elaborare

* la quantita di dati che il ricevitore archiviera nella memoria
 la velocita con cui i dati verranno trasmessi o ricevuti

Per un elenco completo delle opzioni disponibili e per maggiori
informazioni al riguardo, rivolgersi al rivenditore TPS.

Controllo dell'OAF del ricevitore
Usare PC-CDU per visualizzare lo stato delle opzioni del ricevitore.

1. Collegare ricevitore e computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19 per informazioni su questa
procedura.
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2. Fare clic su Tools » Receiver Options. La finestra di dialogo
“Options Manager” (Figura 5-15 a pag. 5-12) contiene le seguenti
informazioni:

Option name - nome/descrizione dell'opzione
Current - lo stato corrente dell'opzione

Purchased - se 1'opzione ¢ stata acquistata o meno
Leased - se I'opzione ¢ stata noleggiata o meno

Expiration date - la data in cui 'opzione verra disabilitata,
se applicabile

Dato che le opzioni possono essere sia acquistate che noleggiate,
lo stato "Current" dell'opzione indica il valore corrente effettivo. I
valori delle opzioni possono essere i seguenti:

-10"-—-- " - la versione firmware non supporta questa
opzione

0 - I'opzione del ricevitore ¢ disabilitata
positive integer - 1'opzione ¢ abilitata

yes or no - l'opzione ¢ abilitata o disabilitata

3. Al termine, fare clic su Exit nella finestra di dialogo Option
Manager, quindi fare clic su File » Disconnect per scollegarsi da
PC-CDU (ed impedire conflitti con la gestione delle porte seriali).
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el

Option name | Curent | Puichased | Leased Exp. date | «|
| Tools GPS yes yes no
e GLONASS ves ves no
Initislize file system B es yes no
Clear NVRAM ] yes yes no
Reset receiver Cinderella yes yes no
_ Pasition update rate (Hz) 20 20 0
r options Raw data update rate (Hz) 20 20 0
Code differential Base yes yes no
Code differential Rover yes yes no
RTK Base ves wes no
RTK Rover [Hz) 20 20 0
Mermory (Mb) 76 76 0
Co-Op Tracking ves es no
1-PPS Timing Signal 2 2 1]
Event Markers 2z 2 1}
InBand Int. Rejection 1 1 1]
Multipath Reduction yes yes no
Frequency Input yes yes no
Freq. Lock and Output yes yes no
Senial Port & (Kbps) 460 460 1]
Senal Port B (Kbps) 460 460 0
Serial Port C (Kbps) 460 460 0
Serial Port D [Kbps) 460 460 0
Infrared Port no no no
Parallel Port no no
Sp.5p. Freq Hop. no no no
Sp.Sp. Direct no ho no
RalM ves yes no
Datums support yes yes no
tagnetic azimuth yes yes no

Geoid height yes yes no —
‘way Point Navigation yes no

WAAS yes yes ves 8/1/2001

OMNISTAR yes no
RTCM Output 3 2 0
RTCM Input 2 2 0
CMR Output 1 1 0
CMR Input 1 2 0
JPS Output 1 1] 0

JPS Input 2 1] 1] :I

Refresh | Load | Stap | B |
[ /

Figura 5-15. Visualizzazione di Option Manager

Caricamento di un OAF

I rivenditori Topcon Positioning System forniscono ai clienti file
OAF. Per qualsiasi domanda sui file OAF, inviare una e-mail a TPS
all'indirizzo options@topconps.com, com includendo il codice
identificativo del ricevitore (che si trova sotto il ricevitore).

1. Per caricare un nuovo OAF, seguire i punti uno e due in
“Controllo dell'OAF del ricevitore” a pag. 5-10.

2. Fare clic su Load in basso nella finestra di dialogo Option
Manager (vedere Figura 5-15).
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Cancellazione della NVRAM

3. Sfogliare fino al punto in cui si trova il nuovo Option
Authorization File. I file OAF hanno le estensioni .jpo o .tpo e
sono unici per ciascun ricevitore (Figura 5-16).

Select options file @@
Look, in: i e Local Disk [C:) LI & ek E3-
L) WINDOWS = uosf_6_3_turbo.tpo

= spcLommzovk. tpo
=) spnsvrowUTC tpo
= sqcsHPQvIGw-1.tpo
=) sqcsHravIG tpo
=) pavasDaI6RK tRO

<

Filename:  |[PEYAAD3IERAK tpo Open

dlj

Files of type: ‘ Options files [ *.tpo; *jpo ) ﬂ Cancel

Figura 5-16. Caricamento del file OAF

4. Selezionare il file giusto e fare clic su Open (Figura 5-16). La
nuova opzione verra caricata nel ricevitore e la tabella Option
Manager verra aggiornata.

5. Al termine, fare clic su Exit nella finestra di dialogo Option
Manager, quindi fare clic su File » Disconnect per impedire
conflitti con la gestione delle porte seriali.

Cancellazione della NVRAM

La RAM non volatile (NVRAM) del ricevitore conserva i dati
necessari per la tracciatura dei satelliti, quali i dati e la posizione del
ricevitore. La NVRAM conserva inoltre le impostazioni correnti del
ricevitore, quali input antenna attivo, elevation mask e intervallo di
registrazione, nonché informazioni sul file system interno del
ricevitore.

Anche se la cancellazione della NVRAM non € un'operazione comune
(né solitamente consigliata), a volte essa consente di eliminare
problemi di comunicazione o tracciatura. La cancellazione della
NVRAM del ricevitore puo essere interpretata come "soft boot" del
computer.

Dopo avere cancellato la NVRAM, il ricevitore richiedera del tempo
per la raccolta di nuove effemeridi e almanacchi (circa 15 minuti).
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La cancellazione della NVRAM del ricevitore non cancella i file gia
registrati nella memoria del ricevitore. Verranno tuttavia ripristinati i
valori di fabbrica del ricevitore.

Inoltre, la NVRAM conserva le informazioni relative al file system del
ricevitore. Si ricordi che dopo avere cancellato la NVRAM, il LED
STAT del ricevitore lampeggera di arancione per alcuni secondi
indicando che il ricevitore sta acquisendo e controllando il file system.

Utilizzo di MINTER per cancellare la NVRAM

Premere il tasto di alimentazione per spegnere il ricevitore.

Tenere premuto il tasto FUNCTION.

Premere il tasto di alimentazione per circa un secondo. Rilasciare

il tasto di alimentazione continuando a tenere premuto il tasto

FUNCTION.

4. Attendere fino a quando i LED STAT e REC non diventano verdi

5. Attendere fino a quando i LED STAT e REC lampeggiano di
arancione.

6. Rilasciare il tasto FUNCTION con i LED STAT e REC

lampeggianti (arancione).

we =

Utilizzo di PC-CDU per cancellare la NVRAM

1. Collegare ricevitore e computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19 per informazioni su questa
procedura.

2. Fare clic su Tools » Clear NVRAM (Figura 5-17).

Tools

Initialize file system

Resel receiver !

Receiver options

Figura 5-17. Cancellazione della NVRAM con PC-CDU

Durante la cancellazione della NVRAM, il LED REC lampeggia di
verde e di rosso; il LED STAT lampeggia invece di rosso. Al termine,
il ricevitore si scolleghera automaticamente.
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Modifica delle modalita del ricevitore
Il ricevitore dispone delle seguenti tre modalita: due information mode
e una modalita di alimentazione:

* Normal Mode - la modalita di acquisizione standard.

+ Extended Information Mode - usata per i test durante il normale
funzionamento.

* Modalita sospensione - usata per interrompere la registrazione
dei dati, anche se mantiene il ricevitore in funzione nella
modalita di "standby".

Immissione della Extended Information Mode

La Extended Information Mode (EIM) viene usata per testare il
ricevitore. In questa modalita, il ricevitore continua a funzionare come
al solito, ma il LED STAT indica informazioni "estese" mediante un
delimitatore. Il delimitatore € un chiaro doppio lampeggio che indica
lo stato generale dei test eseguiti in EIM. Il colore del LED STAT per
il delimitatore si ricava dai colori di altri LED lampeggianti e sara uno
dei seguenti una volta completati i test:

* Arancione - almeno un lampeggio ¢ di colore arancione.

* Rosso - nessun lampeggio di colore arancione e almeno uno
r0Sso.

* Verde - tutti gli altri casi.

11 doppio lampeggio del delimitatore ¢ seguito da sei lampeggii dei
LED corrispondenti a sei test del ricevitore, in cui ogni lampeggio
indica le seguenti informazioni:

Lampeggio 1. Dati sufficienti per il calcolo della posizione.
Lampeggio 2. I rapporti GPS S/N sono buoni (Tabella 5-1).

Lampeggio 3. 1 rapporti GLONASS S/N sono buoni
(Tabella 5-1).

Lampeggio 4. L'offsetdi frequenza dell'oscillatore ¢ inferiore a
3 ppm (parti per milione).

Lampeggio 5. Varianza di Allan dell'oscillatore migliore di
2,7e-10 (attualmente sempre arancione).
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Lampeggio 6. Il tempo di tracciatura continuo ¢ superiore a 15

minuti.

Tabella 5 - 1: Rapporti S/N (Signal-to-Noise) "buoni"

CA/L1

P/L1

P/L2

GPS

51

39

39

GLONASS

51

49

40

Il colore del lampeggio indica I'assenza delle informazioni per il
test(arancione), il ricevitore ha superato il test (verde) oppure il
ricevitore non ha superato il test (rosso).

1. Per passare a EIM, premere e rilasciare rapidamente (entro un
secondo) il tasto FUNCTION nell'applicazione MINTER.

2. Ricercare il doppio collegamento del delimitatore. Con buone
condizioni di osservazione, ricevitore e antenna, tutti i lampeggii
dovrebbero diventare verdi nel giro di 15 minuti dall'accensione.

* Verde - ok
* Arancione - attendere
* Rosso - alcuni test non sono stati superati

3. Per ritornare alla modalita normale, premere il tasto FUNCTION.

Modalita sospensione (Off)

Nella modalita sospensione, la scheda di alimentazione ¢ il modulo
Bluetooth continueranno ad essere alimentati da batterie che si
scaricheranno con il passare del tempo. La modalita sospensione ¢ lo
stato 'off' normale del ricevitore.

1. Accendere il ricevitore.

2. Premere il tasto di alimentazione del ricevitore per piu di quattro
secondi e meno di otto secondi. Il LED STAT diventera arancione.
Il ricevitore passa alla modalita sospensione.

3. Tutte le attivita che hanno luogo nella porta RS232 accenderanno
il ricevitore.
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Se si preme il tasto di alimentazione per piu di 14

@ secondi, verra ignorato. In questo modo si protegge

il ricevitore contro funzionamenti dovuti a chiavi
incastrate.

Caricamento di nuovo firmware

I ricevitori base e rover devono disporre della stessa versione
firmware. Utilizzare la versione firmware piu recente disponibile per
il download dal sito Web di Topcon per garantire che il ricevitore
disponga degli ultimi aggiornamenti.

Caricare sul ricevitore GR-3 la versione firmware
3.0 o superiore.

@ Non cercare di caricare un firmware con versione

precedente a 3.0.

La scheda del ricevitore e la scheda di alimentazione devono eseguire
firmware dello stesso pacchetto. Il firmware del modulo Bluetooth ¢
indipendente dalla scheda del ricevitore e dalla scheda di
alimentazione e ha un diverso pacchetto firmware.

FLoader, un'utilita Windows®-based, consente di caricare il firmware
nel ricevitore e nelle schede di alimentazione. FLoader puo essere
scaricato nel computer dal sito Web di TPS. Per maggiori
informazioni, fare riferimento al Manuale dell'utente di FLoader,
disponibile anche nel sito Web di TPS. Vedere “Installazione di
FLoader” a pag. 2-6 per informazioni su come installare FLoader nel
computer.

1. Scaricare il nuovo pacchetto firmware nel computer.

2. Collegare ricevitore e computer. Vedere “Collegamento del
ricevitore al computer” a pag. 2-19 per informazioni su questa
procedura.

3. Avviare FLoader.
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4. Nella scheda Connection, selezionare la porta COM del computer
che si collega al ricevitore e selezionarne la velocita (di solito

115200) (Figura 5-18).

5. Vedere “Caricamento del firmware della scheda di alimentazione
e del ricevitore” a pag. 5-18 per caricare il firmware corretto.

TPS Firmware Loader: Device = Receiver

File Options Help

=lolx|

Connection | Devics | Program|

Connection Type:

Connection Settings
PC Port:

Baud rate:

|1152E|U 'I Parity:
Handshaking: INnne 'I Stop Bits:

ICGMT 'I Word Length: |8 >

None =
1 -

25 Jul 2002 |161EIG.11

Figura 5-18. Schermata principale di FLoader

Caricamento del firmware della scheda di ali-

mentazione e del ricevitore

Il firmware del ricevitore e della scheda di alimentazione ¢ disponibile
sotto forma di file compresso che puo essere scaricato e decompresso.

Esso contiene i seguenti tre file:

* ramimage.ldr - il file RAM della scheda del ricevitore

* main.ldp - il file Flash della scheda del ricevitore
* powbrd.ldr - il file RAM della scheda di alimentazione

<

Durante il caricamento del nuovo firmware, ¢ nec-
essario caricare tutti e tre i file. I file devono essere
far parte dello stesso pacchetto firmware.

1. In FLoader, fare clic sulla scheda Device e impostare Device Type
come "Receiver". Fare quindi clic su Get from Device per
informazioni sul dispositivo (Figura 5-19 a pag. 5-19).
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TPS Firmware Loader: Device = Receiver
File Options Help

Caricamento di nuovo firmware

Connection Device I ngraml

Receiver "I

Device Type:

Device Informatio

Model:

1D:

Firrmvrare:
Hardware:
RAM Size. KB:

Save to file

Cancel

31 Mar 2003 17.53 44

Figura 5-19. Impostazione del tipo di dispositivo
2. Fare clic sulla scheda Program e impostare Capture Method su
"Soft Break Capture" (consigliato) (Figura 5-20).

EA 1PS Firmware Loader: Device - Receiver
File Options Help

Eunnecllurll Device Program |

Firmware

Capture Method: |Soft Break Capture hd

& RAM fle: [T \FLoader_Fimwaie\GA3_3_D\iamimage Idh

L] Browse B

@ Flash file: [E:‘\FLoadeLF\rmwale\GF\Jjj\mam.ldp

Cancel

LI Browse F

Ready

08 Jun 2006 15:57.38

Figura 5-20. Impostazioni scheda Program

Stogliare e selezionare il file RAM e il
ricevitore (Figura 5-20).

ricevitore.

file Flash della scheda del

Fare clic su Load e attendere il caricamento completo dei file nel

Se ¢ stato selezionato un file non corretto, in basso

nella finestra di dialogo
saggio di errore. Selezio

o

verra visualizzato un mes-
nare 1l file corretto.
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5. Fare clic sulla scheda Device ¢ impostare Device Type come
"Receiver's Power Board". Fare quindi clic su Get from Device
per informazioni sul dispositivo (Figura 5-21).

TPS Firmware Loader: Device = Receiver's Power Board [_ O] %]

File Options Help

Connection Device I Program |

Device Type: Receiver's Power Board VI

Device Informatic

Firmveare:
Hardware:

Save to fils I LCancel |

[Ready 31 Mar 2003 [17:55 40

Figura 5-21. Impostazione del tipo di dispositivo

6. Fare clic sulla scheda Program e impostare Capture Method su
"Soft Break Capture" (consigliato) (Figura 5-22).

TPS Firmware Loader: Device = Receiver's Power Board Q‘ ] |®
File Options Help

Cmnectiunl Device  Program |

Capture Method: |Soft Bieak Captuie -
Firmgare

@ RAM file: |C:\FLoader_Fimware\GR3_3_0\powbrd Idi j Browse B

Cancel ‘

08 Jun 2006 15;58.51

Figura 5-22. Impostazioni scheda Program
7. Sfogliare e selezionare il file RAM della scheda di alimentazione
(Figura 5-22).
8. Fare clic su Load e attendere il caricamento completo dei file
della scheda di alimentazione nel ricevitore.
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Se ¢ stato selezionato un file non corretto, in basso
@ nella finestra di dialogo verra visualizzato un mes-

saggio di errore. Selezionare il file corretto.

9. Fare clic su File » Exit.

10.Cancellare la NVRAM del ricevitore (vedere “Cancellazione della
NVRAM?” a pag. 5-13) e aggiornare l'almanacco (vedere
“Acquisizione di almanacchi ed effemeridi” a pag. 2-26).
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Note:
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Capitolo 6

Risoluzione dei
problemi

Questo capitolo aiutera l'utente nella diagnosi e nella risoluzione di
alcuni problemi comuni che si possono riscontrare durante 1'uso del
ricevitore.

venti di questo genere rendono nulla la garanzia e

Non cercare di riparare 'apparecchio da soli. Inter-
& danneggiano I'hardware.

Controlla prima questo!

Prima di contattare I'assistenza Topcon, controllare quanto segue:

» Controllare tutti i collegamenti esterni del ricevitore per
garantire la correttezza e la sicurezza dei collegamenti.
Controllare nuovamente per verificare che non vi siano cavi
usurati o difettosi.

» Controllare tutte le fonti di alimentazione per verificare se le
batterie sono scariche oppure se le batterie e i cavi sono
collegati correttamente.

 Verificare di avere scaricato sul computer il software piu
aggiornato e di avere caricato nel ricevitore il firmware piu
aggiornato. Consultare il sito Web TPS per le versioni
aggiornate.

* Se ci si connette tramite Bluetooth, controllare che la porta
usata per il collegamento sia nella modalita Command. Per
maggiori informazioni, vedere a pag. 6-10.
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Risoluzione dei problemi

Dopo di che, provare quanto segue:

* Ripristinare il ricevitore con PC-CDU (Tools » Reset
receiver).

» Ripristinare le impostazioni predefinite con PC-CDU
(Configuration » Receiver, quindi fare clic su Set all
parameters to defaults).

» Cancellare la NVRAM (vedere “Cancellazione della NVRAM”
a pag. 5-13).

* Inizializzare il file system (fare clic su Tools » Initialize file
system). In questo modo si cancellano tutti i file all'interno del
ricevitore.

Se il problema persiste, fare riferimento alle seguenti sezioni per altre
soluzioni.

Elenco per la risoluzione rapida dei
problemi

Per problemi di alimentazione del ricevitore:

Se 1l ricevitore non si accende.”, vedere a pag. 6-3.
Se "Il ricevitore non riesce a collegarsi a un computer o a un con-
troller esterno.”, vedere a pag. 6-4.

Per problemi del ricevitore:

Se "Il ricevitore non si fissa sui satelliti per un periodo di tempo
sufficientemente lungo.”, vedere a pag. 6-5.
Se "Il ricevitore acquisisce un numero di satelliti molto basso.”,
vedere a pag. 6-6.
Se "Il ricevitore non riesce ad ottenere soluzioni Code Differential
e/o RTK.”, vedere a pag. 6-6.
Se "Il ricevitore non inizia la registrazione dei dati.”, vedere a
pag. 6-9.

Per problemi di collegamento Bluetooth:

In presenza di "BTCONF error message: Can't find receiver.”,
vedere a pag. 6-10.

In presenza di "BTCONF error message: Can't find Bluetooth.”,
vedere a pag. 6-11.
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In presenza di "BTCONF error message: Open COM# port failed:
Access is denied.”, vedere a pag. 6-12.
In presenza di "BTCONF error message: Open COM# port failed:
Access is denied.”, vedere a pag. 6-12.
In presenza di "Can see the icon for the receiver's Bluetooth mod-
ule on the computer screen, but cannot connect to it.". a pag. 6-12.

Per problemi del modem:

Se "Modem-TPS non riesce a collegarsi al ricevitore.”, vedere a
pag. 6-13.

In presenza di ”Per modem FH915+ interni: il LED TX RX
lampeggia di rosso.”, vedere a pag. 6-15.

Problemi di alimentazione

Tutti i ricevitori vengono impostati in fabbrica sulla modalita "Auto
mode" per entrambe le batterie. Per controllare queste impostazioni,
attenersi alla seguente procedura:

1. Collegare il ricevitore e il computer ed eseguire PC-CDU (vedere
“Collegamento del ricevitore al computer” a pag. 2-19).

2. Dopo il collegamento, fare clic su Configuration » Receiver.

3. Nella scheda General, visualizzare i campi Power e Charter.
Questi campi dovrebbero essere impostati su "Auto". In caso
contrario, impostarli su Auto e fare clic su Apply.

modalita di alimentazione Auto (vedere “Cancel-

Se si cancella la NVRAM, il ricevitore ritorna alla
% lazione della NVRAM” a pag. 5-13).

Il ricevitore non si accende.

= Le batterie amovibili potrebbero essere collegate in modo
inadeguato.

* Controllare che le batterie siano collegate correttamente.

» Controllare che i contatti sopra la batteria amovibile siano
puliti e privi di polvere.
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= Le batterie potrebbero essere scariche.

Collegare una batteria completamente carica e riprovare.
Vedere “Alimentazione del ricevitore” a pag. 2-14.

Caricare le batterie durante la notte. Vedere “Alimentazione
del ricevitore” a pag. 2-14.

= Se si usa una fonte di alimentazione esterna, il cavo potrebbe
essere scollegato o danneggiato.

Verificare che il cavo sia ben collegato e che non sia dan-
neggiato.

= Il ricevitore potrebbe avere un caricabatteria difettoso o batterie
guaste.

Se, dopo avere caricato le batterie o stabilito il collegamento
a una fonte di alimentazione esterna, il ricevitore continu-
asse a non accendersi, contattare 1'assistenza clienti TPS per
consulenza.

Problemi del ricevitore

Di seguito vengono elencati alcuni dei problemi pit comuni che
interessano il ricevitore.

Il ricevitore non riesce a collegarsi a un computer o a un
controller esterno.

Problemi specifici dei cavi:

= Il cavo non € correttamente inserito.

6-4

Controllare che il connettore del cavo sia collegato alla
porta del ricevitore corretta.

Scollegare il cavo, quindi ricollegarlo in modo sicuro e
appropriato al ricevitore.

Vedere “Ricevitore GR-3” a pag. 1-10 e “Caratteristiche dei
connettori” a pag. A-8 per informazioni sui connettori del
ricevitore.
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= Il cavo ¢ danneggiato.

Utilizzare un cavo non danneggiato. Rivolgersi al proprio
rivenditore per la sostituzione del cavo.

Problemi generici:

= La porta del ricevitore usata per il collegamento non si trova
nella modalita Command.

1. Collegare il ricevitore e un computer utilizzando una porta libera
(vedere “Collegamento del ricevitore al computer” a pag. 2-19) y
ejecute PC-CDU.

2. Fare clic su Configuration » Ports.

3. Cambiare l'input della porta usata per la connessione in
"Command".

Il ricevitore non si fissa sui satelliti per un periodo di tempo
sufficientemente lungo.

= Il ricevitore memorizza un almanacco obsoleto.
Aggiornare I'almanacco. Vedere “Acquisizione di almanacchi ed
effemeridi” a pag. 2-26 per maggiori informazioni.

= Le opzioni del ricevitore potrebbero essere disabilitate o
scadute L1/L2, GPS/GLONASS devono essere attivi per poter
tracciare i satelliti).

* Vedere “Gestione delle opzioni del ricevitore” a pag. 5-10
per informazioni su come controllare le opzioni correnti.

* Ordinare un nuovo OAF con le opzioni desiderate attivate
per abilitare o estendere la validita delle relative opzioni del
ricevitore. Rivolgersi al proprio rivenditore oppure visitare
il sito Web di TPS per informazioni.

» Fare riferimento al Manuale di riferimento di PC-CDU per
una descrizione dettagliata delle opzioni.
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Il ricevitore acquisisce un numero di satelliti molto basso.

= Il valore dell'elevation mask ¢ eccessivo (superiore a 15°).
Abbassare la elevation mask. Vedere a pag. 3-23 per
informazioni sull'impostazione della elevation mask.
= Il rilievo viene eseguito vicino a ostruzioni (alberi, edifici alti,
ecc.).
» Verificare che le caselle Multipath Reduction siano state
abilitate.

1. Collegare il ricevitore e un computer e avviare PC-
CDU. Vedere “Collegamento del ricevitore al
computer” a pag. 2-19.

2. Fare clic su Configuration » Advanced e Multipath
Reduction. Abilitare le due caselle e fare clic su

Apply.

* Se possibile, spostarsi in un'area priva di ostacoli.

Il ricevitore non riesce ad ottenere soluzioni Code Differential e/o
RTK.

= Sono state immesse delle coordinate di base non corrette.

Specificare le coordinate corrette per la stazione base tramite
PC-CDU o un altro software per la raccolta dei dati sul campo.
= Il ricevitore non ¢ configurato come base o rover.

* Se il ricevitore deve funzionare come base, verificare che
disponga della giusta configurazione. Per maggiori
informazioni, vedere il capitolo 3.

* Se il ricevitore deve funzionare come rover, verificare che
disponga della giusta configurazione. Per maggiori
informazioni, vedere il capitolo 3.

= Le opzioni del ricevitore potrebbero essere disabilitate o
scadute.

* Vedere “Gestione delle opzioni del ricevitore” a pag. 5-10,
per informazioni su come controllare le opzioni correnti.
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* Ordinare un nuovo OAF con le opzioni desiderate attivate
per abilitare o estendere la validita delle relative opzioni del
ricevitore. Rivolgersi al proprio rivenditore oppure visitare
il sito Web TPS per informazioni.

» Fare riferimento al Manuale di PC-CDU per una
descrizione dettagliata delle opzioni.

= Non vi sono abbastanza satelliti comuni. Per ottenere una
soluzione fissa, la base e il rover dovrebbero tracciare almeno
cinque satelliti comuni.

» Assicurarsi che i ricevitori rover e base utilizzino lo stesso
almanacco aggiornato. Vedere “Acquisizione di almanacchi
ed effemeridi” a pag. 2-26.

¢ Controllare le elevation mask dei ricevitori rover e base;
dovrebbero essere uguali. Vedere a pag. 3-23 per
informazioni sull'impostazione della elevation mask.

= Esiste una discrepanza tra gli standard differenziali usati nei
ricevitori base e rover.

Assicurarsi che 1 ricevitori base e rover utilizzino lo stesso
formato di input/output delle correzioni:

1. Collegare il ricevitore e un computer e avviare PC-CDU.
Vedere “Collegamento del ricevitore al computer” a pag. 2-
19.

2. Fare clic sulla scheda Configuration » Receiver ¢ la
scheda Ports. Utilizzare lo stesso formato di input/output
per entrambi i ricevitori.

= Geometria del satellite inadeguata (I valori PDOP/GDOP sono
troppo alti). Effettuare il rilievo quando i valori PDOP sono
bassi.

= La elevation mask ¢ superiore a 15°.

Abbassare la elevation mask. Vedere a pag. 3-23 per
informazioni sull'impostazione della elevation mask.

= La batteria del modem ¢ scarica.

* Collegare al ricevitore una fonte di alimentazione esterna.
Vedere “Utilizzo di un'alimentazione ausiliaria” a pag. 2-16.
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* Per maggiori informazioni, vedere “Alimentazione del
ricevitore” a pag. 2-14.

= L'antenna di trasmissione €/0 ricezione potrebbe non essere
collegata correttamente.

* Controllare che I'antenna del radio modem sia collegata in
modo adeguato e sicuro al connettore dell'antenna.

* Verificare che l'antenna del radio modem non sia
danneggiata. In caso contrario, rivolgersi al rivenditore TPS
per sostituire l'antenna.

= La velocita di trasmissione specificata non ¢ compatibile con le
velocita di trasmissione supportate dal modem.

La velocita di trasmissione € la velocita a cui il ricevitore
trasmette messaggi differenziali al modem e viceversa.

Modificare la velocita di trasmissione in quella supportata
dal modem. Per maggiori informazioni, fare riferimento al
manuale del modem.

= [ modem base e rover utilizzano diversi parametri di
collegamento radio.

Configurare i radio modem base e rover in base alle procedure
elencate nella relativa sezione.

e Per informazioni su un modem FH915+, vedere
“Configurazione di un dispositivo radio modem ad ampio
spettro” a pag. 3-3.

¢ Per informazioni su un modem GSM, vedere
“Configurazione del radio modem GSM” a pag. 3-6.

= La distanza tra la base e il rover € eccessiva.
« Diminuire la distanza tra base e rover.
» Utilizzare dei ripetitori per aumentare la copertura radio.

= Potrebbe essere presente una fonte di interferenza radio che
disturba le comunicazioni via radio.

* Modificare il canale RF (se possibile).
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Problemi del ricevitore

» Utilizzare un analizzatore di spettro per rilevare le
caratteristiche radio del segnale di interferenza e modificare
la configurazione del sistema di conseguenza.

» Togliere la causa del segnale di jamming oppure
riposizionare le radio antenne (se possibile).

Il ricevitore non inizia la registrazione dei dati.

= Il ricevitore non ha una scheda SD installata oppure 1'opzione
della memoria ¢ disabilitata o scaduta.

» Verificare che la scheda sia inserita in modo corretto. Per
maggiori informazioni, vedere “Installazione delle schede
SD e SIM opzionali ” a pag. 2-7.

» Verificare che 1'opzione di memoria sia abilitata. Per
maggiori informazioni, vedere “Controllo del'OAF del
ricevitore” a pag. 5-10.

= Lo spazio sulla scheda di memoria del ricevitore ¢ esaurito.

* Scaricare e/o cancellare i file di dati per liberare spazio per
nuovi file (vedere “Trasferimento di un file ad un computer
” a pag. 5-1 e “Eliminazione di file dalla scheda SD del
ricevitore” a pag. 5-8).

o Utilizzare la funzione AFRM. Vedere “Automatic File
Rotation Mode (AFRM)” en la pag. 3-23.
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Problemi con la tecnologia Bluetooth

Di seguito vengono elencati alcuni dei messaggi di errore e dei
problemi pit comuni.
BTCONF error message: Can't find receiver.
= Il ricevitore potrebbe essere spento.
Assicurarsi che il ricevitore sia alimentato e acceso.

= Se si usa un cavo, i connettori del cavo sono collegati in modo
inadeguato.

» Controllare che il connettore del cavo sia collegato alla
porta seriale corretta.

* Scollegare il cavo, quindi ricollegarlo in modo sicuro e
appropriato al ricevitore.

= Se si usa un cavo, il cavo ¢ danneggiato.
» Utilizzare un cavo non danneggiato.

* Rivolgersi al proprio rivenditore TPS per acquistare un
nuovo cavo.

= La porta COM a cui ¢ collegato il ricevitore ¢ diversa da quella
selezionata in BTCONF.

* Verificare che il cavo RS232 sia collegato alla porta COM
specificata nell'elenco delle porte di comunicazione
BTCONF.

* Per maggiori informazioni, vedere “Modulo Bluetooth
Configurazione” a pag. 2-21.

= La porta del ricevitore usata per il collegamento non si trova
nella modalita Command.

1. Collegare il ricevitore e un computer utilizzando una porta
libera (vedere “Collegamento del ricevitore al computer” a
pag. 2-19) e avviare PC-CDU.

2. Fare clic su Configuration » Ports.

3. Cambiare l'input della porta seriale usata per la connessione
in "Command".
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Problemi con la tecnologia Bluetooth

Si tratta della causa piu comune che porta alla com-

parsa di questo messaggio di errore. Usare PC-
CDU per verificare le impostazioni della porta di

collegamento.

= Le impostazioni della porta D sono state modificate.

* Le impostazioni per la porta D sono: velocita di
trasmissione 115200, 8 bit di dati, 1 bit di arresto, nessuna
parita e nessun handshaking.

» Cercare di abilitare I'handshaking RTS/CTS per la porta D.
Non modificare altre impostazioni.

= Le opzioni del ricevitore potrebbero essere disabilitate o
scadute (la porta seriale D deve essere abilitata).

* Vedere “Gestione delle opzioni del ricevitore” a pag. 5-10
per informazioni su come controllare le opzioni correnti.

* Ordinare un nuovo OAF con le opzioni desiderate attivate
per abilitare o estendere la validita delle relative opzioni del
ricevitore. Rivolgersi al proprio rivenditore oppure visitare
il sito Web di TPS per informazioni.

» Fare riferimento al Manuale di riferimento di PC-CDU per
una descrizione dettagliata delle opzioni.
BTCONF error message: Can't find Bluetooth.
= Lo slot 2 (C) del ricevitore ¢ disattivo.

1. Vedere “Creazione di un collegamento via cavo RS232” a
pag. 2-21 per collegare computer e ricevitore.

2. Fare clic su Configuration » Receiver » General.

3. Nel campo Turn on/off, abilitare la casella di controllo Slot
2 (C).

= Il modulo Bluetooth ¢ collegato a un altro dispositivo.

Terminare il collegamento con il dispositivo, quindi collegarsi
al ricevitore.

= Il ricevitore non dispone di un modulo Bluetooth.
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* Continuare con le altre funzioni di configurazione/
acquisizione utilizzando un cavo seriale o USB.

» Rivolgersi al proprio rivenditore TPS per acquistare un
ricevitore abilitato Bluetooth.

BTCONF error message: Open COM¢# port failed: Access is
denied.

= Un'altra applicazione utilizza la porta del computer dedicata al
collegamento.

* Chiudere l'applicazione, quindi ricollegarsi.

* Collegare il ricevitore da un'altra porta del computer
inutilizzata.

In presenza di "After searching for available devices, none are
discovered."

= Il ricevitore non viene alimentato.
* Verificare che il ricevitore sia alimentato e acceso.

* Controllare che il cavo di alimentazione sia collegato alla
porta contrassegnata "PWR".

* Scollegare il cavo, quindi ricollegarlo in modo sicuro e
appropriato al ricevitore.

* Se il cavo di alimentazione ¢ danneggiato, rivolgersi al
proprio rivenditore per acquistare un nuovo cavo.

= Lo slot 2 (C) del ricevitore ¢ disattivo.

1. Collegare il ricevitore e un computer con un cavo RS232
(Vedere “Creazione di un collegamento via cavo RS232” a
pag. 2-21).
2. Fare clic su Configuration » Receiver » General.
3. Nel campo Turn on/off, abilitare la casella di controllo Slot
2 (C).
In presenza di "Can see the icon for the receiver's Bluetooth
module on the computer screen, but cannot connect to it.".

= Le impostazioni di protezione del dispositivo sono diverse.

6-12 GR-3 Manuale Operativo
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» Verificare che i dispositivi abilitati Bluetooth utilizzino le
stesse impostazioni di protezione.

*  Vedere “Modulo Bluetooth Configurazione” a pag. 2-21, in
particolare la Figura 2-23 a pag. 2-25 per informazioni sulla
modifica delle impostazioni di protezione.

= Le impostazioni del modulo Bluetooth potrebbero essere
cambiate.

1. Se le impostazioni del modulo Bluetooth sono state
modificate, rimuoverlo dall'elenco dei dispositivi Bluetooth
trovati mediante l'apposito programma di gestione (in
dotazione con il dispositivo usato per la gestione del
ricevitore).

2. Ripetere la ricerca.

Problemi con Modem-TPS

Di seguito viene riportato il problema piu frequente riscontrato con
Modem-TPS.

Modem-TPS non riesce a collegarsi al ricevitore.
= Il ricevitore potrebbe essere spento.
Assicurarsi che il ricevitore sia alimentato e acceso.

= Se si usa un cavo, i connettori del cavo sono collegati in modo
inadeguato.

* Controllare che il connettore del cavo sia collegato alla
porta seriale corretta.

» Scollegare il cavo, quindi ricollegarlo in modo sicuro e
appropriato al ricevitore.
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= Se si usa un cavo, il cavo ¢ danneggiato.
+ Utilizzare un cavo non danneggiato.

* Rivolgersi al proprio rivenditore per acquistare un nuovo
cavo.

= Se si utilizza la tecnologia wireless Bluetooth, ¢ stata
selezionata la porta sbagliata oppure il ricevitore o il computer
non sono in grado di supportare la tecnologia Bluetooth.

» Usare un computer o un ricevitore con tecnologia wireless
Bluetooth abilitata/installata.

* Verificare che il computer e il ricevitore utilizzino le porte
di comunicazione corrette. Nel caso del ricevitore GR-3, la
porta giusta ¢ la A.

Lampeggio del LED TX RX in condizioni di errore

= Le opzioni del modem potrebbero essere disabilitate o scadute.

*  Vedere “Gestione delle opzioni del ricevitore” a pag. 5-10
per informazioni su come controllare le opzioni correnti.

* Ordinare un nuovo OAF con le opzioni desiderate attivate
per abilitare o estendere la validita delle relative opzioni del
ricevitore. Rivolgersi al proprio rivenditore oppure visitare
il sito Web di TPS per informazioni.

 Fare riferimento al Manuale di riferimento di PC-CDU per
una descrizione dettagliata delle opzioni.

= Il tipo di radio modem ¢ disabilitato per il rilevamento con
Modem-TPS.

1. Se necessario, fare clic su Cancel nella finestra di dialogo
Connection oppure su Stop nella finestra di dialogo
Connecting to device.

2. In Modem-TPS, fare clic su Tools » Options.

3. Abilitare il tipo di modem installato nel ricevitore collegato
al computer. Fare clic su OK.

4. Fare clic su File » Connect.
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Lampeggiamento del LED TX
RX in condizioni di errore

Per modem FH915+ interni: il LED TX RX lampeggia di rosso.

= E stata rilevata una condizione di errore.

e Verificare che 'antenna del radio modem non sia
danneggiata. Rivolgersi al proprio rivenditore per la
sostituzione dell'antenna.

* Controllare che I'antenna del radio modem sia collegata in
modo adeguato e sicuro al connettore dell'antenna.

* Allontanare l'antenna o il ricevitore da oggetti conduttivi
(quali grandi oggetti in metallo).

= Il cavo ¢ danneggiato.
» Utilizzare un cavo non danneggiato.

* Rivolgersi al proprio rivenditore per la sostituzione del
cavo.

Per modem GSM interni: il LED TX RX lampeggia di arancione.

= Il rover usa il codice PIN errato oppure non ¢ stato selezionato
alcun codice PIN.

1. In TopSURY, fare clic su Job » Config » Survey.

2. Fare clic sul pulsante "..." (continua) e premere Next per
raggiungere la schermata di configurazione Rover Radio.

3. Premere Configure GSM.

4. Selezionare il PIN della stazione base e premere OK.
= Si ¢ verificato un errore durante l'inizializzazione.

* Verificare che 'antenna del radio modem non sia

danneggiata. Rivolgersi al proprio rivenditore per la
sostituzione dell'antenna.

* Controllare che I'antenna del radio modem sia collegata in
modo adeguato e sicuro al connettore dell'antenna sul
radomo.
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Come richiedere assistenza tecnica

Se 1 suggerimenti per la risoluzione dei problemi riportati nel presente
Manuale operatore non riuscissero a risolvere il problema, contattare
l'assistenza clienti TPS.

Prima di contattare I'assistenza clienti TPS per informazioni sui
problemi riscontrati con il ricevitore, fare riferimento a “Controlla
prima questo!” a pag. 6-1 dove ¢ possibile trovare alcune soluzioni
utili.

Teléfono

071- 21325280

Geotop srl via Brecce Bianche n.152 Tel. 071-213251
Fax 071-21325282

Per contattare 1'assistenza clienti TPS tramite posta elettronica, usare
il seguente indirizzo e-mail: assistenza.gps@geotop.it

Per un'assistenza veloce ed efficiente, fornire una
descrizione dettagliata del problema.

Per un servizio migliore e piu veloce, quando si invia una e-mail
all'assistenza clienti TPS, ¢ necessario fornire le seguenti
informazioni:

1. Modello del ricevitore e impostazioni della configurazione.
In PC-CDU, fare clic su Help » About, quindi su Save to file.
Immettere un nome per il file e salvarlo sul computer. Allegare il
file alla e-mail.

2. Le caratteristiche del sistema/hardware del computer che esegue
PC-CDU; quali, sistema operativo e versione, capacita di memoria
e di archiviazione, velocita del processore, ecc.

3. I'sintomi e/o i codici di errore/messaggi che precedono e seguono
il problema.
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4. Le attivita provate alla comparsa del problema. Se possibile,
includere le operazioni precise adottate alla comparsa del
messaggio di errore o dell'altro problema.

5. La frequenza con cui il problema si presenta.

Generalmente, un rappresentante dell'assistenza clienti risponde entro
24 ore, a seconda della gravita del problema.

Sito Web

11 sito Web di Topcon Positioning Systems fornisce informazioni
aggiornate sulla linea di prodotti Topcon. La sezione dedicata
all'assistenza all'interno del sito Web consente di accedere alle
domande frequenti, alle procedure di configurazione, ai manuali,
all'assistenza e-mail, ecc.

Per accedere al sito Web di Topcon, usare 1'indirizzo:

www.topconpositioning.com
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Note:
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Appendice A

Caratteristiche

Questo prodotto TPS ¢ un ricevitore GNSS a 72 canali con radio
modem interno, modulo a tecnologia wireless Bluetooth®, modulo
GSM opzionale, scheda SD amovibile opzionale e alloggiamento in
magnesio resistente con connettori cavo ¢ MINTER.

Le caratteristiche di prestazione presuppongono
almeno 6 satelliti GPS oltre i 15° sull'orizzonte e la
conformita alle procedure consigliate nel presente
manuale.

Il rendimento potrebbe diminuire in zone con forte
multipath, PDOP e durante i periodi di maggiore
attivita ionosferica.

Adottare procedure di controllo sofisticate in zone
con multipath estremo o sotto un fitto fogliame.
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Caratteristiche

Specifiche del ricevitore

Le seguenti sezioni indicano le caratteristiche del ricevitore e dei suoi

componenti interni.

Dettagli generali

La tabella A-1 elenca le caratteristiche generali del ricevitore.
Tabella A - 1: Specifiche generali del ricevitore

Caratteristiche fisiche

Alloggiamento Magnesio, estrusione IPX 6, resistente alla pioggia
Colore Giallo Topcon e grigio Topcon
Dimensioni L:156,6 x A:234,5 x D:156,6 mm
Peso 1,78 kg
Antenna Interna
Batteria Due esterne, amovibili
Controller Esterno
Montaggio 5/8-11, a disconnessione rapida
Guarnizioni Silicone (molding in Color)
Tasti Due tasti:
Alimentazione — On/Off
Funzione — avvio/arresto della registrazione dati;
commutazione information mode.
LED Sei LED:
STAT - stato del satellite e del ricevitore
REC —registrazione e stato dati
RX TX — stato del modem
BT - stato di collegamento della tecnologia wireless
Bluetooth
BATT x 2 — stato batteria
Ambiente
Temperatura Da -20 C° a +50 C° con batterie
d’esercizio
Temperatura di Da -20 C° a +35 C° con batterie
stoccaggio Da -40 C° a +75 C° senza batterie
Umidita 95%
Temperatura Da -20 C° a +50 C° con batterie
d’esercizio

A-2
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Specifiche del ricevitore

Tabella A - 1: Specifiche generali del ricevitore (continua)

Alimentazione

Batterie esterne Agli ioni di litio, 3900 mAh, 7.2 V; 2 batterie; amovibili
Dimensioni batteria 132 x 52 x 25 (mm)

Peso batteria 165 g (1 batteria)

Tempo di utilizzo * Modem = off — circa 16 ore

In media con * 915 modem sola ricezione — circa 13 ore

Bluetooth “on” e 12 * 915 modem trasmissione a 250 mW — circa 11 ore
SV tracked. .

Con batterie nuove

915 modem trasmissione a 1 W — circa 9 ore

» Involucri batterie AA collegati ai due slot batteria e
€ a temperatura modem spento — circa 2,5 ore

ambiente. » Zone urbane con una distanza dai siti ridotta e GSM/
GPRS attivo — circa 12 ore di chiamate continue

Alimentazione 1 porta
esterna

Tensione d’ingresso Da9a21V DC (durante 1’uso)
Da 10 a21 V DC (per la carica della batteria)
Corrente di carica massima <=2 Amp

Consumo medio ¢ Modem = off — circa 3,5 W
con Bluetooth “on” * 915 modem sola ricezione — circa 4,4 W
e 12 SV tracciati. + 915 modem trasmissione a 250 mW — circa 5,0 W

¢ 915 modem trasmissione a 1 W — circa 6 W

¢ Zone urbane con una distanza dai siti ridotta e GSM/
GPRS attivo —circa 4,2 W

Carica della batteria | Collegare all’adattatore AC per caricare la batteria
interna. Possibilita di carica durante 1’uso se ¢ presente il
collegamento a una batteria esterna.

Tempo di carica ~6 ore per la carica completa

A bordo Batteria di backup per il rilevamento tempo e
archiviazione dei dati degli almanacchi; 10 anni di
funzionamento minimo
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Tabella A - 1: Specifiche generali del ricevitore (continua)

/0

Comunicazione Una porta seriale RS232 ad alta velocita (con bordo
Porte nero), una porta USB (con bordo giallo) e una porta di
comunicazione Bluetooth interna (porta D).

Specifiche della Porta seriale RS232
porta Baud rate: 460800,230400,115200 (predefinito),57600,
38400,19200,9600,4800,2400,1200,600, 300
Controllo di flusso: RTS/CTS
Lunghezza: 7,8 (predefinito)
Bit di stop: 1 (predefinito), 2
Parita: Nessuna (predefinito), Dispari, Pari
Porta Bluetooth
Disponibile
Porta USB
Versione 1.1

Connettori Antenna modem (BNC o polarita inversa TNC in
funzione del tipo di modem), PWR, seriale RS232, USB

MINTER Sei LED esterni (vedere “LED” a pag. A-2 per maggiori
informazioni) Input di controllo ON/OFF (tasto di
alimentazione) Controllo registrazioni dati (pulsante
FUNCTION)

Caratteristiche dei dati

Velocita di aggiornamento fino a 20 Hz per posizione in
tempo reale e dati grezzi (codice e portante) precisione
code-phase 10cm e carrier-phase 0,1lmm RTCM SC104
versione 2.1, 2.2, 2.3, ¢ 3.0 I/O RTCM stazioni base
multiple Modelli di variazione geodica e magnetica
RAIM Supporto DATTI diversi Output di coordinate di
griglia CMR e CMR+ supporto

Tecnologia
Mitigazione del multipath avanzata
WAAS
Parametri PLL e DLL regolabili
NMEA
Versione NMEA Ver. output 2.1, 2.2, 2.3, 3.0
Messaggi GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC,
VTG, ZDA, ROT, GMP
Intervallo output 1Hz standard; 5, 10, 20Hz opzionale
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Tabella A - 1: Specifiche generali del ricevitore (continua)
DGPS
Formato di RTCM SC104 Ver 2.1,2.2,2.3¢ 3.0
correzione

Tipo di messaggio
RTCM

1, 3,9, 31, 32, 34; selezionabile dall’utente

Intervallo di

1Hz standard; 5, 10, 20Hz opzionale

processo
Intervallo output 1Hz standard; 5, 10, 20Hz opzionale

per dati di

correzione RTCM

Elevazione Da 0 a 90° (indipendentemente dalla registrazione dati)

DGPS multi-base

Modalita di selezione correzione differenziale: Nearest,
Mix, Best (opzionale)

RTK
Formato di CMR2/CMR+ (compatibile Trimble), RTCM SC104 Ver
correzione 22,2303.0

Tipo di messaggio
RTCM

3,18, 19, 20, 21, 22; selezionabile dall’utente

Inizializzazione OTF (L1, L1/L2)

ambiguita

Lunghezza base Fino a 50km di mattina e di sera. Fino a 32km a
topografica mezzogiorno.

Tempo di Da 5 secondi a 10 minuti a seconda della lunghezza della
inizializzazione base topografica e delle condizioni multipath

Intervallo output
per CMR/RTCM

1Hz standard; 5, 10, 20Hz opzionale

Elevazione

Da 0 a 90° (indipendentemente dalla registrazione dati)

Modalita soluzione

Ritardo (sincronizzazione) estrapolazione (non
sincronizzata)

Intervallo di
processo

1Hz standard; 5, 10, 20Hz opzionale

Latenza

Modalita ritardo — da 20 msec a 20 sec (a seconda della
latenza che riceve i dati di correzione di ricezione dal
ricevitore base) Estrapolazione — Da 20 a 30 msec

Registrazione dati
grezzi

Il ricevitore ¢ in grado di registrare dati grezzi a un
intervallo diverso durante il funzionamento RTK

Stato Fisso, Flottante, DOP, stato collegamento dati, Latenza
modem, satelliti comuni, percentuale di risoluzione
Risultati Coordinate RTK, HRMS, VRMS, matrice di covarianza
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Caratteristiche

Tabella A -

1: Specifiche generali del ricevitore (continua)

Livello di fissaggio
dell’ambiguita

Soglie selezionabili Bassa: 95%; media: 99,5%; alta:
99,9%

Modalita di acquisiziol

ne

Base o rover

Statica

Cinematica (Stop and Go)

RTK (cinematica in tempo reale)
DGPS (GPS differenziale)
WASS/EGNOS DGPS

Precisione del rilievo

Statica, Statica
veloce

Per L1+L2 — H: 3mm + 0,5ppm
(x lunghezza base topografica);

V: 5mm + 0,5ppm
(x lunghezza base topografica)

Cinematica, RTK

Per L1+ L2,L1—-H: 10mm + 1,0ppm
(x lunghezza base topografica);
V: 15mm + 1,0ppm
(x lunghezza base topografica)

DGPS Post elaborazione: meno di 0,25 m (HRMS)
DGPS/RTCM based: meno di 0,25 m (HRMS)

Riacquisizione <60 sec

avvio a freddoe a <10 sec

caldo <1sec

Dettagli della scheda GPS

La tabella A-2 elen

ca le caratteristiche generali della scheda GPS.

Tabella A - 2: Specifiche della scheda GPS.

Tipo di ricevitore (impostato dall’attivazione dell’lOAF adeguato)

Scheda interna:

GPS: L1 (C/A & P), L2, L2C, L5

GR-3 GLONASS: L1, L2 (sia codice che fase)
GALILEO: E2-L1-El, E5a
Tipo di hardware: Con FH915+ TX/RX/RP
in funzione di Con FH915+ TX/RX/RP + GSM
paese/regione/
finalita
Caratteristiche di tracciatura

Canali standard

72 canali universali (G, GG, GD, GGD)

Opzionale

Cinderella days (vedere a pag. A-8 per maggiori

informazioni)
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Specifiche del ricevitore

Tabella A - 2: Specifiche della scheda GPS. (continua)

Segnali rilevati

GPS/GLONASS, L1/L2 C/A, L5, GALILEO e P-Code ¢
portante, WAAS/EGNOS

Funzioni di tracciatura

Riduzione
multipath

Codice e portante

Impostazione PLL/
DLL

Larghezza di banda, ordine, regolabile

Intervallo di
smoothing

Codice e portante

WAAS/EGNOS

WAAS opzionale; EGNOS opzionale

Caratteristiche dei dati

Formati

TPS, NMEA, RTCM, CMR, BINEX

Funzioni

Velocita di aggiornamento fino a 20 Hz per posizione in
tempo reale e dati grezzi (codice e portante)

Precisione code-phase 10cm e carrier-phase 0,1mm
RTCM SC104 versione 2.1,2.2,2.3,¢ 3.0 1/0

RTCM stazioni base multiple

Modelli di variazione geodica e magnetica

RAIM

Supporto DATUM diverso

Output delle coordinate di griglia

CMR e CMR+ supporto

Memoria

Memoria interna

Scheda SD (secure data), amovibile

Capacita In funzione della capacita della scheda SD/MMC
installata, attualmente fino a 1 GB

Tempo di 53 ore (8 MB, 15sec, L1/L2, 7 satelliti)

registrazione

Intervallo di
registrazione

Da 0,05 a 86400 secondi, in funzione delle opzioni
acquistate

a. SD = scheda secure digital; MMC = scheda multimediale

Cinderella days € un'opzione che trasforma un ricevitore GPS
monofrequenza in ricevitore GPS+GLONASS a doppia frequenza per
24 ore 2 martedi al mese. Fare riferimento al sito Web di Topcon per
maggiori informazioni e le specifiche date dei Cinderella day.
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Caratteristiche

Dettagli del modulo Bluetooth

La tabella A-3 elenca le caratteristiche generali del modulo a
tecnologia wireless Bluetooth.
Tabella A - 3: Specifiche del modulo Bluetooth

Range

Fino a 10 m (all’interno); fino a 50 m (all’esterno)

Tipo

Classe 2

Classi di servizio

Varie

Profili supportati

LM, L2CAP, SDP, SPPP

Frequenza paese

Nord America ed Europa

Codice

Dettagli relativi al modulo GSM/GPRS
opzionale
La tabella A-4 elenca le specifiche generali interne del collegamento
modem interno per un modulo GSM/GPRS opzionale.

Tabella A - 4: Specifiche del modulo GSM/GPRS

EGSM: 900/1800 MHz;
GSM: 850/1900 MHz;

Sistemi operativi

Alimentazione TX 0.6 W (850 MHz); 2 W (900 MHz); 1 W (1800/1900

MHz);

GPRS Multi-slot classe 8 (4 giu; 1 su);
Max BR 85.6 Kbps;
Protocollo multiplexing classe B GSM 07.10;

Schema di codifica CS1-CS4;

CSD Max BR 14.4 Kbps;

SMS Modalita MO/MT testo e PDU; Cell broadcast;

Caratteristiche dei connettori

I1 GR-3 ¢ dotato di connettore dell'antenna per la trasmissione/
ricezione radio e tre connettori porta per l'alimentazione e il
caricamento/scaricamento di dati.
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Caratteristiche dei connettori

Connettore RF (modem) radio

Il connettore del modem (Tabella A-5) ¢ un connettore TNC a polarita
inversa per spread spectrum.
Tabella A - 5: Specifiche del connettore modem

Modem Tipo Tipo di Dir Dettagli
segnale
Spread TNCa Modem I/O /0 Output RF/GSM
Spectrum polarita dall’antenna
inversa modem

Connettore di alimentazione

Il connettore di alimentazione con bordo rosso (Figura A-1) € una
presa ermetica, a 5 pin, numero part. ODU G80F1C-T05QF00-0000.

Figura A-1. Connettore di alimentazione

La tabella A-6 indica le caratteristiche del connettore di alimentazione.

Tabella A - 6: del connettore di alimentazione

Numero Nome segnale Dir Dettagli

1 INP_alim. P Ingresso DC da 9 a 21 volt
2 INP_alim. P Ingresso DC da 9 a 21 volt
3 GND_alim. P Ritorno a terra

4 GND_alim. P Ritorno a terra

5 Alim._aus. P Ingresso DC da 9 a 21 volt
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Caratteristiche

Connettore C-RS232 seriale

Il connettore RS232 seriale con bordo nero (Figura A-2) € una presa
ermetica, a 7 pin, numero part. ODU G80F 1C-T07QC00-0000.

Figura A-2. Connettore RS232 seriale

La tabella A-7 indica le caratteristiche dei connettori RS232.
Tabella A - 7: Specifiche del connettore RS232

Numero Nome segnale Dir Dettagli
1 Inutilizzato
2 GND - Messa a terra segnale
3 CTS 1 Invio annullato
4 RTS (0] Richiesta di invio
5 RXD I Ricezione dati
6 TXD (0] Trasmissione dati
7 Inutilizzato
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Caratteristiche dei connettori

Connettore USB

Il connettore USB, con il bordo giallo, € un connettore per cavo TPS a
4 pin in una presa ermetica (Figura A-3).

Figura A-3. Connettore USB per opzioni GGD

La tabella A-8 indica le caratteristiche del connettore USB.
Tabella A - 8: Specifiche USB

Numero Nome segnale Dir Dettagli

1 USB PWR P Ingresso alimentazione bus
2 USB D- 1/0 Dati meno

3 USB D+ /0 Dati piu

4 GND - Terra
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Caratteristiche

Note:
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Appendice B

Informazioni sulla
sicurezza

Avvisi generali

Per soddisfare i requisiti di esposizione RF, mante-

@ nere una distanza minima di 25cm tra l'utente e il
radio modem.

I ricevitori TPS sono progettati per rilievi e operazi-
oni simili (vale a dire per il rilievo di coordinate,
distanze, angoli e profondita e per la registrazione
delle misure rilevate). Il prodotto non va usato:

& :

Se l'utente non ha compreso a pieno il
contenuto del presente manuale.

Se 1 sistemi di sicurezza sono stati disabilitati o
1l sistema alterato.

Con accessori non autorizzati.

Senza le apposite protezioni sul luogo del
rilievo.

In contravvenzione con le leggi, norme e
normative vigenti.

I ricevitori TPS non devono essere usati in ambienti

pericolosi. L'uso sotto la pioggia o la neve ¢ con-
v/ sentito solo per un periodo di tempo limitato.
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Informazioni sulla sicurezza

Avvertenze relative al gruppo
batterie

Non cercare di aprire il vano delle batterie

GTrT®) amovibili! Le batterie agli ioni di litio possono
S essere pericolose se usate in modo errato!
Non incenerire né riscaldare il gruppo batterie oltre
™) i 100°C (212° F). Un calore eccessivo potrebbe
\—/ causare danni seri e possibili esplosioni.
La garanzia della batteria decade se le batterie ven-
gono manomesse dagli utenti finali o da tecnici non
autorizzati.
* Non cercare di aprire né di sostituire il gruppo
batterie.
* Non disassemblare il gruppo batterie.
» Non caricare in condizioni diverse da quelle
specificate.

» Utilizzare esclusivamente il caricabatteria
specificato.

» Non cortocircuitare.

* Non frantumare né modificare.
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Avvertenze per l'uso

Avvertenze per l'uso

Se il prodotto viene fatto cadere, alterato, traspor-
tato o inviato senza un imballaggio adeguato
ovvero non trattato con la debita cura, le misurazi-
oni effettuate potrebbero non essere corrette.

@ Il proprietario deve testare periodicamente il pro-
dotto per verificare che sia in grado di effettuare
misurazioni accurate.

In caso di malfunzionamento del prodotto, darne
immediata comunicazione a TPS.

La manutenzione o la riparazione del prodotto
@ devono essere affidate esclusivamente a centri di

assistenza autorizzati da TPS.
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Informazioni sulla sicurezza

Note:
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Appendice C

Informazioni
normative

Le seguenti sezioni forniscono informazioni sulla conformita del
prodotto con le norme governative relative all'uso.

Conformita FCC

Questo dispositivo ¢ conforme alla Parte 15 delle normative FCC.
L'uso ¢ soggetto alle seguenti condizioni:

1. Il presente dispositivo non deve causare interferenze dannose e
2. Accettare tutte le interferenze di cui ¢ oggetto, comprese quelle
che possono causare un funzionamento non appropriato.

Questo dispositivo ¢ stato controllato e rientra nei parametri previsti
per i dispositivi digitali, conformemente alla Parte 15 delle normative
FCC. Questi parametri rappresentano un'adeguata protezione contro
interferenze che possono essere dannose se il dispositivo € in funzione
in installazioni residenziali. Questo dispositivo produce, utilizza e puo
irradiare energia a radiofrequenza e se non viene installato ed
utilizzato in conformita con quanto riportato nel manuale di istruzioni
potrebbe disturbare le comunicazioni radio. Comunque non si esclude
che possa esserci un'interferenza anche in installazioni particolari.

Se questo dispositivo causa interferenze dannose per la ricezione radio
o televisiva, che possono presentarsi accendendo e spegnendo il
dispositivo, l'utente viene invitato a correggere l'interferenza
adottando una o piu delle seguenti misure:

» Riorientare o riposizionare 1'antenna di ricezione.
* Aumentare la distanza tra il dispositivo e il ricevitore.

» Collegare il dispositivo ad un'uscita su un circuito diverso da
quello a cui ¢ collegato il ricevitore.



Informazioni normative

* In caso di bisogno rivolgersi al fornitore o ad un tecnico radio/
TV esperto.

Cambiamenti o modifiche al dispositivo non autor-

izzati dalla parte responsabile della conformita pos-
sono comportare la perdita del diritto di utilizzo da

parte dell'utente.

Conformita CE

Il prodotto descritto nel presente manuale ¢ conforme alle direttive
R&TTE ed EMC della Comunita Europea.

Direttiva WEEE

Le seguenti informazioni sono valide solo per gli stati membri
dell'Unione Europea:

L'uso di questo simbolo indica che il prodotto non deve essere trattato
come rifiuto domestico. Assicurando un corretto smaltimento del
prodotto, si evitano possibili conseguenze negative per I'ambiente e la
salute umana. Per maggiori informazioni sul ritiro e il riciclaggio del
presente prodotto, contattare o consultare il fornitore presso cui ¢ stato
acquistato il prodotto.
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Appendice D

Condizioni di
garanzia

Le apparecchiature di posizionamento laser ed elettroniche TPS sono
garantite contro difetti di materiale e di manodopera in condizioni
d'uso ed applicazione normali coerenti con quanto specificato nel
presente manuale. Le apparecchiature sono garantite per il periodo
indicato sulla scheda di garanzia che accompagna il prodotto, a partire
dalla data in cui il prodotto ¢ stato venduto all'acquirente originale dai
rivenditori autorizzati TPS.!

Durante il periodo di garanzia, TPS, a propria discrezione, riparera o
sostituira il prodotto senza I'addebito di costi aggiuntivi. I componenti
riparati e i prodotti sostituiti verranno forniti su una base di scambio e
saranno revisionati o nuovi. Questa garanzia limitata non include il
servizio di riparazione dei danni subiti dal prodotto a seguito di
incidente, disastro, utilizzo improprio, abuso o modifica.

Il servizio di garanzia puo essere ottenuto da un rivenditore autorizzato
TPS. Se il prodotto viene spedito tramite posta, I'acquirente accetta di
assicurarlo oppure si assume il rischio di perdita o danni in transito, si
impegna a pagare anticipatamente le spese di spedizione alla sede del
servizio di garanzia e a usare il contenitore di imballaggio originale o
equivalente. Il pacco deve essere accompagnato da una lettera in cui
viene descritto il problema /o il difetto.

L'unico rimedio per l'acquirente deve essere la sostituzione, come
menzionato sopra. In nessun caso TPS deve essere ritenuta
responsabile per danni o altre rivendicazioni per perdita di profitti,
guadagni o altri danni incidentali o extracontrattuali derivanti dall'uso
o dall'impossibilita di usare il prodotto.

1. La garanzia relativa ai difetti presenti in una batteria, in un carica-
batteria o in un cavo Topcon ¢ di 90 giorni.
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Condizioni di garanzia

Note:
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